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V Workstation Imaging

The following sections provide information on Novell® ZENworks® Desktop Management 
Workstation Imaging procedures and features.

Chapter 50, “Common Imaging Deployment Strategies,” on page 571

Chapter 51, “Preparing an Imaging Server,” on page 575

Chapter 52, “Preparing an Imaging Boot Method,” on page 577

Chapter 53, “Using ZENworks Desktop Management Preboot Services,” on page 591

Chapter 54, “Setting Up Workstations for Imaging,” on page 629

Chapter 55, “Setting Up Imaging Policies,” on page 633

Chapter 56, “Creating and Restoring Images,” on page 639

Chapter 57, “Performing Manual Imaging Operations,” on page 647

Chapter 58, “Setting Up Disconnected Imaging Operations,” on page 655

Chapter 59, “Multicasting Images,” on page 663

Chapter 60, “Imaging Utilities and Components,” on page 673

Chapter 61, “Imaging Engine (Img: Command Line and Menu),” on page 707

Chapter 62, “Adding Linux Drivers in ZENworks 6.5 SP2,” on page 723

Chapter 63, “Supported Ethernet Cards,” on page 735

Chapter 64, “Server Imaging,” on page 737

Appendix H, “Documentation Updates,” on page 739
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50 Common Imaging Deployment Strategies

The following overview sections present possible approaches to deploying the Imaging 
component of Novell® ZENworks® Desktop Management for some common enterprise scenarios. 
Use the following sections to determine which procedures (documented in subsequent sections) to 
perform and in what order: 

“Installing a Standard Image Before Deploying New Workstations” on page 571

“Enabling Existing Workstations for Future Reimaging” on page 572

“Reimaging Corrupted Workstations” on page 573

“Restoring Lab or Classroom Workstations to a Clean State” on page 573

Installing a Standard Image Before Deploying New Workstations
As new workstations are purchased and before deploying them, you can install a standard software 
platform and enable the workstation for future unattended reimaging.

1. Create a model workstation of each type that you’ll deploy.

2. Create an image of each model workstation on a Desktop Management Workstation Imaging 
server. For more information, see “Manually Taking an Image of a Workstation” on page 647.

These images should include the Desktop Management Agent, which includes the Imaging 
Agent. ZENworks Desktop Management lets ZENworks work with or without an installation 
of the Novell Client on the workstation. If your setup requires the Novell Client, you should 
install the Desktop Management Agent after the Novell Client installation to ensure that you 
are running the latest Imaging Agent. For more information, see “Installing and Configuring 
the Desktop Management Agent” in the Novell ZENworks 6.5 Desktop Management 
Installation Guide.

3. If you are using Preboot Services, install Desktop Management Preboot Services (PXE 
Support) on your Imaging server. For more information, see “Using Preboot Services (PXE)” 
on page 577.

or

If you are using a bootable CD, bootable diskettes (SP1 only), or a hard-disk partition, create 
a boot CD or diskettes that point to the Desktop Management Workstation Imaging server 
where the model images are stored. For more information, see “Preparing an Imaging Boot 
Method” on page 577.

4. Create a policy for unregistered workstations that specifies which image to put on a new 
machine, depending on its hardware. For more information, see “Defining an Imaging Policy 
for Unregistered Workstations (Server Policy)” on page 633.
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As each new workstation comes in, do the following:

1. If you are using Preboot Services, check to see if the workstation is PXE capable. Enable PXE 
if it isn’t enabled by default. For more information, see “Using Preboot Services (PXE)” on 
page 577.

2. Physically connect the workstation to the network.

3. If you are using Preboot Services, boot the workstation from the Imaging/Preboot Services 
server.

or

If you are not using Preboot Services, boot the workstation with the imaging boot CDs or 
diskettes (SP1 only) and consider installing the Desktop Management Workstation Imaging 
(Linux*) partition to enable auto-imaging without needing to supply the CD or diskettes. For 
more information, see Step 6 on page 632 of “Enabling a Workstation for Auto-Imaging 
Operations” on page 630. After you have installed the partition, reboot the workstation from 
the Desktop Management Workstation Imaging partition.

4. Let the workstation be auto-imaged by the policy.

5. After deploying the machine, register it as a Workstation object in Novell eDirectoryTM. For 
more information, see “Automatic Workstation Import and Removal” on page 77.

Enabling Existing Workstations for Future Reimaging
With minimal disruption to users, you can enable existing workstations for possible future 
reimaging.

This process might need to be phased in by local administrators. Each administrator could do the 
following:

1. Upgrade each workstation to the latest Novell Client, using Automatic Client Update. Or, 
install the Desktop Management Agent. ZENworks Desktop Management lets ZENworks 
work with or without an installation of the Novell Client on the workstation. If your setup 
requires the Novell Client, you should install the Desktop Management Agent after the Novell 
Client installation to ensure that you are running the latest Imaging Agent. For more 
information, see “Installing and Configuring the Desktop Management Agent” in Novell 
ZENworks 6.5 Desktop Management Installation Guide.

2. Install the Desktop Management Imaging Agent on each workstation by distributing an 
Application object. For more information, see Step 4 on page 631 of “Enabling a Workstation 
for Auto-Imaging Operations” on page 630.

3. Register each workstation as a Workstation object in eDirectory. For more information, see 
“Automatic Workstation Import and Removal” on page 77.

4. If the workstations are PXE capable, make sure PXE is enabled (see “Using Preboot Services 
(PXE)” on page 577) and make sure that Desktop Management Preboot Services (PXE 
Support) has been installed on your Imaging server (see Chapter 53, “Using ZENworks 
Desktop Management Preboot Services,” on page 591).

or

Prepare a few sets of imaging boot diskettes (SP1 only) or CDs that users can use when they 
run into trouble (see “Preparing an Imaging Boot Method” on page 577). These devices could 
point to an Imaging server that contains the same clean images used for new workstations.
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5. If a user runs into trouble, use the strategy for reimaging corrupted workstations. For more 
information, see “Reimaging Corrupted Workstations” on page 573.

Reimaging Corrupted Workstations
Without data loss or undue disruption to users, you can fix workstations that have become 
misconfigured or corrupted.

1. Create a policy for registered workstations. Use the same image-selection logic as the policy 
for new (unregistered) workstations. For more information, see “Defining an Imaging Policy 
for Registered Workstations (Workstation Policy)” on page 635.

2. When a workstation needs to be fixed, have the user back up any files to the network that he 
or she wants to keep.

3. Flag the Workstation object in eDirectory using ConsoleOne® to receive an image the next 
time it boots. For more information, see “Performing an Automatic Imaging Creation or 
Restoration” on page 644.

4. If it’s a newer workstation (with a Desktop Management imaging partition or PXE-enabled), 
the user should boot the workstation from the Desktop Management imaging partition or 
Imaging/Preboot Services server. If you are using Preboot Services, make sure that Desktop 
Management Preboot Services (PXE Support) has been installed on your Imaging server. For 
more information, see Chapter 53, “Using ZENworks Desktop Management Preboot 
Services,” on page 591.

or

If it’s an older workstation (without a Desktop Management Workstation Imaging (Linux) 
partition), the user should boot the workstation with the imaging boot CD or diskettes (SP1 
only).

5. After the image is laid down, restore any user files that were backed up to the network.

Restoring Lab or Classroom Workstations to a Clean State
After each lab session, you can restore every workstation to a clean state, removing any changes 
or additions made during the session. The following steps assume that the workstations are 
unregistered (not imported into eDirectory).

1. Create an image of a clean model workstation and store it on a Desktop Management 
Workstation Imaging server. For more information, see “Manually Taking an Image of a 
Workstation” on page 647.

Upgrade each workstation to the latest Novell Client, if needed, using Automatic Client 
Update. Or, install the Desktop Management Agent. ZENworks Desktop Management lets 
ZENworks work with or without an installation of the Novell Client on the workstation. If 
your setup requires the Novell Client, you should install the Desktop Management Agent after 
the Novell Client installation to ensure that you are running the latest Imaging Agent. For 
more information, see “Installing and Configuring the Desktop Management Agent” in the 
Novell ZENworks 6.5 Desktop Management Installation Guide guide.

2. If you are using Preboot Services, make sure that Desktop Management Preboot Services 
(PXE Support) has been installed on your imaging server. For more information, see Chapter 
53, “Using ZENworks Desktop Management Preboot Services,” on page 591.
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3. If you are using Preboot Services and the workstations are PXE capable, make sure that PXE 
is enabled. For more information, see “Using Preboot Services (PXE)” on page 577.

or

If you are not using Preboot Services or the Linux partition, create an imaging boot CD or 
diskettes (SP1 only) that point to the Desktop Management Workstation Imaging server where 
the clean image is stored. For more information, see “Preparing an Imaging Boot Method” on 
page 577.

4. Create a policy for unregistered workstations that specifies the clean image to restore. Choose 
the option to always force down the same base image. For more information, see “Defining 
an Imaging Policy for Unregistered Workstations (Server Policy)” on page 633.

Deploy each lab workstation as follows:

1. Physically connect the workstation to the lab network.

2. If you are using Preboot Services, boot the workstation from the Imaging/Preboot Services 
server.

or

If you are not using Preboot Services, boot the workstation with the imaging boot CD or 
diskettes (SP1 only) and install the Desktop Management Workstation Imaging (Linux) 
partition. For more information, see Step 6 on page 632 of “Enabling a Workstation for Auto-
Imaging Operations” on page 630. After you have installed the partition, reboot the 
workstation from the Desktop Management Imaging partition.

3. At the end of each lab session, reboot each workstation and let it be auto-imaged by the policy.
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51 Preparing an Imaging Server

Before you can use Novell® ZENworks® Desktop Management imaging services, you must install 
the Imaging components. If you have already done a typical Desktop Management installation on 
the server, the server is ready to act as an imaging server. 

If you want to deploy images based on specific workstations, you should also install the Automatic 
Workstation Import component to ease the management of these deployments.

If you have not installed the Automatic Workstation Import and Imaging components during 
installation of Desktop Management, use the following steps to install the needed components:

1. Make sure your server meets the requirements specified in “Preparation” in the Novell 
ZENworks 6.5 Desktop Management Installation Guide.

In addition to the specific hardware requirements for the server, the Imaging server must meet 
the following requirements:

A fixed IP address: When you connect to the Imaging server during a workstation 
imaging operation, you must do so using the fixed IP address or DNS name of the 
Imaging server.

Enough space to store workstation images: Unless you use compression (which is 
enabled by default) for your workstation images, they are nearly the same size as the data 
on the workstation hard disk, which could be hundreds of MB.

Although the System Account should already have Full Control rights to the folder that 
you will store image files in, you should ensure that this is the case if you are running the 
Imaging component on a Microsoft server.

If you want to store an image locally (on a CD, DVD, hard disk, or Jaz* drive) rather than 
on an Imaging server, see “Using a CD or DVD for Disconnected Imaging Operations” 
on page 655 and “Using a Hard Disk or Jaz Drive for Disconnected Imaging Operations” 
on page 657.

2. Run the Desktop Management installation program (winsetup.exe) either on your server 
(Windows 2000/2003) or from a Windows workstation with a drive mapped to your server 
(NetWare®).

3. When prompted for the Novell eDirectory tree to install to, choose the tree that your server is 
in.

4. When prompted for the components to install, choose Automatic Workstation Import and 
Imaging.

5. When prompted for the import/removal role, choose Import.

6. If you are installing Preboot Services (PXE), select it when prompted.

7. When the installation is done, restart your server.
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52 Preparing an Imaging Boot Method

The Novell® ZENworks® Desktop Management imaging engine that performs the actual imaging 
of a workstation is a Linux application. Therefore, the workstation must be temporarily booted to 
Linux while the imaging is performed. 

Unless you use Preboot Services, you need to prepare a boot device that has the Linux kernel, 
Desktop Management Workstation Imaging engine, and network drivers installed.

The following sections contain additional information:

“Using Preboot Services (PXE)” on page 577

“Preparing Imaging Boot CDs or DVDs” on page 578

“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580

“Creating an Imaging Hard-Disk Partition” on page 587

“Additional Information About Booting to Linux” on page 587

Using Preboot Services (PXE)
Preboot Execution Environment (PXE) is an industry-standard protocol that allows a workstation 
to boot up and execute a program from the network before the workstation operating system starts. 
PXE uses DHCP (Dynamic Host Configuration Protocol) and TFTP (Trivial File Transfer 
Protocol). The PXE environment is loaded from either the NIC in flash memory or read-only 
memory, or in the same memory as the system BIOS. 

Desktop Management Preboot Services uses PXE to find out if there is imaging work specified for 
a workstation and to provide the workstation with the files necessary to boot to the Desktop 
Management imaging environment.

Before you can use Preboot Services, you need to do the following:

Install the Desktop Management Imaging and Preboot Services (PXE Support) components 
on your imaging server.

Enable PXE on the workstation.

Have a standard DHCP server, either on your Imaging server or on another network server.

For information about the requirements and installation of Preboot Services, see the Novell 
ZENworks 6.5 Desktop Management Installation Guide. For information about deployment and 
administration of Preboot Services, see Chapter 53, “Using ZENworks Desktop Management 
Preboot Services,” on page 591.
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If You Have Previously Installed a Desktop Management Workstation Imaging 
(Linux) Partition

An existing partition is not updated when a ZENworks support pack is applied.

If you decide to use Preboot Services but have previously installed a Desktop Management 
imaging partition on the workstation, you can disable or delete the partition.

You can disable (and enable) the Desktop Management imaging partition when you boot to Linux 
using any imaging boot device or method.

You can delete the Desktop Management imaging partition only when you boot the workstation 
from an imaging boot method other than the Desktop Management imaging partition.

For more information on disabling or deleting a partition, see Step 9 in “Creating a Workstation 
Image Object” on page 642.
IMPORTANT: After you have deleted the Desktop Management imaging partition, you need to make sure that 
the image you put on the workstation was made on a workstation without a Desktop Management imaging 
partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the workstation will fail to boot. In 
addition, if you remove the Desktop Management imaging partition from a Windows NT, Windows 2000, or 
Windows XP machine, Windows will no longer be able to boot. You should only remove the Desktop 
Management imaging partition if you are going to restore an image to the workstation.

Preparing Imaging Boot CDs or DVDs
If you have software for burning CDs or DVDs, you can create an imaging boot CD or DVD for 
imaging operations. You have two options:

“Creating a Boot CD or DVD with Additional Files” on page 578

“Creating a Boot CD or DVD without Additional Files” on page 579

For information on how to use the CD or DVD to perform disconnected imaging operations, see 
“Setting Up Disconnected Imaging Operations” on page 655.

Creating a Boot CD or DVD with Additional Files
This section describes how to create an imaging CD or DVD that contains more than the files 
provided in the bootcd.iso image.

This method allows you to include the settings.txt file on the boot CD or DVD to provide the 
required imaging parameters. For more information on the settings.txt file, see “Imaging 
Configuration Parameters (Settings.txt)” on page 695.

This method also allows you to add other files and drivers that you need to do the imaging.

To create an imaging boot CD or DVD that includes settings.txt and other files:

1 Copy the bootcd.iso file to a temporary location.

The bootcd.iso file is located in the\public\zenworks\imaging directory in your Desktop 
Management installation (on the ZENworks Imaging server).

2 In an ISO editor, open the temporary copy of the bootcd.iso file.

If you experience ISO corruption after adding files into the ISO, such as a checksum error, use 
a more reliable ISO editor. Also, some ISO editors do not work very well with DVDs.
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3 Using the temporary bootcd.iso file, copy the settings.txt file to the root of the bootcd.iso 
image.

The settings.txt file is located in the \public\zenworks\imaging directory in your Desktop 
Management installation (on the ZENworks Imaging server).

4 Copy any other files or drivers that you want included on the CD or DVD to the /addfiles 
directory in the temporary bootcd.iso image.

Any files or subdirectories that you add under the /addfiles directory are placed at the root of 
the client when booting the CD or DVD.
IMPORTANT: When booting from the CD or DVD, the imaging engine is read into RAM. Because the 
imaging engine uses some of the RAM that exists on the client device, the combined size of any files that 
you add under the /addfiles directory cannot exceed amount of remaining RAM.

(SP1 only) Use the Add Linux Drivers button in the Imaging Boot Disk Creator 
(zimgboot.exe) to copy the Linux drivers to a diskette, then copy the a:\drivers directory from 
the diskette to the /addfiles directory in the bootcd.iso image.

(SP1 and earlier only) For more information about adding Linux drivers, see the online help 
for the Imaging Boot Disk Creator (zimgboot.exe) or see “Using Zimgboot.exe to Add Linux 
Drivers” on page 693.

(SP2 only) For information on adding Linux drivers in ZENworks 6.5 SP2, see Chapter 62, 
“Adding Linux Drivers in ZENworks 6.5 SP2,” on page 723.

5 Save the updated bootcd.iso image file to its temporary location.

6 Use your software for burning CDs or DVDs to burn the updated bootcd.iso image onto the 
CD or DVD.

7 Boot the device to be imaged from your newly created imaging boot CD or DVD.

Booting from a SCSI CD-ROM device is currently not supported.

Creating a Boot CD or DVD without Additional Files
If you do not want to include the settings.txt file or any other files or drivers in the imaging boot 
CD or DVD, you can simply create the imaging boot CD or DVD from the bootcd.iso image 
provided with ZENworks.

However, you will need to provide the settings.txt file on a floppy diskette to provide the required 
imaging parameters. For more information on the settings.txt file, see “Imaging Configuration 
Parameters (Settings.txt)” on page 695.

To create an imaging boot CD or DVD that contains only the bootcd.iso image:

1 Copy the settings.txt file containing the settings you want for the imaging boot process onto 
a floppy diskette.

This file is located in the \public\zenworks\imaging directory in your Desktop Management 
installation (on the ZENworks Imaging server).

2 Use your software for burning CDs or DVDs to burn the bootcd.iso image onto the CD or 
DVD.

The bootcd.iso file is located in the \public\zenworks\imaging directory in your Desktop 
Management installation (on the ZENworks Imaging server).
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3 Boot the device to be imaged from your newly created imaging boot CD or DVD.

You will be prompted for the diskette that contains the settings.txt file.

Booting from a SCSI CD-ROM device is currently not supported.

Using the ZENworks Imaging Floppy Boot Disk Creator Utility
With the release of ZENworks 6.5 Support Pack 2 (SP2), there are now two versions of 
zimgboot.exe:

“Using zimgboot.exe in ZENworks 6.5 SP1 and Earlier” on page 580

“Using zimgboot.exe in ZENworks 6.5 SP2 and Later” on page 584

Using zimgboot.exe in ZENworks 6.5 SP1 and Earlier
You can do the following with the zimgboot.exe that shipped with ZENworks 6.5:

“Create Imaging Boot Diskettes” on page 580

“Prepare a CD Boot Diskette” on page 582

“Configure the Settings.txt File” on page 583

“Add Linux Device Drivers” on page 584

“Create A Language Disk” on page 584

“Create A Utility Disk” on page 584

“Configure PXE-on-Disk” on page 584

Create Imaging Boot Diskettes

Imaging boot diskettes are easy to prepare. Five diskettes are required, six if you need to image 
workstations that have non-English keyboards.

To create imaging boot diskettes:

1 Format five high-density diskettes, or use preformatted blank diskettes.

If you need the imaging boot diskettes to include support for booting workstations with a non-
English keyboard, you need a sixth diskette.
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2 Browse to the SYS:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server) and run zimgboot.exe.
TIP: You can also start zimgboot.exe in ConsoleOne by clicking Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette.

3 In the ZENworks Imaging Floppy Boot Disk Creator dialog box, near the bottom under 
Imaging Proxy Server Address, specify either the fixed IP address or the full DNS name of 
your Imaging server.

4 For the other fields and options on the dialog box, keep the default settings unless you have a 
specific reason to change a setting, such as to include support for a non-English keyboard. 
Click Help for details on specific settings.

5 Click Create Boot Disk 1, insert the first diskette, then click OK.

6 When the first diskette has been created, click Create Boot Disk 2, insert the second diskette, 
then click OK.

7 When the second diskette has been created, click Create Boot Disk 3, insert the third diskette, 
then click OK.

8 When the third diskette has been created, click Create Boot Disk 4, insert the fourth diskette, 
then click OK.

9 When the fourth diskette has been created, click Create Boot Disk 5, insert the fifth diskette, 
then click OK.

10 (Conditional) If you need the imaging boot diskettes to include support for a non-English 
keyboard: When the fifth diskette has been created, click Create Language Disk, insert the 
sixth diskette, then click OK.

For more information, see “Booting with a Non-English Keyboard” on page 589.
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11 When the last (fifth or sixth) diskette has been created, click Close.

After you have created the diskettes, you can customize them for the particular imaging tasks for 
which you will use them, such as one set of diskettes for connecting to a server that holds Windows 
2000 images, another set for connecting to a server that holds Windows XP images, and another 
set for installing Desktop Management Workstation Imaging (Linux) partitions. To customize the 
diskettes, edit the settings.txt file on the fifth diskette as explained in “Imaging Configuration 
Parameters (Settings.txt)” on page 695.

When you boot a workstation using imaging boot diskettes, you are prompted when to insert the 
second, third, fourth, and fifth diskettes, and when to insert the language diskette (if you created 
one).
NOTE: You can also use the Imaging Boot Disk Creator (zimgboot.exe) to create a diskette that contains Linux 
utilities. See the Help in the Boot Disk Creator for more information.

Prepare a CD Boot Diskette

The CD boot diskette is easy to prepare. One diskette is required. The zimgboot.exe utility is used 
to create the diskette, which is used to enable devices that cannot normally boot a CD or DVD to 
do so.

To create a CD boot diskette:

1 Format one high-density diskette, or use a preformatted blank diskette.

2 Browse to the SYS:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server) and run zimgboot.exe.
TIP: You can also start zimgboot.exe in ConsoleOne by clicking Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette.

3 Insert the formatted blank diskette, click Create CD Boot Disk, then click OK.
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4 When the diskette has been created, click Close.

Use this diskette to boot workstations that cannot be booted using a CD or DVD. The diskette 
boots the workstation, enabling access to the imaging CD or DVD.

Configure the Settings.txt File

The settings.txt file is required for imaging workstations. A default copy is provided with Desktop 
Management that you can use to create and configure a version for an imaging session.

To configure a settings.txt file for imaging:

1 Format one high-density diskette, or use a preformatted blank diskette.

2 Browse to the SYS:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server) and run zimgboot.exe.
TIP: You can also start zimgboot.exe in ConsoleOne by clicking Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette.

3 Click Load Settings from Disk. 

This allows you to browse for the settings.txt file. Then, it populates the fields in this dialog 
from information in the settings.txt file after you locate it in the next step, which you can 
modify in subsequent steps.

4 Browse for the settings.txt file, then click Open.

The default copy shipped with Desktop Management is located in the \zenworks\imaging 
folder on your imaging server.

5 (Required) In the ZENworks Imaging Floppy Boot Disk Creator dialog box, in the Imaging 
Proxy Server Address section, specify either the fixed IP address or the full DNS name of your 
imaging server.
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6 (Optional) For the other fields and options on the dialog box, keep the default settings, unless 
you have a specific reason to change a setting, such as to specify a particular device’s IP 
Address in the Workstation IP Settings section.

Click Help for details on specific settings, or see “Imaging Configuration Parameters 
(Settings.txt)” on page 695.

7 Click Save Settings to Disk.

8 Browse for where you want to save the settings.txt file, then click Save.

The default location is A:\. You can save to a different location for use in burning it to an 
imaging CD or DVD.

9 When you are finished using this utility, click Close.

Add Linux Device Drivers

For information, see “Adding Linux Device Drivers” on page 587.

Create A Language Disk

For information, see “Booting with a Non-English Keyboard” on page 589.

Create A Utility Disk

You can use the Boot Disk Creator to create a diskette that contains Linux utilities, such as df 
(shows disk usage), fdisk, less, more, host (performs DNS lookups in order to convert DNS names 
to IP addresses), ldd (shows shared library dependencies), pico (text editor), sed (stream file 
editor), and touch (changes file time stamps). These utilities are not needed to perform imaging, 
but they might be useful to you for debugging purposes when imaging is booted to manual or 
maintenance mode.

To create the utility disk:

1 Insert an empty, formatted, high-density diskette;

2 Click Create Utility Disk.

When created, the utility disk contains a tar file, utility.tgz.

3 To decompress the utility.tgz file and extract it to the root file system, enter utility.s at 
the Linux bash prompt.

Configure PXE-on-Disk

For information, see “Creating a PXE-on-Disk Diskette” on page 617.

Using zimgboot.exe in ZENworks 6.5 SP2 and Later
You can do the following with the new zimgboot.exe:

“Prepare a CD Boot Diskette” on page 585

“Configure PXE-on-Disk” on page 585

“Configure the Settings.txt File” on page 585
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Prepare a CD Boot Diskette

The CD boot diskette is easy to prepare. One diskette is required. The zimgboot.exe utility is used 
to create the diskette, which is used to enable devices that cannot normally boot a CD or DVD to 
do so.

To create a CD boot diskette:

1 Format one high-density diskette, or use a preformatted blank diskette.

2 Browse to the SYS:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server) and run zimgboot.exe.
TIP: You can also start zimgboot.exe in ConsoleOne by clicking Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette.

3 Insert the formatted blank diskette, click Create CD Boot Disk, then click OK.

4 When the diskette has been created, click Close.

Use this diskette to boot workstations that cannot be booted using a CD or DVD. The diskette 
boots the workstation, enabling access to the imaging CD or DVD.

Configure PXE-on-Disk

For information, see “Creating a PXE-on-Disk Diskette” on page 617.

Configure the Settings.txt File

The settings.txt file is required for imaging workstations. A default copy is provided with Desktop 
Management that you can use to create and configure a version for an imaging session.

To configure a settings.txt file for imaging:

1 Format one high-density diskette, or use a preformatted blank diskette.

2 Browse to the SYS:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server) and run zimgboot.exe.
TIP: You can also start zimgboot.exe in ConsoleOne by clicking Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette.
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3 Click Load Settings from Disk. 

This allows you to browse for the settings.txt file. Then, it populates the fields in this dialog 
from information in the settings.txt file after you locate it in the next step, which you can 
modify in subsequent steps.

4 Browse for the settings.txt file, then click Open.

The default copy shipped with Desktop Management is located in the \zenworks\imaging 
folder on your imaging server.

5 (Required) In the ZENworks Imaging Floppy Boot Disk Creator dialog box, in the Imaging 
Proxy Server Address section, specify either the fixed IP address or the full DNS name of your 
imaging server.

6 (Optional) For the other fields and options on the dialog box, keep the default settings, unless 
you have a specific reason to change a setting, such as to specify a particular device’s IP 
Address in the Workstation IP Settings section.

Click Help for details on specific settings, or see “Imaging Configuration Parameters 
(Settings.txt)” on page 695.

7 Click Save Settings to Disk.

8 Browse for where you want to save the settings.txt file, then click Save.

The default location is A:\. You can save to a different location for use in burning it to an 
imaging CD or DVD.

9 When you are finished using this utility, click Close.
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Creating an Imaging Hard-Disk Partition
If you want to set up a workstation for unattended imaging operations and are unable to use 
Preboot Services (PXE), you can create a Desktop Management Workstation Imaging (Linux) 
partition on the hard disk. If you make the partition big enough, you can even store an image of 
the workstation’s hard disk, which can be useful if the workstation becomes misconfigured or 
corrupted when the network connection is lost.
IMPORTANT: Installing the Desktop Management Imaging partition will destroy all data on that hard drive.

To create a Desktop Management Imaging partition:

1 Do one of the following to create the imaging boot device to boot the workstation from:

(only SP1 or earlier) Create imaging boot diskettes (see “Create Imaging Boot Diskettes” 
on page 580)

Create an imaging CD/DVD (see “Preparing Imaging Boot CDs or DVDs” on page 578)

2 Proceed with Step 5 of “Enabling a Workstation for Auto-Imaging Operations” on page 630.

These steps include booting the workstation and installing the partition on it.

Additional Information About Booting to Linux
IMPORTANT: This section applies only to ZENworks 6.5 SP1 and earlier.

For information on adding Linux drivers in ZENworks 6.5 SP2, see Chapter 62, “Adding Linux Drivers in 
ZENworks 6.5 SP2,” on page 723.

The following sections contain additional information:

“Adding Linux Device Drivers” on page 587

“Booting with a Non-English Keyboard” on page 589

Adding Linux Device Drivers
(SP1 and earlier only) If you need to, you can add Linux device drivers to your boot method. 

“Obtaining Linux Drivers” on page 587

“Adding Linux Drivers to Your Boot Method” on page 588

Obtaining Linux Drivers

To obtain a Linux driver for your particular hardware, you should visit the Web site of the hardware 
vendor and check for a download location.

There are also some other Web sites where you can obtain drivers:

Network drivers can be downloaded from the Scyld Computing Corporation* (http://
www.scyld.com). Click Network Drivers.

PCMCIA drivers can be downloaded from the Linux PCMCIA Information Page (http://
pcmcia-cs.sourceforge.net).
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To learn more about drivers, including the loading parameters you need to specify, see the Linux 
Documentation Project (http://en.tldp.org) and visit the following HOWTO (http://en.tldp.org/
HOWTO/HOWTO-INDEX/howtos.html) sites: 

Hardware

PCMCIA

SCSI

Ethernet

Adding Linux Drivers to Your Boot Method

You can add Linux drivers to the following boot methods:

“Adding Linux Drivers for Use with Preboot Services (PXE)” on page 588

“Adding Linux Drivers for Use with a CD or DVD” on page 589

“Adding Linux Drivers for Use with Diskettes” on page 589

“Adding Linux Drivers for Use with a Hard-Disk Partition” on page 589

Adding Linux Drivers for Use with Preboot Services (PXE)

To add Linux drivers for use with Preboot Services, you must have a working Linux workstation 
capable of mounting a loop device. Most Linux distributions have this ability compiled in the 
distribution kernel.

1 On the TFTP server on your Imaging/Preboot Services server, locate the linux.2 file in 
\public\zenworks\imaging\tftp. Make a backup copy of this file.

2 On the Linux workstation, create a working directory for linux.2. 

3 Using a transfer method such as FTP, transfer linux.2 to the directory created in Step 2 on 
page 588.

4 Enter the following to rename linux.2 to linux.gz:

mv linux.2 linux.gz

5 Enter the following to extract linux.gz:

gzip -d linux.gz

This replaces the linux.gz file with a file named linux. This file is a complete file system that 
can be mounted and changed.

6 Enter the following to create a mount point:

mkdir /mnt/loop

7 Enter the following to mount the file system:

mount -o loop linux /mnt/loop

8 Copy the driver files to the appropriate directory in the /mnt/loop directory structure.

9 Enter the following to unmount the updated file system:

umount /mnt/loop

10 Enter the following to zip the file:

gzip -9c linux > linux.gz
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11 Enter the following to rename the file:

mv linux.gz linux.2

12 Using a transfer method such as FTP, transfer linux.2 to the TFTP server.

Adding Linux Drivers for Use with a CD or DVD

For information, see “Preparing Imaging Boot CDs or DVDs” on page 578.

Adding Linux Drivers for Use with Diskettes

For information, see “Using Zimgboot.exe to Add Linux Drivers” on page 693.

Adding Linux Drivers for Use with a Hard-Disk Partition

It is unlikely that you will need to add Linux drivers if you are using a Desktop Management 
Workstation Imaging partition. If you want to update the Linux drivers, however, follow this 
procedure:

1 Boot the workstation using imaging boot diskettes, an imaging boot CD, or if it is PXE-
enabled, boot it from the Imaging/Preboot Services server.

2 Enter manual at the boot prompt or select Start ZENworks Imaging in Maintenance Mode 
from the PXE menu.

3 Enter the following to mount the hard drive:

mount /dev/hda1 /mnt/harddisk

4 Enter the following to mount the diskette that contains the driver files:

mount /dev/fd0 /mnt/floppy

5 Enter the following to copy the files to the appropriate directory on the Desktop Management 
Imaging partition:

cp /mnt/floppy/*.o /mnt/harddisk/lib/modules/2.4.22/drivers/
net

6 Type reboot, then press Enter.

Booting with a Non-English Keyboard
If you image workstations that have non-English keyboards, the imaging boot method must 
include additional language support, in the form of a language diskette. When you boot a 
workstation from the imaging method, you will be prompted for this diskette. For information on 
preparing this diskette, see the online help in the “Imaging Boot Disk Creator (Zimgboot.exe)” on 
page 692.

If the Language/Country drop-down list in the Imaging Boot Disk Creator utility doesn’t have the 
keyboard language you need, you can close the utility and reconfigure it to support the additional 
language. This assumes you can find Linux keyboard support files somewhere on the Web.
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Adding Support for Another Keyboard Language

1 Get the Linux .gz files that contain the keyboard mappings, fonts, and Unicode* mappings for 
the language that you want to add.

2 From the folder containing the zimgboot.exe file, browse to the bootdisk folder, then copy the 
.gz files for the new language to the following subfolders:

The keyboard map file goes in the keymaps folder.

The font file goes in the consolefonts folder.

The Unicode map file goes in the consoletrans folder.

3 Add a section to the zimglang.ini file using the format illustrated for German in “Imaging 
Bootup Languages (Zimglang.ini)” on page 701.

3a For the bracketed section heading, specify the language or country name that you want 
shown in the Imaging Boot Disk Creator utility.

3b In the KEYMAP, FONT, and ACM parameters, specify the names and locations (relative 
to the bootdisk folder) of the keyboard map, font, and Unicode map files, respectively.

4 Save your changes to the zimglang.ini file.

5 Restart the Imaging Boot Disk Creator utility and verify that the new language appears in the 
Language/Country drop-down list. 
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53 Using ZENworks Desktop Management Preboot 
Services

This section provides information about using Novell® ZENworks® Desktop Management 
Preboot Services on your network.

There are four methods that you can use for imaging: Preboot Services, a bootable CD or DVD, 
bootable diskettes (SP1 only), or a Linux hard-disk partition. For more information, see “Preparing 
an Imaging Boot Method” on page 577. 

Because Preboot services offers the greatest flexibility and options, we recommend using it.

 The following sections contain additional information:

“Understanding Desktop Management Preboot Services” on page 591

“Installing and Setting Up Desktop Management Preboot Services” on page 595

“Checking the Preboot Services Server Setup” on page 595

“Deploying Desktop Management Preboot Services In a Network Environment” on page 599

“Enabling PXE on a Workstation” on page 610

“Administering Desktop Management Preboot Services” on page 612

“Using the Desktop Management Preboot Services PXE-on-Disk Utility” on page 617

“Using the Desktop Management Preboot Services Menu Editor Utility” on page 621

Understanding Desktop Management Preboot Services
This section contains information that will help you to understand Desktop Management Preboot 
Services, including:

“About Desktop Management Preboot Services” on page 591

“Typical Preboot Services Operation” on page 592

“Preboot Services Process Diagrams” on page 592

About Desktop Management Preboot Services
PXE (Preboot Execution Environment) is an industry-standard protocol that allows a workstation 
to boot up and execute a program from the network before the workstation operating system starts. 
PXE uses DHCP (Dynamic Host Configuration Protocol) and TFTP (Trivial File Transfer 
Protocol). The PXE environment is loaded from either the NIC in flash memory or read-only 
memory, or in the same memory as the system BIOS.
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Desktop Management Preboot Services uses PXE to find out if there is imaging work specified for 
a workstation and to provide the workstation with the files necessary to boot to the Desktop 
Management imaging environment.

By using Preboot Services, you can put an image on a workstation even if the workstation's hard 
disk is blank. You do not need to use Desktop Management imaging boot diskettes (SP1 only), a 
ZENworks Desktop Management imaging boot CD or DVD, or a Desktop Management imaging 
hard-disk (Linux) partition on the workstation. 

Before you can use Preboot Services, you need to do the following:

Install the Desktop Management Imaging and Preboot Services (PXE Support) components 
on your imaging server.

Enable PXE on the workstation.

Have a standard DHCP server, either on your Imaging server or on another network server.

For information about requirements, installing Desktop Management and Preboot Services on 
your Imaging server, enabling PXE on a workstation, and configuring your DHCP server, see 
“Installing and Setting Up Desktop Management Preboot Services” on page 595.

Typical Preboot Services Operation
When a PXE-enabled workstation starts to boot up, it sends a DHCP discovery request to 
determine the IP address of the Preboot Services/Imaging server. The DHCP server responds with 
an IP address for the client to use, and the Proxy DHCP server responds with the IP addresses of 
the Transaction server, TFTP, and MTFTP (Multicast TFTP) servers, as well as the filename of the 
Preboot Services client.

The PXE workstation then downloads the Preboot Services client (dinic.sys) using either TFTP or 
MTFTP.

After the Preboot Services client is downloaded and executed, the workstation checks the Preboot 
Services Transaction server to see if there is any imaging work to do. If there is imaging work to 
do, it downloads the Desktop Management Workstation Imaging environment (linux.1, linux.2, 
and loadlin.exe in ZENworks 6.5 Desktop Management SP1 and earlier; initrd, linux, and root in 
ZENworks 6.5 Desktop Management SP2 and later) from the server so that the workstation can be 
booted to Linux and any imaging tasks can be performed. If there are no imaging tasks to perform, 
these files are not downloaded and the workstation proceeds to boot to its operating system.

Preboot Services Process Diagrams
The following diagrams show the interaction between a Preboot Services (PXE) client workstation 
and a Preboot Services/Imaging server, starting when the PXE client workstation is turned on and 
begins to boot up, and ending when imaging work begins on that workstation.

Three diagrams are used to show one complete process. The first diagram shows steps 1-5, the 
second diagram shows steps 6-11, and the third diagram shows steps 12-19. Each number 
corresponds to explanatory text in a table following the diagram.

In this example, the DHCP server and the Preboot Services/Imaging server are two separate 
servers on the network, although it is possible to run both from the same server with some 
additional configuration. This example also assumes that the client workstation and the servers are 
in the same segment.
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Diagram 1 (Steps 1-5)

Step Explanation

The workstation is turned on and begins to boot up. PXE (triggered by the BIOS, network interface card, or PXE-on-
Disk boot diskette) sends a DHCP request to the network. The DHCP request includes PXE extensions.

The DHCP server responds with an IP address for the workstation to use. This step may occur before or after Step 3.

The Proxy DHCP server responds with the IP addresses of the Preboot Services Transaction server, Preboot 
Services TFTP and MTFTP servers, and with the name of the Preboot Services client (dinic.sys).

The Preboot Services client includes a preboot component that makes the workstation available on the network 
before the operating system has loaded. This component ensures that the workstation can contact the Transaction 
server (in Step 7) even when there is no operating system installed on the workstation.

Using TFTP or MTFTP, the Preboot Services client (dinic.sys) is downloaded to the PXE client workstation.

By default, TFTP is used because it speeds the workstation’s boot process; however, you can change the 
configuration to use MTFTP. For more information, see “Installing and Setting Up Desktop Management Preboot 
Services” on page 595.

If a PXE-on-Disk boot diskette was used in Step 1, the Preboot Services client does not need to be downloaded, and 
this step does not occur.

The Preboot Services client is loaded on the PXE client workstation.
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Imaging Proxy Server
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Using ZENworks Desktop Management Preboot Services 593



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Diagram 2 (Steps 6-11)

Diagram 3 (Steps 12-19)

Step Explanation

The Preboot Services client reads the image-safe data and discovers the hardware on the workstation.

The Preboot Services client connects to the Transaction server and authenticates with the server. The Preboot Services 
client sends information about the workstation to the Transaction server with a request to find out if the PXE menu 
should be displayed on this workstation.

The Transaction server checks with zenpxe.nlm to see if the PXE menu should be displayed on this workstation.

Zenpxe.nlm checks with the Imaging Proxy Server to find out if the PXE menu should be displayed on this workstation.

The Imaging Proxy Server checks the PXE menu setting in the workstation object, workstation policy, or server policy 
that applies to this workstation. The possible settings include do not display, always display, or display only when a 
specific keystroke is pressed at the workstation during bootup.

The Imaging Proxy Server sends information about the PXE menu setting to the Transaction server.

The Transaction server sends information about the PXE menu setting to the Preboot Services client.
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Installing and Setting Up Desktop Management Preboot Services
For information about the hardware requirements for the Preboot Services server, see “Preboot 
Services Hardware Requirements” in the Novell ZENworks 6.5 Desktop Management Installation 
Guide.

For information about the requirements for workstations using Preboot Services, see “User 
Workstation Hardware Requirements” in the Novell ZENworks 6.5 Desktop Management 
Installation Guide.

For information about installing and setting up Desktop Management Preboot Services, see 
“Desktop Management Server Installation Procedure” in the Novell ZENworks 6.5 Desktop 
Management Installation Guide.

Checking the Preboot Services Server Setup
This section provides information on how to check the configuration of Desktop Management 
Preboot Services after it has been installed, and how to set up standard DHCP and Proxy DHCP 
services on the same server.

“Overview of Preboot Services Components” on page 596

Step Explanation

If the PXE menu should be displayed on the workstation, it is sent via TFTP or MTFTP to the workstation and is 
displayed. 

A user can make selections from the PXE menu. If the user selects to continue in automatic or diagnostic mode, the 
Preboot Services process continues with Step 13. If the user makes any other selection, the Preboot Services process 
does not continue.

If the PXE menu should not be displayed (or if the user is required to press a specific keystroke but does not), the 
Preboot Services process skips this step and continues with Step 13.

The Preboot Services client sends a request to the Transaction server to see if there is any imaging work specified 
for this workstation.

The Transaction server checks with zenpxe.nlm to see if there is any imaging work specified for this workstation.

Zenpxe.nlm checks with the Imaging Proxy Server to see if there is any imaging work specified for this workstation. 

The Imaging Proxy Server performs a limited check of attributes, multicast sessions, and imaging rules. (A more 
detailed check for imaging work is performed by the imaging engine after the workstation is booted to Linux.)

The Imaging Proxy Server sends information about any imaging work specified for this workstation to the Transaction 
server.

The Transaction server sends information about any imaging work specified for this workstation to the Preboot 
Services client.

The Preboot Services client contacts the TFTP server and downloads the files necessary to boot to the Desktop 
Management Workstation Imaging (Linux) environment (linux.1, linux.2, and loadlin.exe in ZENworks 6.5 Desktop 
Management SP1 and earlier; initrd, linux, and root in ZENworks 6.5 Desktop Management SP2 and later).

The workstation boots to the Desktop Management Imaging environment and proceeds with the imaging work.

12
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16

17

18

19
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“Checking the Setup on a Windows Server” on page 596

“Setting up Standard DHCP and Proxy DHCP Services on a Windows 2000 Advanced 
Server” on page 597

“Checking the Setup on a NetWare Server” on page 597

“Setting Up Standard DHCP and Proxy DHCP Services on a NetWare 6.x DHCP Server” on 
page 598

Overview of Preboot Services Components
The following components are installed as part of Preboot Services:

“Proxy DHCP Server” on page 596

“TFTP/MTFTP Server” on page 596

“Transaction Server” on page 596

Proxy DHCP Server

The Preboot Services Proxy DHCP server runs alongside a standard DHCP server to inform 
Preboot Services clients of the IP address of the TFTP, MTFTP, and Transaction servers. The 
Proxy DHCP server also responds to PXE clients to indicate which boot server (TFTP or MTFTP) 
to use.

TFTP/MTFTP Server

The Preboot Services TFTP/MTFTP server is used by the Preboot Services client to request files 
that are needed to perform imaging tasks. The TFTP server also provides a central repository for 
these imaging files (linux.1, linux.2, and loadlin.exe in ZENworks 6.5 Desktop Management SP1 
and earlier; initrd, linux, and root in ZENworks 6.5 Desktop Management SP2 and later). 

A PXE client uses this server to download the Preboot Services client.

By default, TFTP is used because it speeds up the workstation’s boot process; however, you can 
change the configuration to use MTFTP.

Transaction Server

The Preboot Services client connects to the Transaction server to check if there are any imaging 
actions that need to be performed on the workstation.

Checking the Setup on a Windows Server
After the Desktop Management Preboot Services components are installed, the following services 
should be installed and running on the server:

Proxy DHCP Server

MTFTP Server

TFTP Server

Transaction Server
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You should not need to change the default configuration of these services unless the default 
multicast IP is already in use in your environment or you moved any of the PXE-installed files 
from their default directories.

For information about configuring these services, see “Server Configuration” on page 599.

If the 2000/XP/2003 server where the Preboot Services components were installed is also a DHCP 
server, see “Setting up Standard DHCP and Proxy DHCP Services on a Windows 2000 Advanced 
Server” on page 597.

Setting up Standard DHCP and Proxy DHCP Services on a Windows 2000 
Advanced Server

Use the following steps to set up standard DHCP and Proxy DHCP Services on the same Windows 
2000 Advanced Server:

1 At the command prompt, enter netsh.

2 At the netsh prompt, enter dhcp server.

3 At the dhcp server prompt, enter the following:

add optiondef 60 ClassID STRING 0 PXEClient

4 Add the definition type in the DHCP setup menus.

Checking the Setup on a NetWare Server
After the Desktop Management Preboot Services components are installed, the following services 
should be installed and running on the server:

pmap.nlm

tftp.nlm

pdhcp.nlm

dts.nlm

You can use the pxestart.ncf file to start Preboot Services with a single command.

You can use the pxestop.ncf file to stop Preboot Services with a single command.

You should not need to change the default configuration of these services unless the default 
multicast IP is already in use in your environment or you moved any of the PXE-installed files 
from their default directories.

For information about configuring these services, see “Configuring Preboot Services Servers in 
NetWare” on page 614.

If the Preboot Services components were installed to a NetWare® 6.x server that is also a standard 
DHCP server, see “Setting Up Standard DHCP and Proxy DHCP Services on a NetWare 6.x 
DHCP Server” on page 598.
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Setting Up Standard DHCP and Proxy DHCP Services on a NetWare 6.x DHCP 
Server

Use the following steps to set up standard DHCP and Proxy DHCP Services on the same NetWare 
6.x DHCP server.
IMPORTANT: Installing and running the Proxy DHCP server on a NetWare 5.x server that is already running 
a standard DHCP server is not supported because the DHCP protocol on NetWare 5.1 does not deliver option 
60.

If you are running a NetWare 5.1 server but have upgraded the DHCP service to NetWare 6.x, 
follow Step 1 on page 598 to Step 6 on page 598. If you are running a NetWare 6.x server, begin 
at Step 7 on page 598.

1 Install the DNS-DHCP client from NetWare 6.x.

2 Copy dhcpsrvr.nlm, dnipinst.nlm, and nddprefs.dat from the sys:\system directory on the 
server to a backup location.

3 Copy dhcpsrvr.nlm, dnipinst.nlm, and nddprefs.dat from the sys\system directory on the 
NetWare 6.x CD to the sys\system directory on the server.

4 Using the DNS-DHCP console, export the DNS and DHCP records.

Note the Novell eDirectory locations of the DNS-DHCP locator and group objects and the 
DNS zone objects.

5 At the system console, enter load DNIPINST -R to remove DNS-DHCP and related 
schema extensions.

6 At the system console, enter load DNIPINST to install the updated DNS-DHCP and 
schema extensions.

7 Using the DNS-DHCP console, import the DNS and DHCP records.

8 Using the DNS-DHCP console, click Global Preferences on the toolbar, then click the Global 
DHCP Options tab.

or

Using the DNS-DHCP console, click the subnet in the left panel, then click the Other DHCP 
Options tab.

9 Click Modify.

10 Select Option 60 under Available DHCP Options, then click Add.

11 Type PXEClient in the Vendor Class Identifier text box, then click OK twice.

12 If this server is also a DNS server: at the system console, enter load NAMED.

13 At the system console, enter load DHCPSRVR.

14 Using a text editor, make the following changes to sys\system\pdhcp.ini:

Set USE_DHCP_Port to 0.

Make sure USE_BINL_PORT is set to 1.

15 Unload and reload pdhcp.nlm.
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Deploying Desktop Management Preboot Services In a Network 
Environment

To implement the network deployment strategies outlined in this section, you must have a solid 
understanding of the TCP/IP network protocol and specific knowledge of TCP/IP routing and the 
DHCP discovery process.

Deploying Desktop Management Preboot Services (PXE) in a single segment is a relatively simple 
process that only requires configuring the Imaging/Preboot Services server. However, Preboot 
Services deployment in a routed environment is far more complex and might require configuration 
of both the Imaging/Preboot Services server and the network switches and routers that lie between 
the server and the PXE workstations.

Configuring the routers or switches to correctly forward Preboot Services network traffic requires 
a solid understanding of the DHCP protocol, DHCP relay agents, and IP forwarding. The actual 
configuration of the switch or router will need to be carried out by a person with detailed 
knowledge of the hardware.

We strongly recommend that you initially set up Preboot Services in a single segment to ensure 
that the servers are configured correctly and are operational.

This section includes the following information:

“Server Configuration” on page 599

“Network Configuration” on page 600

Server Configuration
The Preboot Services environment requires a standard DHCP server, Proxy DHCP server, TFTP 
or MTFTP boot server, and Transaction server to function correctly. With the exception of the 
standard DHCP server, these are installed when you install Desktop Management Preboot 
Services. 

The following sections give general information about these services:

“DHCP Server” on page 599

“Proxy DHCP Server” on page 600

“TFTP and MTFTP Servers” on page 600

“Transaction Server” on page 600

It is seldom necessary to make changes to the default configuration of these services. However, if 
you need more detailed configuration information, see “Configuring Preboot Services Servers in 
Windows” on page 612 or “Configuring Preboot Services Servers in NetWare” on page 614.

DHCP Server

The standard DHCP server must be configured with an active scope that will allocate IP addresses 
to the PXE workstations. The scope options should also specify the gateway or router that the PXE 
workstations should use.

If Preboot Services (specifically the Proxy DHCP server) is installed on the same server as the 
DHCP server, then the DHCP server must be configured with a special option tag. For more 
information, see “Setting up Standard DHCP and Proxy DHCP Services on a Windows 2000 
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Advanced Server” on page 597 and “Setting Up Standard DHCP and Proxy DHCP Services on a 
NetWare 6.x DHCP Server” on page 598.
IMPORTANT: Installing and running the Proxy DHCP server on a NetWare 5.x server that is already running 
a standard DHCP server is not supported; you can, however, upgrade the DHCP server.

Proxy DHCP Server

The Preboot Services Proxy DHCP server runs alongside a standard DHCP server to inform PXE 
clients of the IP address of the TFTP server, MTFTP server, and Transaction server. The Proxy 
DHCP server also responds to PXE clients to indicate which boot server (TFTP or MTFTP) to use.

It is seldom necessary to make any changes to the default configuration.

If you don’t want to run the Proxy DHCP server on the same server as the Transaction server or 
TFTP server, you can change the Proxy DHCP settings to direct PXE workstations to a different 
server.
IMPORTANT: Installing and running the Proxy DHCP server on a NetWare 5.x server that is already running 
a standard DHCP server is not supported.

TFTP and MTFTP Servers

The Preboot Services TFTP and MTFTP servers are used by the Preboot Services client to request 
files that are needed to perform imaging tasks. The TFTP server also provides a central repository 
for these files. 

A PXE client uses one of these servers to download the Preboot Services client.

By default, TFTP is used because it speeds the workstation’s boot process; however, you can 
change the configuration to use MTFTP. For more information, see “Configuring Preboot Services 
Servers in Windows” on page 612 or “Configuring Preboot Services Servers in NetWare” on 
page 614.

Transaction Server

The Preboot Services client connects to the Transaction server to check if there are any imaging 
actions that need to be performed on the workstation.

It is seldom necessary to make any changes to the default configuration.

You can change the UDP port that the Transaction server uses for communicating with the Preboot 
Services client (by default it is UDP Port 18753). You should do this only if the Transaction server 
is conflicting with another service running on the server. For more information, see “Installing and 
Setting Up Desktop Management Preboot Services” on page 595.

Network Configuration
The configuration required to run Preboot Services in your network depends on your network 
setup. You can configure Preboot Services using any of the following network setups:

LAN environment with Preboot Services and DHCP running on separate servers

LAN environment with Preboot Services and DHCP running on the same server

WAN/VLAN environment with Preboot Services and DHCP running on separate servers

WAN/VLAN environment with Preboot Services and DHCP running on the same server
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This section covers the following topics:

“General Network Design Considerations” on page 601

“LAN Environment” on page 601

“WAN/VLAN Environment” on page 602

“Configuring a WAN/VLAN With Preboot Services and DHCP Running on the Same Server” 
on page 604

“Configuring a WAN/VLAN With Preboot Services and DHCP Running on Separate 
Servers” on page 607

“Configuring Filters on Switches and Routers” on page 609

General Network Design Considerations

Design your network so that Preboot Services clients can effectively connect to the Transaction 
server as well as to the TFTP or MTFTP servers. Make sure you consider the number of Preboot 
Services clients to be installed on the network and the bandwidth available to service these clients. 
To understand how the clients and servers need to interact during the Preboot Services process, see 
“Preboot Services Process Diagrams” on page 592.

Only one Proxy DHCP server should be installed per DHCP server scope.

TFTP servers should be installed so that Preboot Services clients have access to a TFTP server 
within their LAN. The bulk of network traffic generated by Preboot Services is between the 
Preboot Services clients and the TFTP server. A good design will ensure that a client does not need 
to connect to its TFTP server through a slow WAN link.

LAN Environment

The following sections provide information about setting up Preboot Services in a LAN 
environment:

“LAN Environment With Preboot Services and DHCP Running on Separate Servers” on 
page 601

“LAN Environment With Preboot Services and DHCP Running on the Same Server” on 
page 602

LAN Environment With Preboot Services and DHCP Running on Separate Servers

Information Details for This Setup

Scope Only PXE workstations in the LAN will connect to the Preboot Services server.

Example of Usage A small school workstation lab that is using Imaging to prepare the 
workstations between classes.

Advantages Easiest installation and setup.

No network configuration is required.

No DHCP server configuration is required.

Disadvantages Limited use, because a single-LAN environment only exists in small lab-type 
networks.
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LAN Environment With Preboot Services and DHCP Running on the Same Server

WAN/VLAN Environment

In a WAN, the PXE workstation is usually separated from the Proxy DHCP and DHCP servers by 
one or more routers. The PXE workstation broadcasts for DHCP information, but by default the 
router does not forward the broadcast to the servers, causing the Preboot Services session to fail.

In a VLAN (Virtual LAN) environment, the PXE workstation is logically separated from the Proxy 
DHCP server and the DHCP server by a switch. At the IP level, this configuration looks very 
similar to a traditional WAN (routed) environment.

In a typical VLAN environment, the network is divided into a number of subnets by configuring 
virtual LANs on the switch. Workstations in each virtual LAN usually obtain their IP address 
information from a central DHCP server. In order for this system to work, it is necessary to have 
Bootp or IP helpers configured on each gateway. These helpers forward DHCP requests from 
workstations in each subnet to the DHCP server, allowing the DHCP server to respond to 
workstations in that subnet.

The following sections provide information about setting up Preboot Services in a WAN/VLAN 
environment:

“WAN or VLAN Environment With Preboot Services and DHCP Running on Separate 
Servers” on page 603

“WAN or VLAN Environment With Preboot Services and DHCP Running on the Same 
Server” on page 604

Information Details for This Setup

Scope Only PXE workstations in the LAN will connect to the Preboot Services 
server.

Example of Usage A small school workstation lab with only one server that is using Imaging to 
prepare the workstations between classes.

Configuration 
Required

Because Preboot Services and DHCP are running on the same server, 
option tag 60 is set on the DHCP server.

For information on setting this tag, see “Setting up Standard DHCP and 
Proxy DHCP Services on a Windows 2000 Advanced Server” on page 597 
and “Setting Up Standard DHCP and Proxy DHCP Services on a NetWare 
6.x DHCP Server” on page 598.

Advantages Easy installation and setup. 

No network configuration is required.

Disadvantages DHCP server configuration is required (option tag 60). 

Limited use, because a single-LAN environment only exists in small 
lab-type networks.
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WAN or VLAN Environment With Preboot Services and DHCP Running on Separate 
Servers

Information Details for This Setup

Scope PXE workstations over the entire WAN/VLAN will connect to the Preboot 
Services server.

Example of Usage Any corporate or mid-size network that has the network divided into 
multiple subnets, but is running only one DHCP server.

Configuration 
Required

A DHCP relay agent or IP helper is configured on the router/switch serving 
the subnet that the PXE workstation belongs to. The helper is configured 
to forward all DHCP broadcasts that are detected in the subnet to the 
DHCP and Proxy DHCP servers.

This normally requires two helpers to be configured: the first to forward 
DHCP broadcasts to the DHCP server, and the second to forward the 
DHCP broadcasts to the Proxy DHCP server.

Advantages Common network setup.

Multiple Preboot Services servers can be installed so that each 
server provides service only for certain subnets. If multiple Preboot 
Services are installed, the Proxy DHCP server must be configured 
so it supplies the IP address of the central Transaction server. 

With this solution, the PXE workstation will receive a response from 
a Proxy DHCP server located on its subnet, but the workstation is 
redirected to a single central Transaction server to check for imaging 
work to do.

For information about changing the Proxy DHCP configuration, see 
“Installing and Setting Up Desktop Management Preboot Services” 
on page 595.

Disadvantages The network equipment (routers/switches) must be configured with 
additional IP helpers. Some network equipment may not function properly 
when more than one additional IP helper is configured.

Detailed Setup 
Information

“Configuring a WAN/VLAN With Preboot Services and DHCP Running on 
Separate Servers” on page 607
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WAN or VLAN Environment With Preboot Services and DHCP Running on the Same 
Server

Configuring a WAN/VLAN With Preboot Services and DHCP Running on the Same Server

If the switch is acting as a firewall and limiting the type of traffic on the network, it might be 
necessary to open certain UDP ports in the firewall. For a list of UDP ports used by Desktop 
Management Preboot Services, see “Configuring Filters on Switches and Routers” on page 609.

This section includes the following topics:

“Implementation” on page 604

“Installing the Proxy DHCP Server and the TFTP Server on the DHCP Server” on page 606

Implementation

The Desktop Management installation provides for a complete installation of the Preboot Services 
and Imaging components. If you want to install all of Imaging and Preboot Services on the DHCP 
server, then run the standard installation on the server.

However, you might want to run the Preboot Services components (Proxy DHCP and TFTP 
services) on the DHCP server and the Imaging and Transaction Server components on another 
server. 

Information Details for This Setup

Scope PXE workstations over the entire WAN/VLAN will connect to the Preboot 
Services server.

Example of Usage Any corporate or mid-size network that has the network divided into 
multiple subnets, but is running only one DHCP server.

Configuration Required The routers/switches have been configured with IP helpers to 
forward network traffic to the DHCP server.

Because Preboot Services and DHCP are running on the same 
server, option tag 60 is set on the DHCP server.

For information on setting this tag, see “Setting up Standard DHCP 
and Proxy DHCP Services on a Windows 2000 Advanced Server” 
on page 597 and “Setting Up Standard DHCP and Proxy DHCP 
Services on a NetWare 6.x DHCP Server” on page 598.

Advantages No network equipment (routers/switches) needs to be configured to 
forward network traffic to the Proxy DHCP server.

Disadvantages DHCP server configuration required (option tag 60). 

Only one Preboot Services server can be installed because it needs 
to run on the same server as the DHCP server (and there is usually 
only one DHCP server).

Detailed Setup 
Information

“Configuring a WAN/VLAN With Preboot Services and DHCP Running on 
the Same Server” on page 604
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If you want to configure the system like this, you need to do so manually by following the steps 
below.

1 Install Desktop Management Preboot Services on a server.

2 Test to make sure that the server is set up correctly.

2a Connect the server to a LAN with a PXE workstation in the same LAN. 

2b Assign imaging work to the workstation through a server or workstation policy in 
ConsoleOne.

2c Boot the workstation.

2d Verify that it picks up the imaging work correctly.

3 Stop the Desktop Management Proxy DHCP service on the server. 

For Windows, go to the Services panel and stop the Proxy DHCP Service. Set the service to 
Disabled so that it does not start the next time the server is started.

For NetWare, enter unload pdhcp at the server console to unload the Proxy DHCP service. 
Edit the zfdstart.ncf file and comment out the line that loads the Proxy DHCP service to 
prevent it from loading the next time the server is started.

4 If the Proxy DHCP service was running on the same server that was running DHCP, delete 
option tag 60 from the DHCP server that you added during the installation.

5 Install the Proxy DHCP service and TFTP service on the server that is running DHCP 
services.

For instructions on how to do this, see “Installing the Proxy DHCP Server and the TFTP 
Server on the DHCP Server” on page 606.

6 Configure option tag 60 on the DHCP server and set the tag to the text string PXEClient.

For instructions on how to do this, see “Setting up Standard DHCP and Proxy DHCP Services 
on a Windows 2000 Advanced Server” on page 597 and “Setting Up Standard DHCP and 
Proxy DHCP Services on a NetWare 6.x DHCP Server” on page 598.

7 Configure the Proxy DHCP service to redirect PXE workstations to the Preboot Services 
server that you set up in Step 1. 

For Windows, run the Proxy DHCP service configuration application and set the VSP IP to 
the IP address of the server that you set up in Step 1.

For NetWare, open pdhcp.ini and edit the TRANSACTION_SERVER_IP entry to the IP 
address of the server that you set up in Step 1.

8 Start the Proxy DHCP service that has just been installed on the server running DHCP 
services.

For Windows, start the service in the Service Control Manager.

For NetWare, enter load pdhcp at the server console.

PXE workstations in all VLANs that are supported by the DHCP server will now be able to pick 
up work through PXE.
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Installing the Proxy DHCP Server and the TFTP Server on the DHCP Server

This section includes the following topics:

Installing and Configuring Proxy DHCP and TFTP Servers on a NetWare Server

Installing and Configuring Proxy DHCP and TFTP Servers on a Windows Server

Installing and Configuring Proxy DHCP and TFTP Servers on a NetWare Server

1 Copy the following files to sys:\system on the destination server. These files can be obtained 
either from your working Preboot Services/Imaging server, or from the ZENworks Desktop 
Management Program CD.

pdhcp.nlm
pdhcp.ini
tftp.nlm
tftp.ini

2 Copy all the files from the sys:\tftp directory to a directory with the same name on the 
destination server.

3 Edit the tftp.ini file. Make sure that the ReadPath is the same as the path where you copied the 
TFTP files in Step 2.

4 If you want the services to start automatically, edit the autoexec.ncf file and add the following 
lines:

Load tftp

Load pdhcp

5 Start the services on the server by entering the following lines at the server console:

Load tftp

Load pdhcp

Installing and Configuring Proxy DHCP and TFTP Servers on a Windows Server

1 Stop all Desktop Management Preboot Services on the server where you installed Preboot 
Services. 

To do this, open the Service Control Manager (Control Panel > Administrative Tools > 
Services), and stop the Preboot Transaction Server, Preboot Port Mapper, Proxy DHCP 
Service, and Preboot TFTP/MTFTP Service.

2 Copy the entire subdirectory where you installed Desktop Management Preboot Services to 
the destination server. Typically, this subdirectory is \program files\zen_preboot_services. 

3 Using the Service Control Manager, restart the services on the original server that you stopped 
in Step 1.

4 On the destination server, perform the following steps. You will need to be logged in to the 
server with administrator rights.

This example assumes you copied all the files to c:\program files\zen_preboot_services.

4a Click Start > Run.

4b Type cmd, then press Enter to open a command console.

4c Type cd c:\program files\zen preboot services\pdhcp, then press 
Enter.
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4d Type dhcpservice -i, then press Enter.

4e Type dhcpcfg, then press Enter. This will start the Proxy DHCP configuration 
application.

4f Set the VSP Host IP to the IP address of the Imaging/Preboot Services server, click Save 
All, then click Exit.

4g Switch back to the command console.

4h Type cd c:\program files\zen preboot services\tftp, then press 
Enter.

4i Type tftpservice -I, then press Enter.

4j Type tftpcfg, then press Enter. 

The TFTP configuration applet starts. Make sure the TFTP Read Path is correct, and 
points to a subdirectory containing the TFTP files (dinic.sys, boot.dnx, bootzen2.bin, 
bootzen5.bin) as well as other files.

4k Click Exit to close the application.

5 Open the Service Control Manager, then start the Proxy DHCP and TFTP services that are 
now listed there.

or

Reboot the server and the services start automatically.

Configuring a WAN/VLAN With Preboot Services and DHCP Running on Separate Servers

If the switch is acting as a firewall and limiting the type of traffic on the network, it might be 
necessary to open certain UDP ports in the firewall. For a list of UDP ports used by ZENworks 
Desktop Management Preboot Services, see “Configuring Filters on Switches and Routers” on 
page 609.

An example deployment is given below of a WAN/VLAN environment with Preboot Services and 
DHCP running on the same server. Then, the following sections provide the specific steps required 
to configure network equipment so that it will correctly forward Preboot Services network traffic.

“Configuring Cisco Equipment” on page 608

“Configuring Nortel Network Equipment” on page 608

“Configuring Bay Network Equipment” on page 609

Example Deployment

In this example, three VLANs are configured on a Bay Networks Accel 1200 switch running 
firmware version 2.0.1. One VLAN hosts the Proxy DHCP server, the second VLAN hosts the 
DHCP server, and the third VLAN hosts the PXE client. The PXE client’s DHCP broadcast is 
forwarded by the switch to both the Proxy DHCP server and the DHCP server. The response from 
both servers is then routed correctly back to the PXE client, and the PXE client starts the Preboot 
Services session correctly.

The three VLANs are all 24-bit networks; their subnet mask is 255.255.255.0.

The first VLAN gateway is 10.0.0.1. This VLAN hosts the PXE client that is allocated an IP in the 
range of 10.0.0.2 to 10.0.0.128. This VLAN is named VLAN1.
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The second VLAN gateway is 10.1.1.1. This VLAN hosts the DHCP server with IP 10.1.1.2. This 
VLAN is named VLAN2.

The third VLAN gateway is 196.10.229.1. This VLAN hosts the server running the Proxy DHCP 
server and the Transaction server. The server’s IP is 196.10.229.2. This VLAN is named VLAN3.

Routing is enabled between all the VLANs. Each VLAN must be in its own spanning tree group.

Configuring Cisco Equipment

1 Go to Global Configuration mode.

2 Type ip forward-protocol udp 67, then press Enter.

3 Type ip forward-protocol udp 68, then press Enter.

4 Go to the LAN interface that serves the PXE workstation.

5 Type ip helper-address 10.1.1.2, then press Enter.

6 Type ip helper-address 196.10.229.2, then press Enter.

7 Save the configuration.

Configuring Nortel Network Equipment

1 Connect to the router with Site Manager.

2 Ensure that IP is routable.

3 Enable Bootp on the PXE workstation subnet/VLAN.

4 Select the interface that the PXE workstations are connected to.

5 Edit the circuit.

6 Click Protocols.

7 Click Add/Delete.

8 Ensure there is a check in the Bootp check box.

9 Press OK.

10 Click Protocols > IP > Bootp > Relay Agent Interface Table.

The interface where Bootp was enabled will be visible in the list.

11 Click Preferred Server.

12 Change the Pass Through Mode value to Bootp and DHCP.

13 Set up the relay agents:

13a Click Add.

13b In the Relay Agent IP Address box, type the local LAN IP address.

13c In the Target Server IP Address box, type the DHCP server IP address.

13d Click OK.

13e Change the Pass Through Mode value to Bootp and DHCP.

13f Perform Step 1 to Step 5 on page 608 again and enter the Proxy DHCP server IP address 
at Step 3 on page 608.

13g Apply the configuration.
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Configuring Bay Network Equipment

Perform the following steps on the switch:

1 Enable DHCP for the client VLAN using the following command lines:

# config vlan1 ip

# dhcp enable

2 Configure IP helpers to forward DHCP requests from the workstation subnet to the Proxy 
DHCP server, using the following command lines:

# config ip dhcp-relay

# create 10.0.0.1 10.1.1.2 mode dhcp state enable

# create 10.0.0.1 196.10.229.2 mode dhcp state enable

The create command has the form create agent server mode dhcp state enable, 
where agent is the IP address of the gateway that serves the PXE workstation, and server 
is the IP address of the server that the DHCP frame should be forwarded to.

3 Save the configuration.

Configuring Filters on Switches and Routers

Some network devices filter network traffic that passes through them. Preboot Services makes use 
of several different types of traffic, and all of these must be able to pass through the router or switch 
successfully for the Preboot Services session to be successful. The Preboot Services session uses 
the following destination ports:

Spanning Tree Protocol in Switched Environments

Spanning tree protocol (STP) is available on certain switches and is designed to detect loops in the 
network. When a device (typically a network hub or a workstation) is patched into a port on the 
switch, the switch indicates to the device that the link is active, but instead of forwarding frames 
from the port to the rest of the network, the switch checks each frame for loops and then drops it. 
The switch can remain in this listening state from 15 to 45 seconds.

The effect of this is to cause the DHCP requests issued by PXE to be dropped by the switch, 
causing the Preboot Services session to fail.

It is normally possible to see that the STP is in progress by looking at the link light on the switch. 
When the workstation is off, the link light on the switch is obviously off. When the workstation is 
turned on, the link light changes to amber, and after a period of time changes to a normal green 
indicator. As long as the link light is amber, STP is in progress.

Component Port

DHCP and Proxy DHCP Servers UDP Port 67, 68, and 4011

TFTP Server UDP Port 69

RPC Port Map Server UDP Port 111

Transaction Server UDP Port 18753
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This problem only affects PXE or Preboot Services clients that are patched directly into an 
Ethernet switch. To correct this problem, perform one of the following:

Turn off STP on the switch entirely.

Set STP to Port Fast for every port on the network switch where a PXE workstation is 
attached.

After the problem is resolved, the link light on the port should change to green almost immediately 
after a workstation connected to that port is turned on.

Information about STP and its influence on DHCP can be found at Using PortFast and Other 
Commands to Fix End-Station Startup Connectivity Problems (http://www.cisco.com/univercd/
cc/td/doc/cisintwk/itg_v1/tr1923.htm#xtocid897350).

Enabling PXE on a Workstation
To image a workstation using Preboot Services, you need to find out if the workstation is PXE 
capable, and then make sure that PXE is enabled.

PXE code is typically delivered with newer workstations (PC 99 compliant or later) on the NIC.

This section includes the following information:

“Enabling PXE on a PXE-Capable Workstation” on page 610

“Verifying That PXE Is Enabled on a Workstation” on page 611

“If a Workstation Is Not PXE Capable” on page 611

Enabling PXE on a PXE-Capable Workstation
When PXE is enabled, it can lengthen the time of the boot process slightly, so most NICs have PXE 
turned off by default. To enable PXE on a PXE-capable workstation:

1 Access the computer system BIOS and look at the Boot Sequence options.

The PXE activation method for a workstation varies from one manufacturer to another, but 
generally one of the following methods is used:

Some BIOSs have a separate entry in the BIOS configuration to enable or disable the 
PXE functionality. In this case, set either the PXE Boot setting or the Network Boot 
setting to Enabled.

Some BIOSs extend the entry that allows you to configure boot order. For example, you 
can specify that the system should try to boot from a diskette before trying to boot from 
the hard drive. In this case, set the system to try Network Boot before trying to boot from 
a diskette or from the hard disk.

2 If PXE is not listed in the Boot Sequence options and if the NIC is embedded in the 
motherboard, look at the Integrated Devices section of the BIOS, which might have an option 
to enable PXE. PXE might be called by another name, such as MBA (Managed Boot Agent) 
or Pre-Boot Service. 

After enabling PXE in the Integrated Devices section, look at the Boot Sequence options and 
move PXE so that it is first in the Boot Sequence.

3 Save any changes you have made and exit the system BIOS.

4 Reboot the workstation.
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If the workstation does not have the network adapter and PXE integrated into the motherboard, it 
uses the installed NIC management software to prompt you to start PXE configuration during the 
boot process. 

For example, many network adapters that are PXE aware will prompt you to press Control+S 
during the boot process to allow you to configure the PXE functionality. Other network adapters 
might prompt you to press Control+Alt+B or another key combination to configure PXE.

If the computer system does not have an integrated NIC, you might need to use NIC management 
software to configure your NIC to support PXE. Refer to your NIC documentation for support of 
PXE.

Verifying That PXE Is Enabled on a Workstation 
After you have activated PXE, it will become available in the Boot section of the BIOS. PXE is 
correctly enabled on a workstation when the workstation attempts to establish a PXE session 
during the boot process. You can see this happening when the workstation pauses during the boot 
process and displays the following on the screen:

CLIENT MAC ADDR: 00 E0 29 47 59 64

DHCP...

The actual message displayed varies from one manufacturer to another, but you can identify it by 
the obvious pause in the boot process as the workstation searches for DHCP.

If a Workstation Is Not PXE Capable
Some older workstations might not support PXE and require you to install PXE on them. There 
are several ways to do this:

Update your NIC or NIC driver. Most network adapter manufacturers supply a PXE Boot 
ROM chip that you can fit into your network adapter to enable PXE on the workstation. 
Contact the NIC manufacturer or a supplier to see if they sell a PXE Boot ROM. It is also 
possible that your current NIC might need an upgraded driver to become PXE-enabled.

Update your BIOS version. Most manufacturers that supply motherboards with the network 
adapter embedded in the motherboard offer a BIOS upgrade that will PXE-enable the 
workstation. Check the manufacturer’s Web site or contact a supplier to check for a BIOS 
upgrade.

Use the Desktop Management Preboot Services PXE-on-Disk utility if no PXE is available 
for the workstation. With this utility, you can create a boot diskette that enables the 
workstation to participate in the PXE environment. 

The PXE-on-Disk utility is installed to the Imaging server as part of Preboot Services (PXE 
Support) in Desktop Management and is available from the Create PXE Disk button in the 
Imaging Boot Disk Creator (in ConsoleOne, click Tools > ZENworks Utilities > Imaging > 
Create or Modify Boot Diskette).

For more information about using PXE-on-Disk, see “Using the Desktop Management 
Preboot Services PXE-on-Disk Utility” on page 617.
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Administering Desktop Management Preboot Services
This section includes information about administering and configuring Desktop Management 
Preboot Services. 

It includes the following topics:

“Configuring Preboot Services Servers in Windows” on page 612

“Configuring Preboot Services Servers in NetWare” on page 614

“Configuring IP Port Usage” on page 616

Configuring Preboot Services Servers in Windows
These sections explain how to configure the following Desktop Management Preboot Services 
servers:

“Configuring the TFTP Server” on page 612

“Configuring the MTFTP Server” on page 612

“Configuring the Proxy DHCP Server” on page 613

“Configuring the DHCP Server” on page 614

Configuring the TFTP Server

It is seldom necessary to change the default TFTP server configuration values. If you need to 
change them, use the following procedure:

1 From the Windows Desktop, click Start > Programs > ZEN Preboot Services > ZEN Preboot 
Services Configuration > TFTP Configuration to display the TFTP Configuration window.

2 Fill in the field:

TFTP Data Path: The data path should point to a directory where the TFTP server will look 
for files that are requested or written to by clients.

3 Click Save All to save new settings.

or

Click Exit to close the configuration utility without saving changes.

Configuring the MTFTP Server

It is seldom necessary to change the default MTFTP server configuration values. If you need to 
change them, use the following procedure:

1 From the Windows Desktop, click Start > Programs > ZEN Preboot Services > ZEN Preboot 
Services Configuration > MTFTP Configuration to display the MTFTP Configuration dialog 
box.
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2 Fill in the fields:

Multicast IP: Specify the address to be used as a destination during multicast transfers. 
Ensure that the address used falls within the IP address range designated for multicast. If you 
change this value, be sure to update the corresponding entry in the Proxy DHCP 
configuration.

Server Port: Specify the port number that the server expects to receive requests on. If you 
change this value, be sure to update the corresponding entry in the Proxy DHCP 
configuration.

Data Read Path: Specify the directory where the MTFTP server reads the files that are 
requested by clients.

3 Click Save All to save new settings.

or

Click Exit to close the configuration utility without saving changes.

Configuring the Proxy DHCP Server

The Proxy DHCP server provides Preboot Services clients with the information that they require 
to be able to connect to the Preboot Services system.

Use the following steps to check the settings of the Proxy DHCP server:

1 From the Windows Desktop, click Start > Programs > ZEN Preboot Services > ZEN Preboot 
Services Configuration > Proxy DHCP Configuration to display the Proxy DHCP 
Configuration dialog box.
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2 Check the fields:

Transaction Server IP: The Preboot client contacts the server on this IP address to check for 
imaging work.

TFTP Server IP: The PXE/Preboot client contacts the server on this IP address to download 
the Preboot client (dinic.sys) and the Imaging engine if imaging work is required.

Proxy DHCP IP: If this address is set, the Proxy DHCP server tries to bind to this IP address 
on the server. The IP address set must be a valid IP address on the server.

This setting can be used to force the Proxy DHCP server to use the virtual LAN adapter on a 
cluster server, rather than the physical LAN adapter of the server. 

This setting can also be used to force the PDHCP server to respond on only one interface on 
a multi-homed server.

All of the MTFTP settings in this dialog box should be the same as the settings that appear in 
the MTFTP Configuration Utility. Do not modify the MTFTP Client Port, MTFTP Open 
Timeout, MTFTP Reopen Timeout, and PXE Boot Menu Timeout settings from their default 
values.

3 Click Save All to save new settings.

or

Click Exit to close the configuration utility without saving changes.

You can set any of the IP address fields in the configuration utility to 0.0.0.0. The server replaces 
these entries with the IP address of the first network adapter installed in the server.

Configuring the DHCP Server

The DHCP server needs to have option 60 (decimal) added to the DHCP tags if the PDHCP and 
the DHCP servers are running on the same physical server. This option should be a string type and 
must contain the letters PXEClient.

For more information, see “Setting up Standard DHCP and Proxy DHCP Services on a Windows 
2000 Advanced Server” on page 597.

Configuring Preboot Services Servers in NetWare
After Desktop Management Preboot Services has been installed, it is seldom necessary to change 
the default server values. If you need to change the settings, however, you can do so by editing the 
appropriate .ini file for the server you want to change. These .ini files can be found on the Preboot 
Services server in the sys:\system directory.

This section contains the following information:

“Configuring the MTFTP/TFTP Module” on page 615

“Configuring the Proxy DHCP Module” on page 615

“Configuring the Transaction Server Module” on page 616

“Configuring the DHCP Server” on page 616
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Configuring the MTFTP/TFTP Module

You can set the path that the MTFTP/TFTP module uses for file access by modifying the tftp.ini 
file. The following options are available:

ReadPath: Set the path that the MTFTP/TFTP module uses for file access. The default value for 
this setting is sys:\tftp\.

WriteProtect: Set the value to 0 to cause the MTFTP/TFTP module to accept Write requests, or 
set the value to 1 to disallow Write requests.
NOTE: The variable names (for example, ReadPath) are case sensitive.

Configuring the Proxy DHCP Module

You can set the parameters that the Proxy DHCP module uses by modifying the pdhcp.ini file. The 
following options are available:

TRANSACTION_SERVER_IP: The Preboot client contacts the server on this IP address to 
check for imaging work.

TFTP_SERVER_IP: The PXE/Preboot client contacts the server on this IP address to download 
the Preboot client (dinic.sys) and the Imaging engine if imaging work is required.

PDHCP_Server_IP: If this address is set, the Proxy DHCP server tries to bind to this IP address 
on the server. The IP address set must be a valid IP address on the server.

This setting can also be used to force the Proxy DHCP server to use the virtual LAN adapter on a 
cluster server, rather than the physical LAN adapter of the server. 

This setting can be used to force the PDHCP server to respond on only one interface on a multi-
homed server.

BOOT_MENU_TIMEOUT: This setting controls how long (in seconds) the PXE boot menu is 
displayed while a PXE workstation boots.

USE_DHCP_PORT: Set this to 0 to bind to the BINL port (4011). This is only necessary if you 
are running proxy DHCP and another DHCP Server on the same machine. This setting replaces 
the older USE_BINL_PORT setting. 

USE_MTFTP: Set this option to 0 to disable multicast TFTP transfers. This is the default setting.

Set this option to 1 to enable multicast TFTP transfers. In this mode, the PXE client waits to join 
a multicast group for the transfer of the initial dinic.sys file. Enabling this option adds 10 to 20 
seconds to the PXE boot-up sequence, so this is not recommended.

MTFTP_IP: This value specifies the multicast IP that the server should use for MTFTP transfers.

MTFTP_SERVER_PORT: This value specifies the server port to use for MTFTP transfers.

MTFTP_CLIENT_PORT: This value specifies the client port to use for MTFTP transfers.

MTFTP_OPEN_TIMEOUT: Sets the time to wait before opening the MTFTP session.

MTFTP_REOPEN_TIMEOUT: Sets the time to wait before reopening the MTFTP session.
NOTE: The variable names (for example, MTFTP_IP) are case sensitive.
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Configuring the Transaction Server Module

You can set the parameters that the Transaction server module uses by modifying the dts.ini file. 
The following option is available:

Server UdpPort: Set this value to the UDP port number you want to use.
NOTE: This variable name is case sensitive.

Configuring the DHCP Server

For information on running the DHCP server and Proxy DHCP server on the same NetWare 6 
server, see “Setting Up Standard DHCP and Proxy DHCP Services on a NetWare 6.x DHCP 
Server” on page 598.

Configuring IP Port Usage
This section describes the network ports used by Desktop Management Preboot Services. Using 
this information in this section, you can configure routers or firewalls to correctly forward the 
network traffic generated by Preboot Services. For further information about configuring routers, 
see “Deploying Desktop Management Preboot Services In a Network Environment” on page 599.

The following sections contain additional information:

“Available Ports” on page 616

“Changing Port Usage in Windows Server” on page 617

“Changing Port Usage in NetWare” on page 617

Available Ports

Desktop Management Preboot Services uses both well-known and proprietary IP ports.

The well-known IP ports include:

67 decimal: The Proxy DHCP server listens on this port for PXE information requests. This 
is the same port used by a standard DHCP server.

68 decimal: The DHCP/Proxy DHCP server listens on this port for client requests.

69 decimal: The TFTP server listens on this port for file requests from PXE or Preboot 
Services clients.

111 decimal: Port mapper port. Refer to RFC 1057 (http://sunsite.iisc.ernet.in/collection/rfc/
rfc1057.html) for a description of this server.

The proprietary IP ports include:

360 decimal: The MTFTP server listens on this port for MTFTP requests from PXE or 
Preboot Services clients.

4011 decimal: The Proxy DHCP server uses this port to communicate with PXE clients, but 
only when running on the same server as the standard DHCP server.

18753 decimal: Transaction server client connection port. The Transaction server receives all 
connection requests from the Preboot Services clients on this port.
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Changing Port Usage in Windows Server

The Transaction server and MTFTP server can be configured to use different ports if necessary. To 
change the port, use the following procedure:

1 From the Windows server desktop, click Start > Programs > ZEN Preboot Services > ZEN 
Preboot Services Configuration > preboot_service_configuration.

2 Change the relevant settings in the configuration.

3 Stop and start the servers for the changes to take effect.

Changing Port Usage in NetWare

1 Edit the dts.ini file located in the same directory as the dts.nlm module.

2 Set ServerUdpPort to the port number you want to use.

3 Stop and start dts.nlm for the changes to take effect.

Using the Desktop Management Preboot Services PXE-on-Disk 
Utility

This section contains information that will help you understand the ZENworks Desktop 
Management Preboot Services PXE-on-Disk utility, prepare a workstation for it, and use it.

“What Is PXE-on-Disk Setup?” on page 617

“Creating a PXE-on-Disk Diskette” on page 617

“Booting with a PXE-on-Disk Diskette” on page 620

“If PXE-on-Disk Fails to Operate Correctly” on page 621
NOTE: If you upgraded to ZENworks Desktop Management from a previous version of ZENworks for 
Desktops, you can access the ZENworks PXE-on-Disk Manual from the Start menu. However, in order to 
access the latest information about this utility, you should use the information in this ZENworks Desktop 
Management Administration Guide.

What Is PXE-on-Disk Setup?
PXE-on-Disk Setup helps you create a 1.44 MB floppy diskette that contains all of the files needed 
to allow a non-PXE-compatible network adapter on a Windows workstation to communicate with 
a Desktop Management Preboot Services server. When you boot a workstation with a PXE-on-
Disk diskette in the floppy drive, it is as if that workstation had a PXE-enabled network adapter.

The PXE-on-Disk Setup program runs on the following operating systems:

Windows 95/98/ME

Windows 2000/XP

Creating a PXE-on-Disk Diskette
This section contains the following information:

“Creating the Diskette in a Windows Server Environment” on page 618

“Creating the Diskette in a NetWare Server Environment” on page 619
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Creating the Diskette in a Windows Server Environment

When you installed the Desktop Management Preboot Services component on a Windows server, 
the PXE-on-Disk creation program was also installed and registered. Use the following procedure 
to create a PXE-on-Disk diskette from your Windows server.

1 From the Windows desktop, click Start > Programs > ZEN Preboot Services > PXE-on-Disk 
to display the PXE-on-Disk Setup window.

or

In ConsoleOne, click Tools > ZENworks Utilities > Imaging > Create or Modify Boot 
Diskette > Create PXE Disk.

2 Insert an empty, formatted, high-density diskette in the disk drive.

3 Click OK to display the Driver and Information lists for PXE-compatible network adapters.
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Note that the network adapter (or adapters) installed on your server is detected and the 
specifications are listed in the Information list box of the Setup window. Some driver types 
might be duplicated. For example, Accton En1207d is the same as SMC 1211TX.

4 From the Driver List, select the name of the network adapter driver (or its nearest equivalent) 
that is installed on the client workstation you want to connect to the Preboot Services server.

5 Insert an empty, formatted, high-density diskette in the disk drive, then click Install to start 
creating a PXE-on-Disk diskette. 

When the installation is complete, the diskette contains appropriate PXE-on-Disk information 
for the intended client workstation.

6 Click Close to complete the creation of the PXE-on-Disk diskette.

Creating the Diskette in a NetWare Server Environment

1 From the sys:\public\zenworks\pxe directory, run psetupn.exe to display the PXE-on-Disk 
Setup window.

2 Insert an empty, formatted, high-density diskette in the disk drive.

3 Click OK to display the Driver and Information lists for PXE-compatible network adapters.
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The network adapter of machine you are using is detected and its specifications listed in the 
Information list box of the Setup window.

4 From the Driver List, select the name of the network adapter driver (or its nearest equivalent) 
that is installed on the client workstation you want to connect to the Preboot Services server.

Some driver types may be duplicated. For example, Accton En1207d is the same as SMC 
1211TX.

5 Click Install to start creating a PXE-on-Disk diskette. 

When the installation is complete, the diskette contains appropriate PXE-on-Disk information 
for the intended client workstation.

6 Click Close to complete the creation of the PXE-on-Disk diskette.

Booting with a PXE-on-Disk Diskette
Before you boot a client workstation with a PXE-on-Disk diskette, you should make sure that 
Desktop Management Preboot Services has been installed on a network server. This is the server 
that will communicate with the client workstation and give it workstation imaging tasks to 
perform. For more information about installing ZENworks Desktop Management Preboot 
Services on a server, see Step 12 under “Desktop Management Server Installation Procedure” in 
the Novell ZENworks 6.5 Desktop Management Installation Guide.

When you know that Desktop Management Preboot Services is installed on the server, you can 
reboot the client workstation with a PXE-on-Disk diskette. During the reboot cycle, the client 
workstation will:

1. Establish a connection with the Desktop Management Preboot Services server.

2. Execute any imaging work to be performed.

3. Continue its boot cycle.
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If PXE-on-Disk Fails to Operate Correctly
If PXE-on-Disk is not working, an incorrect network adapter is installed, or PXE-on-Disk is not 
installed on the diskette you are using to boot the workstation. To correct this, install a PXE-
enabled network adapter or reinstall PXE files on a diskette using the PXE-on-Disk setup utility. 
See “Creating a PXE-on-Disk Diskette” on page 617.

Using the Desktop Management Preboot Services Menu Editor 
Utility

This section contains information that will help you understand and use the ZENworks Desktop 
Management Preboot Services Menu Editor utility.

“What Is the Preboot Services (PXE) Menu?” on page 621

“What Is the Preboot Services Menu Editor?” on page 621

“Using the Preboot Services Menu Editor” on page 622
NOTE: If you upgraded to ZENworks Desktop Management from a previous version of ZENworks for 
Desktops, you can access the ZENworks Preboot Services Menu Editor Manual from the Start menu. 
However, in order to access the latest information about this utility, you should use the information in this 
ZENworks Desktop Management Administration Guide.

What Is the Preboot Services (PXE) Menu?
When a PXE-enabled workstation is booted, it broadcasts for DHCP information and receives a 
response from both the DHCP and Proxy DHCP servers. The workstation then downloads the 
Preboot Services client and check for imaging work with the Transaction server. If there is imaging 
work to do, the workstation displays a default Desktop Management Preboot Services (PXE) 
Menu displaying the following options:

Start ZENworks Imaging in Automatic Mode 

Start ZENworks Imaging in Maintenance Mode

Disable the ZEN Partition

Enable the ZEN Partition

Exit

What Is the Preboot Services Menu Editor?
If you want to create a custom Preboot Services (PXE) menu, you can use the Desktop 
Management Preboot Services Menu Editor to set and run your own actions and DOS utilities on 
the client workstation. Novell provides this utility as a service; no custom DOS or Linux utilities 
have been developed by Novell.

The Menu Editor is a Windows-based, option-driven utility that lets you do the following on the 
Preboot Services (PXE) menu:

Add menu items or submenus to the Preboot Services (PXE) menu

Add executable commands to be performed on the client workstation

Delete a submenu or an action from an existing menu
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The Menu Editor generates menu files and stores them on the Desktop Management Preboot 
Services server. These files can be selected from the Menu Editor interface and downloaded to a 
Preboot Services client workstation.

The following sections contain additional information:

“Installing the Preboot Services Menu Editor” on page 622

“Accessing the Preboot Services Menu Editor” on page 622

“Understanding the Preboot Services Menu Editor Interface” on page 622

Installing the Preboot Services Menu Editor

If you chose the Preboot Services component during the Desktop Management Preboot Services 
installation program, the Menu Editor is automatically installed on Windows servers you designate 
as Preboot Services servers. For more information, see “Desktop Management Server Installation 
Procedure” in the Novell ZENworks 6.5 Desktop Management Installation Guide. The Menu 
Editor is not installed to a NetWare server during the Preboot Services installation; the files must 
be accessed from a Windows workstation.

Accessing the Preboot Services Menu Editor

If you installed to a Windows server, you can access the Menu Editor from the Windows desktop 
(after the PXE-enabled Windows workstation is imaged) by clicking Start > Programs > ZEN 
Preboot Services > ZEN Preboot Services Menu Editor.

If you need to access the Menu Editor from a NetWare server, locate the files on the ZENworks 
Desktop Management Program CD in the \menu editor folder, then copy them to your NetWare 
server. Then, from a Windows machine, you can map a drive to the location on the server and run 
the Menu Editor.

Understanding the Preboot Services Menu Editor Interface

The Menu Editor interface is not available unless you are creating or editing an existing menu. Add 
and delete functions are available from the Options menu or from icons on the toolbar. Menu 
Editor functions can also be initiated with keyboard commands from a Windows workstation. For 
example, pressing the Insert key while in the Menu Editor adds a menu item, and pressing the 
Delete key deletes a menu item.

You can enter descriptive text about the menu in the Information field. You can also add help by 
entering appropriate text in the Help field.

Using the Preboot Services Menu Editor
Although you will probably use the default Preboot Services (PXE) Menu for Desktop 
Management Preboot Services, you might want to take advantage of the flexibility of the Preboot 
Services Menu Editor to create a new menu or to modify the default menu.

This section contains the following information:

“Modifying the Default Menu” on page 623

“Creating a New Preboot Services (PXE) Menu” on page 625

“Creating a Submenu” on page 626

“Creating Functions Within the Menu” on page 627
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“Saving the Menu as a .Dat File” on page 627

Modifying the Default Menu

There may be circumstances that require you to limit the options on the Desktop Management 
Preboot Services (PXE) menu. For example, you may want to restrict the user from using the 
Linux bash command line options. In such a case, you must create a new default menu and copy 
it to proper location on the Preboot Services server.

The following steps assume that you want to overwrite the existing default menu. If you want to 
save the options of this menu, we recommend that you rename defmenu.mnu (for example, 
defmenu_old.mnu), edit it with the Menu Editor to meet your needs, then save it again as 
defmenu.mnu.

To modify the default menu:

1 In the Windows desktop, click Start > Programs > ZEN Preboot Services > ZEN Preboot 
Services Menu Editor to display the following dialog box:

2 Click No to display the menu files that reside in the directory from which meditor.exe is 
running.

3 Select (or browse to) the defmenu.mnu you want to change, then click Open.
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4 Select the menu item that you want to delete, click Options, then click Delete to display a 
message similar to the following:

Do you want to delete Start ZEN Imaging Maintenance and its 
subitems?

5 Click Yes to return to the Menu Editor.

6 Click File > Save to open the Save As dialog box.

7 Select defmenu.mnu to enter this filename in the File Name field, then click Save. The 
following prompt is displayed:

 Do you want to overwrite the old file?

8 Click Yes to overwrite the file and to return to the Menu Editor window. 

You have now modified the defmenu.mnu menu template.

9 In the Menu Editor window, click File > Save to reopen the Save As dialog box.

10 In the Save As Type drop-down list, select ZEN Preboot Menu file (*.DAT).
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11 Select defmenu.dat to enter this filename in the File Name field, then click Save. The 
following prompt is displayed:

 Do you want to overwrite the old file?

12 Click Yes to overwrite the file and to return to the Menu Editor window. 

You have now modified the data file that will be displayed as the menu on a PXE workstation.

13 Copy the new defmenu.dat file to the /tftp folder on the Preboot Services server.

Creating a New Preboot Services (PXE) Menu

Use the following steps to create a new Preboot Services (PXE) menu using the Desktop 
Management Preboot Services Menu Editor:

1 In the Windows desktop, click Start > Programs > ZEN Preboot Services > ZEN Preboot 
Services Menu Editor to display the following dialog box:

2 Click Yes to display the Create Menu dialog box.

3 Enter the name of menu you want to create, then click OK to display the ZEN Preboot Menu 
Editor window.
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Creating a Submenu

If you want to create your own functions for the Preboot Services (PXE) menu, you need to create 
a submenu of these functions. Use the following steps to create a submenu.

1 Select Add from the Options menu to display the Add Menu Item window.

2 Select Submenu, then click OK to display the Add Menu dialog box.

3 In the Heading field of the dialog box, specify the text you want to use as the option in the 
submenu, then click OK.

The Menu Editor displays the submenu option as a subordinate item to the main menu you 
have already created. 

4 Enter descriptive and help text in the Information and Help fields.

5 Click Update to save the text of the submenu option and any accompanying text you have 
created.

Although the submenu item is now created and will appear on the Preboot Services (PXE) menu, 
it does not launch any utility; it is merely a text heading that serves as a navigation tool to options 
that actually perform functions.
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Creating Functions Within the Menu

As stated earlier in this document, Desktop Management Preboot Services ships with a Preboot 
Services (PXE) menu that allows only limited, predesigned actions from the client workstation. 
Novell does not ship other DOS or Linux utilities. However, if you want to add functionality of 
your own, you can do so with the Preboot Services Menu Editor.

To add executable commands to the Menu Editor:

1 In the Preboot Services Menu Editor window, select a menu item, click Options, then click 
Add to display the Add Menu Item window.

2 Select Execute Command, then click OK.

3 In the Execute Command dialog box, specify menu text that describes the functionality of 
your program, then click OK.

4 Specify the command parameters of the utility you want to run, then click OK.

5 Specify descriptive text about the item you have created, then click OK.

6 Specify any help text that you want to be accessible by an F1 command for this menu item, 
then click OK.

7 When you have finished creating the menu, click File > Save to save the structure.

By default, the file is saved in .mnu format, which is used as a template by the Preboot Services 
Menu Editor interface. To be used by the Preboot Services (PXE) menu, this file must be exported 
to a binary (.dat) format. For more information, see “Saving the Menu as a .Dat File” on page 627.

Saving the Menu as a .Dat File

To create a .dat file for the Preboot Services (PXE) menu using a .mnu file: 

1 Open the Preboot Services Menu Editor, then click No to display the existing .mnu files saved 
to your default folder (the same folder where the menu editor, meditor.exe, resides).

2 Select the .mnu file of the menu you want to export for later use by the Preboot Services (PXE) 
menu, click File, then click Export.

3 In the Save As Type drop-down list, select ZEN Preboot Menu file (*.dat).

4 In the file Name field, type DEFMENU, then click Save to return to the Menu Editor window. 
You have now created a data file that can be displayed as the default menu on a PXE 
workstation.

5 Copy the defmenu.dat file to the /tftp folder on the Preboot Services Server.

The .dat file is saved in the local folder from which you are running the Preboot Services Menu 
Editor. You must copy the file to the \tftp folder at the Preboot Services server.
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54 Setting Up Workstations for Imaging

The following sections cover procedures to prepare workstations for imaging. The procedures that 
are applicable to you depend on your imaging deployment strategy. For more information, see 
Chapter 50, “Common Imaging Deployment Strategies,” on page 571.

If you are using Preboot Services (PXE) as your imaging method, you need to enable PXE on the 
workstation. For more information, see “Using Preboot Services (PXE)” on page 577.

If you are using a Linux hard-disk partition as your imaging method, you need to create the 
partition on the workstation. For more information, see “Creating an Imaging Hard-Disk Partition” 
on page 587.

The following sections contain additional information:

“Workstation Requirements” on page 629

“Enabling a Workstation for Auto-Imaging Operations” on page 630

Workstation Requirements
This section gives the requirements for using a network-connected Windows workstation. 

It is possible (but usually not as convenient) to image a workstation without connecting to the 
network. It is also possible to image non-Windows workstations, but such operations can’t be fully 
automated through Novell® eDirectoryTM and the images can only be raw, bit-by-bit images of the 
entire hard disk, as opposed to customizable, file-by-file images of the data.

The following are the requirements for the workstation:

Workstation Must Have Because

A supported Ethernet 
card

The workstation must connect with the imaging server to store or retrieve the 
images. This connection is made when the workstation is under the control of 
the Desktop Management Workstation Imaging engine (which is a Linux 
application), not when the workstation is running under Windows. Therefore, 
make sure the workstation has a supported Ethernet card. For more 
information, see Chapter 63, “Supported Ethernet Cards,” on page 735.

Windows 98, 2000, or 
XP installed

Unattended operations based on Workstation objects are currently supported 
only on 32-bit Windows platforms.

50 MB free disk space Unless you are using Preboot Services, unattended operations require a 
Desktop Management Workstation Imaging (Linux) partition to be installed on 
the workstation hard disk, so that the imaging engine can gain control on 
bootup. The default partition size is 150 MB, and the minimum partition size is 
50 MB. This partition is not required if you are performing manual imaging 
operations using bootable CDs, DVDs, or diskettes (SP1 only).
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NOTE: Desktop Management Imaging does not support workstations running boot managers, such as System 
Commander. Boot managers create their own information in the MBR and overwrite the ZENworks boot 
system, which prevents the workstation from communicating with the Imaging server. If you are using boot 
managers in your environment, you should disable or remove them before performing imaging operations. 

Enabling a Workstation for Auto-Imaging Operations
The following procedure explains how to register the workstation as an object in your eDirectory 
tree, install a Desktop Management Imaging Agent on the workstation, and install a permanent 
Desktop Management Workstation Imaging (Linux) partition on the hard disk. 

Complete this procedure if you are not using Preboot Services (PXE). If you have enabled PXE on 
the workstation and have installed Desktop Management Preboot Services on your imaging server, 
this procedure is not a prerequisite to performing unattended imaging operations. For more 
information, see “Using Preboot Services (PXE)” on page 577.

This procedure needs to be performed only once prior to performing auto-imaging (unattended) 
operations. It is not a prerequisite to performing manual imaging operations.

1 If you haven’t already done so, install the Novell ClientTM on the workstation. For more 
information, see Chapter 1, “Understanding the Novell Client,” on page 31.

Desktop Management works with or without an installation of the Novell Client on the 
workstation. If your setup does not require the Client, then the Desktop Management 
Management Agent must be installed. For more information, see Chapter 2, “Understanding 
the Desktop Management Agent,” on page 35.

2 If you haven’t already done so, register the workstation as an object in your eDirectory tree 
that contains the Desktop Management Workstation Imaging server. 

When you boot a Windows workstation from an imaging device or method and allow the 
bootup process to proceed in auto-imaging mode, the imaging engine runs on the workstation 
and contacts a Desktop Management Workstation Imaging server. In order for the workstation 
to be imaged, you must first either define an eDirectory policy for the Desktop Management 
Workstation Imaging server (for more information, see “Defining an Imaging Policy for 
Unregistered Workstations (Server Policy)” on page 633), or you must register the 
workstation as an object and configure Imaging on the Workstation object.

For more information on registering the workstation as an object, see “Automatic Workstation 
Import and Removal” on page 77.

You don’t need to complete all the tasks mentioned in the instructions. Just create a Server 
policy package that contains a minimal Workstation Import policy (use the defaults for 
naming, groups, and limits), and then associate the Server package with the container where 
you want the Workstation object to be created. Then, configure the workstation to 
communicate with the import service on the Imaging server, and reboot the workstation. 
Before proceeding with the next step, check your eDirectory tree to make sure that the 
Workstation object was created.

Standard hardware 
architecture

NEC* PC98 architecture is not supported.

PXE enabled If you are using Desktop Management Preboot Services, PXE must be 
enabled either in the BIOS or through a PXE boot disk. See “Using Preboot 
Services (PXE)” on page 577 for more information.

Workstation Must Have Because
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3 Set a flag in the Workstation object that triggers the imaging operation you want.

For more information, see “Performing an Automatic Imaging Creation or Restoration” on 
page 644.

4 Install the Desktop Management Imaging Agent on the workstation.

When you put a new base image on a Windows workstation, the workstation receives the same 
identification data as the workstation from which the image was taken, including such settings 
as the IP address and computer (NETBIOS) name. To work around this, you can install the 
ZENworks Desktop Management Imaging Agent on the target workstation before reimaging 
it. This saves the workstation’s current identity settings to an area on the hard disk that’s safe 
from reimaging. When the workstation reboots after being reimaged, the agent restores the 
original settings.
IMPORTANT: The Imaging Agent does not save or restore any Windows 2000/XP Domain information. 
If you change a workstation’s domain and then restore an image, the workstation receives whatever 
domain is embedded in the new image.

The Desktop Management Imaging Agent has already been installed on the workstation if in 
Step 1 you did a custom Novell Client installation and chose the Imaging Services option. If 
this is the case, skip to Step 5. Or, you can choose to install the Imaging Agent by running the 
ZISD-9x or ZISD-NT application object on the workstation. Otherwise, proceed with Step 4a 
to install the Desktop Management Imaging Agent.

4a Browse to the sys:\public\zenworks\imaging folder in your ZENworks Desktop 
Management installation (on the Imaging server).

4b Complete the steps that correspond to the type of workstation:

4c Reboot the workstation.

Workstation Type Steps

Windows 98 1. Copy ziswin.exe, zislib16.dll, and zislib32.dll to the novell\zenis 
folder.

2. Run ziswin.exe from the novell\zenis folder.

3. Run regedit.exe and browse to HKEY_LOCAL_MACHINE > 
Software > Microsoft > Windows > CurrentVersion > 
RunServices.

4. Add the string value ZENwork Imaging Service and set it to 
the filename and path of the ziswin.exe file. For example, 
c:\novell\zenis\ziswin.exe

5. Save the changes and close regedit.

Windows 2000 1. Copy ziswin.exe and ziswinr.dll (in the nls\english subfolder or 
the appropriate language subfolder) to your winnt\system32 
folder.

2. From a command prompt, change to your winnt\system32 
folder, type ziswin -install, then press Enter.

Windows XP 1. Copy ziswin.exe and ziswinr.dll (in the nls\english subfolder or 
the appropriate language subfolder) to your 
windows\system32 folder.

2. From a command prompt, change to your windows\system32 
folder, type ziswin -install, then press Enter.
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5 Take an image of the workstation as instructed in “Manually Taking an Image of a 
Workstation” on page 647. 
IMPORTANT: Do this even if you have taken an image of the workstation previously. This ensures that 
the new image captures the changes you made in the preceding steps.

6 When the image has been created, reboot the workstation with the first imaging boot diskette 
(or other imaging boot method), type install at the boot prompt, then press Enter.

This starts the process of creating the Desktop Management imaging partition in the first 
partition slot. It also destroys all existing partitions, even if slot 1 is empty and available. By 
default, the Desktop Management imaging partition size is 150 MB.

If the Desktop Management imaging partition already exists, it will be upgraded, and your 
existing Windows partitions will be left intact. For information on updating Linux device 
drivers (SP1 only) in your hard-disk partition, see “Adding Linux Drivers to Your Boot 
Method” on page 588.

7 If prompted, reinsert the first imaging boot diskette, then press Enter.

8 (Optional) When the Desktop Management imaging partition has been created and the bash 
prompt reappears, type img dump, then press Enter.

This displays a list of the partition slots on the workstation. Unless you were upgrading your 
Desktop Management imaging partition, each partition slot should be empty and none should 
be active. The Desktop Management imaging partition is hidden from the list, so the number 
of partition slots in the list should be one less than before.

or

Type img to display a menu, select Dump, then select No Geometry.

9 At the bash prompt, restore the image you took in Step 5. Use the img restorep command or 
select Restore an Image, then select Proxy Image from the menu as instructed in Step 7 of 
“Manually Putting an Image on a Workstation” on page 651.

10 (Optional) When the image has been restored and the bash prompt reappears, use the img 
dump command to redisplay the list of the partition slots on the workstation.

or

Type img to display a menu, select Dump, then select No Geometry.

You should now see information about the Windows partitions that were restored and 
activated. There should still be one less partition slot than before because the Desktop 
Management imaging partition is still hidden (and will continue to be).

11 At the bash prompt, type lilo.s, then press Enter.

12 When the bash prompt reappears, remove the diskette and reboot the workstation.

The workstation should boot to Windows. If the bash prompt reappears, enter the lilo.s 
command again and reboot a second time.

From this point on, whenever the workstation is rebooted, the imaging engine takes control and 
checks the Imaging server to see if an imaging operation should be performed. If you have not 
configured the Workstation object in eDirectory to trigger an unattended imaging operation, the 
imaging engine simply exits and automatically reboots the workstation to Windows.
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55 Setting Up Imaging Policies

The following sections explain how to set up policies for Novell® ZENworks® Desktop 
Management imaging services, and how to select general imaging server settings. The procedures 
that are applicable to you depend on your imaging deployment strategy. For more information, see 
Chapter 50, “Common Imaging Deployment Strategies,” on page 571.

The following sections contain additional information:

“Defining an Imaging Policy for Unregistered Workstations (Server Policy)” on page 633

“Defining an Imaging Policy for Registered Workstations (Workstation Policy)” on page 635

“Allowing Overwriting Filenames and Restricting Save Location of Image Files (Imaging 
Server Settings)” on page 637

Defining an Imaging Policy for Unregistered Workstations (Server 
Policy)

If a Windows workstation hasn’t been registered as a Workstation object in Novell eDirectory and 
you boot that workstation from an imaging method in auto-imaging mode, the Imaging server is 
contacted and checks its Imaging Server policy in eDirectory to determine which image to put 
down on the workstation. 

If the base image specified by the policy is the same as the base image currently on the workstation 
(as reported by the imaging engine), the Imaging server doesn’t send any new images to put down 
on the workstation, unless the policy specifies to force down the base image again. If the policy 
specifies to force down the base image, or if the base image currently on the workstation is 
different than the base image specified by the policy, the Imaging server sends down the new base 
image and any add-on images specified by the policy, and the imaging engine puts these images 
down on the workstation.
WARNING: If you configure an Imaging Server policy to send an add-on image only (no base image) to a 
workstation, the workstation receives the add-on image, but it also reboots and brings down the image again, 
resulting in a reboot/imaging loop.

In addition, if the imaging engine reports to the Imaging server that data is missing from the 
workstation’s image-safe area, the Imaging server obtains the missing data from the Imaging 
Server policy and sends it to the imaging engine, which then saves the data to the image-safe area.

To define the Imaging Server policy for one or more Imaging servers:

1 Prepare the various workstation images that the policy can prescribe. For details, see Chapter 
56, “Creating and Restoring Images,” on page 639.

2 If a Server Package hasn’t already been created to hold the policies for the target imaging 
servers, create one as instructed in Chapter 10, “Creating Policy Packages,” on page 103.

3 Right-click the Server Package, then click Properties.
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4 Enable the Imaging Server policy, then click Properties to display the Rules page.

5 Click Add to display the New Image Selection Rule dialog box.

6 Click the browse button next to the Use This Image field to select a Workstation Image object 
(for more information, see “Creating a Workstation Image Object” on page 642), use the drop-
down fields and operators to specify the conditions under which the selected image should be 
used (click Help for details), then click OK.

Repeat this step as needed to provide rules that covers all the workstations serviced by the 
target Imaging servers.

These rules are used by your Imaging server to determine which image to put on workstations 
during unattended imaging operations. The various hardware configuration data specified in 
the rules is compared against the actual hardware configuration data detected by the 
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Workstation Imaging engine on the workstation. To see this data for a particular workstation, 
boot it with the imaging boot diskettes (SP1 only) in manual mode and issue the img info 
command or enter img, then select Information from the menu.

Take care to choose rules that apply only to the unregistered workstations you want imaged. 
Otherwise, an image could be unintentionally pushed to another workstation.

7 (Optional) If you want the Imaging server to force down the base image determined by this 
policy even if it is the same as the base image currently on the workstation, select the Force 
Down a ZENworks Base Image to a Machine check box on the bottom of the Rules page.
WARNING: Use this option with care, because putting down a base image destroys all data that was 
added to the workstation since the last base image was put down. In most scenarios, you’ll want to use 
this option only while a specific workstation is being imaged and not generally for all workstations, unless 
this policy is designed for a lab environment where you want the workstations to be reimaged every time 
they reboot. If you select this option as a temporary measure, be sure to deselect it after the specific 
imaging task is done.

8 (Conditional) If you are using Preboot Services but previously booted workstations from a 
Desktop Management Workstation Imaging (Linux) partition, you can disable the Desktop 
Management imaging partition on the Imaging Partition property page (click the down-arrow 
next to Work To Do, click Imaging Partition, then select the Disable the ZENworks Imaging 
Partition, If It Exists check box). The partition is disabled but is not removed with this option.

9 (Optional) If you want to specify the availability of the PXE menu, which displays when you 
boot a PXE-enabled workstation, click the PXE Settings tab, then select an option. Click Help 
for details. 

If you want to specify a different image when using Preboot Services, rather than the default 
image that is defined, specify the image file and pathname.

10 On the Image-safe Data tab, fill in the IP Configuration, Windows Networking, and DNS 
Settings pages.

These pages supply image-safe data values that might be missing on the workstations that are 
serviced by the target Imaging servers. For details on these pages, click Help.

11 Click OK to save the policy.

12 On the properties of the Server Package, click the Associations tab, add the containers and/or 
server objects that represent the target set of Imaging servers, then click OK.

Remember that the policy won’t actually be consulted by the associated Imaging servers unless the 
client requesting the imaging operation is an unregistered workstation that has been booted in auto-
imaging mode.

Defining an Imaging Policy for Registered Workstations 
(Workstation Policy)

If a Windows workstation has been registered as a Workstation object in eDirectory and you boot 
that workstation from an imaging method in auto-imaging mode, the Imaging server is contacted 
and checks the Workstation object to see if the administrator has flagged it to receive an image. If 
this is the case and the administrator hasn’t specified which image to use, the Imaging server 
consults the Workstation Imaging policy associated with the Workstation object to determine 
which image to send down.
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To define the Workstation Imaging Policy for one or more workstations:

1 Prepare the various workstation images that the policy can prescribe. For details, see Chapter 
56, “Creating and Restoring Images,” on page 639.

2 If a Workstation Package hasn’t already been created to hold the policies for the target 
workstations, create one as instructed in Chapter 10, “Creating Policy Packages,” on 
page 103.

3 Right-click the Workstation Package, then click Properties.

4 Enable the Workstation Imaging policy, then click Properties to display the Rules page.

5 Click Add to display the New Image Selection Rule dialog box.
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6 Click the browse button next to the Use This Image field to select a Workstation Image object 
(for more information, see “Creating a Workstation Image Object” on page 642), use the drop-
down fields and operators to specify the conditions under which the selected image should be 
used (click Help for details), then click OK.

Repeat this step as many times as needed to specify the particular images that should be used 
under different conditions.

These rules are used by your Imaging server to determine which image to put on workstations 
during unattended imaging operations. The various hardware configuration data specified in 
the rules is compared against the actual hardware configuration data detected by the 
Workstation Imaging engine on the workstation. To see this data for a particular workstation, 
boot it with the imaging boot diskettes (SP1 only) in manual mode and issue the img info 
command or enter img, then select Information from the menu.

Take care to choose rules that apply only to the workstations you want imaged. Otherwise, an 
image could be pushed to another workstation unintentionally.

7 (Conditional) If you are using Preboot Services but previously booted workstations from a 
Desktop Management Workstation Imaging (Linux) partition, you can disable the Desktop 
Management imaging partition on the Imaging Partition property page (click the down-arrow 
next to Work To Do, click Imaging Partition, then select the Disable the ZENworks Imaging 
Partition, If It Exists check box). The partition is disabled but is not removed with this option.

8 (Optional) If you want to specify the availability of the PXE menu, which displays when you 
boot a PXE-enabled workstation, click the PXE Settings tab, then select an option. Click Help 
for details.

If you want to specify a different image when using Preboot Services, rather than the default 
image that is defined, specify the image file and pathname.

9 Click OK to save the policy.

10 On the properties of the Server Package, click the Associations tab, add the container, 
Workstation Group, or Workstation objects that represent the target set of workstations, then 
click OK.

Remember that the policy won’t actually be consulted by the Imaging server unless you (or another 
administrator) flag a Workstation object to receive an image on the next boot.

Allowing Overwriting Filenames and Restricting Save Location of 
Image Files (Imaging Server Settings)

Most of the rules that comprise an Imaging Server Policy apply only when the Imaging server is 
servicing a request to auto-image a workstation. Such rules aren’t in force when the Imaging server 
is servicing a manual (command line or menu) imaging request. 

However, the following two aspects of the Imaging Server policy are actually Imaging server 
settings that always apply, including when the Imaging server is servicing an automatic imaging 
request, when the Imaging server is servicing a manual imaging request, when registered 
workstations are booting up, and when unregistered workstations are booting up:

Whether to allow the creation of new image files that overwrite existing image files on the 
server

Whether to restrict the creation of new image files on the server to specific areas
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To define these general behaviors for one or more Imaging servers:

1 If a Server Package hasn’t already been created to hold the policies for the target Imaging 
servers, create one as instructed in Chapter 10, “Creating Policy Packages,” on page 103.

2 Right-click the Server Package, then click Properties.

3 Enable the Imaging Server Policy, then click Properties.

4 Fill in the items on the Security tab. Click Help for details.

5 Click OK to save the policy.

6 On the Associations page, add the containers and/or server objects that represent the target set 
of Imaging servers.

7 Click OK to save the association.
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56 Creating and Restoring Images

Novell® ZENworks® Desktop Management provides tools for creating and compressing images 
of workstation hard disks as well as images of specific add-on applications or file sets. Desktop 
Management also provides tools for customizing such images and for making images available to 
auto-imaging operations through Novell eDirectoryTM. 

Desktop Management Imaging supports devices that physically connect to the network that meet 
the minimum requirements for workstations. For more information, see “User Workstation 
Hardware Requirements” in the Novell ZENworks 6.5 Desktop Management Installation Guide. 
Desktop Management Imaging does not support imaging operations (creating or restoring images) 
using wireless connectivity.
NOTE: Desktop Management Imaging does not support workstations running boot managers, such as System 
Commander. Boot managers create their own information in the MBR and overwrite the ZENworks boot 
system, which will prevent the workstation from communicating with the Imaging server. If you are using boot 
managers in your environment, you should disable or remove them before performing imaging operations. 

The following sections explain how to perform these tasks:

“Creating a Workstation (Base) Image” on page 639

“Creating an Add-On Image” on page 640

“Using Image Explorer to Customize an Image” on page 640

“Making an Image Available for Automatic Imaging” on page 641

“Performing an Automatic Imaging Creation or Restoration” on page 644

Creating a Workstation (Base) Image
A base image is an image of all the partitions and data on a source workstation’s storage devices, 
such as hard disks. Normally, such an image is prepared with the intent to completely replace the 
contents of a target workstation’s storage devices.

The overall process to create a base image is:

1. Boot the source workstation from an imaging method.

2. Run the Desktop Management Workstation Imaging engine to take an image of the 
workstation.

You can do this manually or automatically. In manual mode, you interrupt the bootup process 
and issue an imaging command at the Linux prompt. For more information, see “Manually 
Taking an Image of a Workstation” on page 647. In automatic mode, you set a flag in the 
workstation’s Workstation object using ConsoleOne® and then let the bootup process proceed 
without interruption. For more information, see “Performing an Automatic Imaging Creation 
or Restoration” on page 644.
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Creating an Add-On Image
An add-on image is an archived collection of files to be applied to an existing Windows installation 
on a target workstation. This is sometimes referred to as an application overlay. The existing 
partitions and files on the target workstation are left intact, except for any files that the add-on 
image might update.

An add-on image typically corresponds to an application or utility, or simply to a set of data files 
or configuration settings. There are two ways to create an add-on image, each resulting in a 
different kind of add-on image:

Produce the add-on image from an Application object

You do this in ConsoleOne by using the Imaging property page (on the Common tab) of the 
Application object. For details, click Help on that property page.

An add-on image created in this manner is not fully installed on the target workstation until 
after the workstation reboots from being imaged, the user logs in locally, and Application 
Launcher/Explorer starts up and force runs the new Application object. Deploying the image 
is essentially another way to distribute an Application object.

Drag files into a new image archive using Image Explorer

You do this by starting Image Explorer, dragging files and folders from an existing Windows 
installation into the new image archive, and saving the archive to a file with a .zmg extension 
(case-sensitive). For more information, see “Image Explorer (imgexp.exe)” on page 673.

Generally, an add-on image created in this manner doesn’t require any post-processing on the 
target workstation. It is simply a set of files that are copied to the appropriate locations on the 
hard disk, much like what happens when you unzip a WinZip archive. One exception is that 
the add-on image can contain Windows registry (.reg) files that are applied to the registry 
automatically when the workstation reboots after being imaged, if the Imaging Agent is 
installed on the workstation. For more information, see “Using Image Explorer to Customize 
an Image” on page 640.

Using Image Explorer to Customize an Image
After you have created a base or add-on image as explained in the previous sections, you can 
customize it using the Image Explorer utility. Specifically, you can:

Compress the image: You can compress an image (including images created by previous 
versions of Desktop Management) by 40-60% of the original file size, if you have not done 
so already during the imaging process. There are three compression options. Optimize for 
Speed takes the least amount of time but creates the largest compressed image file. Optimize 
for Space creates the smallest image file but might take a significant amount of time. Balanced 
is a compromise between compression time and image file size. This option is used by default 
when an image is created.

(You can also use the options on the ZENworks Imaging Configuration property page for the 
workstation object in ConsoleOne to specify compression options if you do not want the 
default setting, which is Balanced.)

Desktop Management provides the following compression methods:

Compress: Use this option to compress an image file that you currently have open in 
Image Explorer. For more information, see “Compressing an Open Image” on page 677.
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QuickCompress: Use this option to compress an image file without waiting for the file 
to fully load into Image Explorer. For more information, see “Compressing Any Image 
without Waiting for the File to Fully Load into Image Explorer” on page 677.

Split the image: You can specify a workstation image file that you want to split into separate 
files so that the entire image can be spanned across several CDs or DVDs. Splitting a 
workstation image is helpful for putting down or restoring images in a disconnected 
environment. For more information, see “Splitting a Workstation Image” on page 677.

Resize a partition in an image: For workstation (base) images, you can edit the value in the 
Original Size text box to allow you to change how big the imaging engine will make the 
partition when the image is restored. For more information, see “Resizing a Partition in an 
Image” on page 678.

Purge deleted files: Excluded or hidden files and folders can be completely removed from an 
open image. This saves space in the image if you no longer want to include the files. For more 
information, see “Excluding a File or Folder from the Open Image” on page 675.

Exclude individual files and folders from the image: In doing this, you create variants of 
the image by specifying which of ten possible filesets (variants) to exclude a given file or 
folder from. The variants exist merely as internal attributes of the same image archive. For 
more information, see “Purging Files and Folders Marked for Deletion from the Open Image” 
on page 675.
IMPORTANT: Do not exclude BPB files from a base image or the workstation won’t be able to boot the 
new operating system after receiving the image.

Add files and folders to the image: By default, any file or folder you add is included in all 
variants. To change this, you must explicitly exclude the file or folder from one or more 
variants. For more information, see “Adding a File or Folder to an Open Image” on page 675.

Add Windows registry (.reg) files: The registry settings contained in the .reg files that you 
add are applied after the image is put down and the target workstation reboots to Windows, if 
the Imaging Agent has been installed on the workstation.

As with any other file or folder that you add, a .reg file is included in all variants of the image 
unless you explicitly exclude it from one or more variants. For more information, see “Adding 
Specific Windows Registry Settings That Are to Be Applied After the Open Image is Laid 
Down” on page 675. 

For information on starting Image Explorer, see “Image Explorer (imgexp.exe)” on page 673.

Making an Image Available for Automatic Imaging
When you boot a workstation from an imaging method and allow the bootup process to proceed 
in auto-imaging mode, the imaging operation that is performed on the workstation is determined 
by policies and settings that you define in eDirectory.

In order to make an image available to such operations, you must expose it as a Workstation Image 
object in eDirectory. Otherwise, when you define imaging policies and settings in eDirectory, you 
won’t have any way to refer to the image. 

Creating a Workstation Image object also allows you to combine a base image and one or more 
add-on images into a single entity that can be put down on target workstations. You can specify a 
standard image file to put down, or you can create a script to further customize your imaging 
operation. You can also specify that a particular variant of an image be used. 
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The sections that follow give instructions for performing these tasks:

“Creating a Workstation Image Object” on page 642

“Associating an Add-On Image with a Base Image” on page 643

“Using a Variant of an Image” on page 643

Creating a Workstation Image Object
1 Create the base image that the Workstation Image object will refer to. For more information, 

see “Creating a Workstation (Base) Image” on page 639.

Although it isn’t typical, you can create a Workstation Image object that refers only to one or 
more add-on images. However, if you want a base image to be put down in the same operation 
as the add-on images, you should include both types of images in the Workstation Image 
object.

2 Copy the image file to a Desktop Management Workstation Imaging server that is accessible 
as a server object in your eDirectory tree.

3 In ConsoleOne, open the eDirectory tree and browse to the container where you want to create 
the Workstation Image object.

4 Right-click the container, click New, click Object, select Workstation Image from the list of 
object classes, then click OK.

5 Specify a name for the new object.

Example: Dell Image

6 Click Define Additional Properties, then click OK.

7 Click Use Standard Imaging.

or

Click Use Scripted Imaging, then specify the script you want to use. See the online help for 
examples of how you can use scripts. Skip to Step 10.
NOTE: You can perform scripted imaging operations from the bash prompt by using the imaging.s 
command.

8 Under Base Image File, click the browse button next to the field, select the Imaging server 
where the image resides, select or specify the path and filename of the image, then click OK.

For details on selecting or specifying the path and filename, click Help in the Image File 
Location dialog box.

If the Workstation Image object will consist only of add-on images, leave the Base Image File 
field blank, and skip to Step 5 of “Associating an Add-On Image with a Base Image” on 
page 643.

9 (Conditional) If you are using Preboot Services but formerly booted from Desktop 
Management Workstation Imaging (Linux) partitions on workstations, you can delete the 
Desktop Management imaging partition at the same time you put down an image. To do so, 
select the Delete the ZENworks Imaging Partition, If It Exists, When Bringing Down The 
Base Image check box. You can delete the Desktop Management imaging partition only when 
the workstation is booted from an imaging boot device or method other than the Desktop 
Management imaging partition.
IMPORTANT: After you have deleted the Desktop Management imaging partition, you need to make 
sure that the image you put on the workstation was made on a workstation without a Desktop 
642   Novell ZENworks 6.5 Desktop Management Administration Guide



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Management imaging partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the 
workstation will fail to boot. In addition, if you remove the Desktop Management imaging partition from a 
Windows 2000/XP machine, Windows cannot boot. You should only remove the Desktop Management 
imaging partition if you are going to restore an image to the workstation.

10 Click OK to save the Workstation Imaging object.

Associating an Add-On Image with a Base Image
1 Create the add-on image that you will associate with the base image. For more information, 

see “Creating an Add-On Image” on page 640.

2 Copy the image file to a Desktop Management Workstation Imaging server that is accessible 
as a server object in your eDirectory tree.

You might want to copy the add-on image to the same location as the base image.

3 In ConsoleOne, open the eDirectory tree and browse to the Workstation Image object that 
refers to the base image. If you haven’t created this object yet, do so as instructed in “Creating 
a Workstation Image Object” on page 642.

4 Right-click the object, then click Properties.

5 Under Add-on Image Files, click the Add button, select the Imaging server where the add-on 
image resides, select or specify the path and filename of the image, then click OK.

For details on selecting or specifying the path and filename, click Help in the Image File 
Location dialog box.

You can associate more than one add-on image with a base image. The add-on images are put 
down after the base image in the order listed on this page.

6 Click OK to save the Workstation Imaging object.

Using a Variant of an Image
As explained in “Using Image Explorer to Customize an Image” on page 640, you can exclude 
individual files and folders from any of 10 possible filesets (variants) of an image. The variants 
exist merely as internal attributes of the same image archive.

Because creating an image of a workstation can take a fair amount of time, it is more efficient in 
some cases to just create an image of a few workstations and customize those images to get all the 
variants you need. Even though the variants do not all exist as separate, physical image files, you 
can access them as though they were. How you do this depends on whether you are performing a 
manual or automated imaging operation, as explained below.

Type of imaging operation How to specify the variant to use

Automatic (eDirectory-based) In the Workstation Image object, specify the number of the variant in 
the Use File Set field. All eDirectory policies and settings that specify 
that Workstation Image object use the specified variant.

You can create multiple Workstation Image objects that point to the 
same base image but to different variants.
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Performing an Automatic Imaging Creation or Restoration
The following procedure explains how to set a flag in the Workstation object in ConsoleOne® that 
says to take or put an image on the workstation the next time it is booted, and then verify that the 
imaging operation occurs as expected.

1 If the imaging operation that you want to trigger is to put an image on the workstation, do the 
following. Otherwise, skip this step. 

1a If you haven’t already done so, create the image to be put on the workstation. Make sure 
to store it on your Imaging server. For more information, see “Manually Taking an Image 
of a Workstation” on page 647.

1b In ConsoleOne, create a Workstation Image object in your Novell eDirectory tree. 
Configure the object to point to the image file that is to be put on the workstation. For 
more information, see “Creating a Workstation Image Object” on page 642. For details 
on pointing to the image file, click Help in the Image File Location dialog box.

2 In ConsoleOne, right-click the Workstation object, then click Properties.

3 On the ZENworks Imaging Configuration page, do either of the following:

To take an image of the workstation the next time it boots, select the first check box, click 
the browse button next to the available field, select your Imaging server and the path and 
filename under which to store the new image, select the Use Compression check box and 
select a compression option if you want to use compression (click Help for details), then 
click OK.

To put an image on the workstation the next time it boots, select the Put an Image on This 
Workstation on Next Boot check box, select the box that says to use an image other than 
the effective policy image or multicast session, click the browse button next to the 
available field, select the Workstation Image object you created in Step 1b, then click OK. 

IMPORTANT: Be sure that the Imaging server storing the image or the workstation receiving the image 
has enough disk space for the image. Otherwise, you receive a “Failed to write to proxy” error.

4 Click OK to save the imaging configuration settings.

After the imaging operation has been performed on the workstation, Desktop Management 
clears these imaging configuration settings automatically so that the imaging operation won’t 
keep recurring.

Manual (command-line or 
menu)

Use the s parameter on the img restore command. For example, to 
specify variant number 3:

img restorel dellnt4.zmg s3

or

You can enter img at the bash prompt to display a menu, select 
Restore an Image, then select Local Image. Specify sfileset (for 
example, s3) in the Advanced Parameters field.

For details, see “Imaging Engine (Img: Command Line and Menu)” on 
page 707.

Type of imaging operation How to specify the variant to use
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5 Verify that the imaging operation occurs as expected when you reboot the workstation.

When you put a base image and its add-on images on a workstation, if you abort the process 
after the base image has been put down, or if one of the add-on images fails, the imaging 
engine reports a “successful image” to Linux. 

For example, suppose the base image containing the new OS is successfully laid down and 
one or more of the add-on images fails. In order for the workstation to reboot to the new OS, 
the imaging server must report to Linux that the image was successful.

If any add-on images were not successfully laid down, the job is not marked as complete in 
ConsoleOne. You can see the last base image and the last add-on images that were 
successfully laid down by looking at the workstation object’s properties in ConsoleOne (right-
click the Workstation object, click the down-arrow on the ZENworks Imaging tab, then click 
History).
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57 Performing Manual Imaging Operations

The following sections provide instructions for these basic imaging operations:

“Manually Taking an Image of a Workstation” on page 647

“Manually Putting an Image on a Workstation” on page 651

These instructions assume that you have already prepared the imaging server (see Chapter 51, 
“Preparing an Imaging Server,” on page 575), prepared workstations for imaging (see Chapter 54, 
“Setting Up Workstations for Imaging,” on page 629), and set up imaging policies (Chapter 55, 
“Setting Up Imaging Policies,” on page 633).

Desktop Management Imaging supports devices that physically connect to the network that meet 
the minimum requirements for workstations. For more information, see “User Workstation 
Hardware Requirements” in the Novell ZENworks 6.5 Desktop Management Installation Guide. 
Desktop Management Imaging does not support imaging operations (creating or restoring images) 
using wireless connectivity. 

Manually Taking an Image of a Workstation
This section explains how to take an image of a workstation by booting from an imaging method 
and entering a particular imaging command. The image is stored on your Imaging server. 

If you want to store an image locally rather than on an imaging server, see “Using a CD or DVD 
for Disconnected Imaging Operations” on page 655 and “Using a Hard Disk or Jaz Drive for 
Disconnected Imaging Operations” on page 657.

Ensure that your imaging server has enough disk space for the image. Otherwise, you receive a 
“Failed to write to proxy” error.

The following sections contain additional information:

“Manually Taking an Image of a Workstation Using the Bash Prompt” on page 647

“Manually Taking an Image of a Workstation Using the ZENworks Imaging Engine Menu” 
on page 649

Manually Taking an Image of a Workstation Using the Bash Prompt
1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.
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Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual at the boot prompt.

or

Select Start ZENworks Imaging in Maintenance Mode from the PXE menu.

3 (Optional) At the bash prompt, type img dump, then press Enter.

This displays a list of the partition slots on the workstation. For your reference, note the 
number and type of partitions and which one is active.

4 Enter a command at the bash prompt using one of the following formats:

To create an image and store it on the Imaging server, enter:

img makep serverIPaddr_or_DNSname //uncpath/newimg.zmg [comp=comp 
level]

The makep parameter stands for “make on proxy,” or in other words, create an image and 
store it on the imaging (proxy) server.

The IP address or DNS name should be that of your Imaging server. This can be any 
server running the Imaging Proxy service.

The UNC path to the image file to retrieve, including image filename and .zmg extension 
(case-sensitive). The format of this UNC path is as follows:

//servername/volume_or_share/path_to_stored_images/imagename.zmg

When img makep is executed at the cmd line, the servername portion of this path is 
replaced with the value in the address portion of the path. 

The directories in the path must exist. You can use the following characters in the path 
and filename:

Letters: a through z (uppercase and lowercase)

Numbers

Special Characters: $ % ' - _ @ { } ~ ` ! # ( )

comp level is the amount of compression used when creating the image. Specify any 
number from 0-9. 0 means no compression. 1 is the same as Optimize for Speed and is 
used by default if you do not specify this parameter. 6 is the same as Balanced. 9 is the 
same as Optimize for Space. (Optimize for Speed takes the least amount of time but 
creates the largest image file. Optimize for Space creates the smallest image file but might 
take a significant amount of time. Balanced is a compromise between compression time 
and image file size.)

For example:

img makep 137.65.95.127 //xyz_srv/sys/imgs/cpqnt.zmg comp=6

To create an image and store it locally: enter:

img makel filepath [comp=comp level]

The makel parameter stands for “make locally,” or in other words, create an image and 
store it on a local (writable) device, such as a hard disk or Jaz drive. 
NOTE: Unless you mount a drive before using the makel command, the image is created in RAM 
and is lost during a reboot of the workstation.
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filepath is the image filename, including the .zmg extension (case-sensitive) and the 
complete path from the root of the partition. 

The directories in the path must exist. You can use the following characters in the path 
and filename:

Letters: a through z (uppercase and lowercase)

Numbers

Special Characters: $ % ' - _ @ { } ~ ` ! # ( )

comp level is the amount of compression used when creating the image. Specify any 
number from 0-9. 0 means no compression. 1 is the same as Optimize for Speed and is 
used by default if you do not specify this parameter. 6 is the same as Balanced. 9 is the 
same as Optimize for Space. (Optimize for Speed takes the least amount of time but 
creates the largest image file. Optimize for Space creates the smallest image file but might 
take a significant amount of time. Balanced is a compromise between compression time 
and image file size.) 

For example:

img makel /imgs/dellnt.zmg comp=6

IMPORTANT: Make sure to use forward slashes in the UNC path as shown above. Backslashes aren’t 
recognized by Linux. Alternatively, you can use backslashes and enclose the entire UNC path in quotes. 
The path you specify must exist on your Imaging server.

For more information on the parameters you can use and usage examples, see “Make Mode 
(img make)” on page 709.

Depending on the amount of data on the hard disk, the image might take several minutes to 
create. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after 
a few minutes.)

5 When the image has been created and the bash prompt reappears, remove any diskettes from 
the drive and reboot the workstation.

6 (Optional) Verify that the image file was created on your Imaging server. You might also want 
to check its size.

Manually Taking an Image of a Workstation Using the ZENworks Imaging Engine 
Menu

1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual at the boot prompt.

or

Select Start ZENworks Imaging in Maintenance Mode from the PXE menu.
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3 Enter img to display the ZENworks Imaging Engine menu.

4 (Optional) Click System Information, then click Drive Information to display a list of the 
partition slots on the workstation.

For your reference, note the number and type of partitions and which one is active.

5 Click Imaging, then click Make Image.

6 In the Make Image Wizard window, specify the destination where the image will be stored 
(Local or Server), then click Next.

The directories in the path must exist. You can use the following characters in the path and 
filename:

Letters: a through z (uppercase and lowercase)

Numbers

Special Characters: $ % ' - _ @ { } ~ ` ! # ( )

7 Browse to and specify the path to the image archive.

8 Select the partitions that you want to include in the image.

9 Select a compression option.

None: No compression is used.

Speed: Takes the least amount of time to compress but creates the largest compressed image 
file. This option is used by default when an image is created.

Balanced: Represents a compromise between compression time and image file size.

Size: Creates the smallest image file but takes longer to compress.

10 Click Next.

11 (Optional) Fill in the fields:

Author: The name of the person creating this image.

Computer: The name of the computer being imaged.

Image Description: A description of the image.

Comments: Any additional comments about the image.

12 Click Next.

Depending on the amount of data on the hard disk, the image might take several minutes to 
create. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after 
a few minutes.)

13 After the image has been created, exit from the ZENworks Imaging Engine menu, remove any 
diskettes from the drive, then reboot the workstation.

14 (Optional) Verify that the image file was created on your Imaging server. You might also want 
to check its size.
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Manually Putting an Image on a Workstation
The section explains how to put an image on the workstation by booting from an imaging method 
and entering a particular imaging command. The image is retrieved from your Imaging server.

Ensure that the workstation receiving a new image has enough disk space for the image. 
Otherwise, you will receive a “Failed to write to proxy” error.

The following sections contain additional information:

“Manually Putting an Image on a Workstation Using the Bash Prompt” on page 651

“Manually Putting an Image on a Workstation Using the ZENworks Imaging Engine Menu” 
on page 653

Manually Putting an Image on a Workstation Using the Bash Prompt
1 If you haven’t already done so, create the image to put on the workstation, as instructed in 

“Manually Taking an Image of a Workstation” on page 647.

Make sure that the image is of the same type of workstation (same hardware configuration) 
and is stored on your Imaging server. You can use a previous image of the same workstation.
IMPORTANT: If you are putting an image on a workstation without a Desktop Management Workstation 
Imaging (Linux) partition, make sure the image was made on a workstation without a Desktop 
Management imaging partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the 
workstation fails to boot.

2 (Optional) Boot the workstation from a Windows startup disk and run FDISK to remove all 
partitions from the hard disk.

Running FDISK is not required, but it is recommended for purposes of comparing the 
workstation’s partitions before and after the imaging operation.

3 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

4 Enter manual at the boot prompt.

5 (Conditional; SP1 only) If you are prompted for a language diskette, insert it, then press Enter.

6 (Optional) At the bash prompt, type img dump, then press Enter to display a list of the 
partition slots on the workstation.

For your reference, note the number and type of partitions and which one is active. If you 
removed all partitions using FDISK, each slot should be empty and none should be active.
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7 Enter a command at the bash prompt using one of the following formats:

To restore an image from the Imaging server and put it down on a workstation, enter:

img restorep serverIPaddr_or_DNSname //uncpath/newimg.zmg

The restorep parameter stands for “restore from proxy,” or in other words, retrieve an 
image from the Imaging (proxy) server and put it on this workstation. The IP address or 
DNS name should be that of your imaging server, and the UNC path specifies the location 
and filename where the image is to be retrieved from. 

For example:

img restorep 137.65.95.127 //xyz_srv/sys/imgs/cpqnt.zmg

To retrieve an image from a local device and put it down on a workstation: 

img restorel filepath

The restorel parameter stands for “restore from local,” or in other words, retrieve an 
image from a local device and put it on this workstation. filepath represents the filename 
of the image to retrieve, including the .zmg extension (case-sensitive) and the complete 
path from the root of the partition.

IMPORTANT: Make sure to use forward slashes in the UNC path as shown above. Backslashes aren’t 
recognized by Linux. Alternatively, you can use backslashes and enclose the entire UNC path in quotes. 
The server portion of the path must be the name of your imaging server.

If you want to manually restore an image from a folder that uses extended or double-byte characters in 
its name, you should perform an automatic image restoration using ConsoleOne®. For more information, 
see “Performing an Automatic Imaging Creation or Restoration” on page 644.

For more information on the parameters you can use and usage examples, see “Restore Mode 
(img restore)” on page 711.

Depending on the size of the image, it might take several minutes to put the image down. 
Images actually take slightly longer to put down than they do to take. If the screen goes blank, 
just press any key. (Linux enters a screen-saving mode after a few minutes.)

8 (Optional) When the image has been put down and the bash prompt reappears, type img 
dump, then press Enter.

As before, this displays a list of the partition slots on the workstation. You should now see 
information about the new partitions that were created and activated by the image that you just 
put down.

9 At the bash prompt, type lilo.s, then press Enter.

10 Remove any diskettes from the drive and reboot the workstation. Verify that it boots to the 
operating system that was installed by the new image. 
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Manually Putting an Image on a Workstation Using the ZENworks Imaging Engine 
Menu

1 If you haven’t already done so, create the image to put on the workstation, as instructed in 
“Manually Taking an Image of a Workstation” on page 647.

Make sure that the image is of the same type of workstation (same hardware configuration) 
and is stored on your Imaging server. You can use a previous image of the same workstation.
IMPORTANT: If you are putting an image on a workstation without a Desktop Management Workstation 
Imaging (Linux) partition, make sure the image was made on a workstation without a Desktop 
Management imaging partition. Otherwise, the wrong MBR (Master Boot Record) is restored, and the 
workstation fails to boot.

2 (Optional) Boot the workstation from a Windows startup disk and run FDISK to remove all 
partitions from the hard disk.

Running FDISK is not required, but it is recommended for purposes of comparing the 
workstation’s partitions before and after the imaging operation.

3 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

4 Enter manual at the boot prompt.

or

 Select Start ZENworks Imaging in Maintenance Mode from the PXE menu.

5 (Conditional; SP1 only) If you are prompted for a language diskette, insert it, then press Enter.

6 Enter img to display the ZENworks Imaging Engine menu.

7 (Optional) Click System Information, then click Drive Information to display a list of the 
partition slots on the workstation.

For your reference, note the number and type of partitions and which one is active. If you 
removed all partitions using FDISK, each slot should be empty and none should be active.

8 Click Imaging, then click Restore Image.

9 In the Restore Image Wizard window, specify the source location of the image (Local or 
Server), then click Next.

10 Browse to and specify the path to the image archive.

11 (Optional) Specify a file set.

12 (Optional) Specify any advanced options, such as sfileset or apartition:ppartition.

For details on this and other related img command parameters, see Chapter 61, “Imaging 
Engine (Img: Command Line and Menu),” on page 707.
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13 Click Next.

Depending on the size of the image, it might take several minutes to put the image down. 
Images actually take slightly longer to put down than they do to take. If the screen goes blank, 
just press any key. (Linux enters a screen-saving mode after a few minutes.)

14 (Optional) Click System Information, then click Drive Information to display a list of the 
partition slots on the workstation.

As before, this displays a list of the partition slots on the workstation. You should now see 
information about the new partitions that were created and activated by the image that you just 
put down.

15 Exit the ZENworks Imaging Engine menu.

16 Run lilo.s from the bash prompt.

17 Remove any diskettes from the drive and reboot the workstation. Verify that it boots to the 
operating system that was installed by the new image. 
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58 Setting Up Disconnected Imaging Operations

Disconnected imaging operations are inherently manual in the sense that they don’t involve the 
network and thus can’t be automated through Novell® eDirectoryTM. 

To perform a disconnected imaging operation on a workstation, you must have a storage device to 
hold the image to be created or put down, and that storage device must be locally accessible to the 
imaging engine (in Linux) when you boot the workstation from the imaging device. The following 
sections explain how to set up and perform disconnected operations using several different storage 
devices:

“Using a CD or DVD for Disconnected Imaging Operations” on page 655

“Using a Hard Disk or Jaz Drive for Disconnected Imaging Operations” on page 657

You can also use other storage devices providing that they are locally accessible to the imaging 
engine (in Linux). 

Using a CD or DVD for Disconnected Imaging Operations
Using Desktop Management, you can use CDs and DVDs only as the storage medium for an image 
that will be put down, not for an image to be created.

You can put down an image from a bootable or non-bootable Imaging CD or DVD using either the 
bash prompt or using the ZENworks Imaging Engine menu.

The following sections contain additional information:

“Putting Down an Image Using the Bash Prompt” on page 655

“Putting Down an Image Using the ZENworks Imaging Engine Menu” on page 656

Putting Down an Image Using the Bash Prompt
1 Use your CD- or DVD-burning software to burn the source image onto a CD or DVD.

2 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.
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3 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.

4 Insert the CD or DVD that contains the source image.

5 At the Linux prompt, enter cdrom.s to mount the CD or DVD.

This mounts the CD or DVD to /mnt/cdrom.

6 Enter a command of the following format:

img restorel /mnt/cdrom/path/image.zmg

where path and image are the path and filename of the image relative to the root of the CD or 
DVD.

7 When the imaging is done, remove the imaging device (if applicable) and do the following to 
boot the workstation with the new image:

7a At the Linux prompt, type lilo.s, then press Enter.

7b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.

Putting Down an Image Using the ZENworks Imaging Engine Menu
1 Use your CD- or DVD-burning software to burn the source image onto a CD or DVD.

2 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

3 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.

4 Insert the CD or DVD that contains the source image.

5 At the Linux prompt, enter cdrom.s to mount the CD or DVD.

This mounts the CD or DVD to /mnt/cdrom.

6 Enter img to display the ZENworks Imaging Engine menu.

7 Click Imaging, then click Restore Image.

8 Click Local, then click Next.

9 Browse to and specify the path to the image archive.

10 (Optional) Specify a file set.
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11 (Optional) Specify any advanced options, such as sfileset or apartition:ppartition.

For details on this and other related img command parameters, see Chapter 61, “Imaging 
Engine (Img: Command Line and Menu),” on page 707.

12 Click Next.

Depending on the size of the image, it might take several minutes to put the image down. 
Images actually take slightly longer to put down than they do to take. If the screen goes blank, 
just press any key. (Linux enters a screen-saving mode after a few minutes.)

13 When the imaging is done, remove the imaging device (if applicable) and do the following to 
boot the workstation with the new image:

13a At the Linux prompt, type lilo.s, then press Enter.

13b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.

Using a Hard Disk or Jaz Drive for Disconnected Imaging 
Operations

When you boot a workstation from a Desktop Management Workstation Imaging device, you can 
create an image on, or put down an image from, any primary FAT16, FAT32, EXT2, or EXT3 
partition on an IDE or SCSI hard drive or Iomega* Jaz drive. You can also use the local Desktop 
Management Workstation Imaging (Linux) partition if one is installed. Any target partition must 
have sufficient space.

When you create an image, the partition where you will store the image is itself excluded from the 
image. When you put down an image, the source partition is not altered.

The following sections contain additional information:

“Creating an Image on a Hard Disk or Jaz Drive” on page 657

“Putting Down an Image from a Hard Disk or Jaz Drive” on page 659

Creating an Image on a Hard Disk or Jaz Drive
You can create an image on a hard disk or Jaz drive using either the bash prompt or using the 
ZENworks Imaging Engine menu.

The following sections contain additional information:

“Creating an Image on a Hard Disk or Jaz Drive” on page 657

“Creating an Image Using the ZENworks Imaging Engine Menu” on page 658

Creating an Image Using the Bash Prompt

1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.
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(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.

3 At the Linux prompt, enter img dump to view the available partitions. 

Note the number of the FAT partition where you’ll store the new image.

4 Enter a command of the following format:

img makel[pNumber] /path/image.zmg [comp=comp_level]

where pNumber is the number of the partition to store the image in, and comp_level is the 
amount of compression used when creating the image. Specify any number from 0-9. 0 means 
no compression. 1 is the same as Optimize for Speed. 6 is the same as Balanced and is used 
by default if you do not specify this parameter. 9 is the same as Optimize for Space. (Optimize 
for Speed takes the least amount of time but creates the largest image file. Optimize for Space 
creates the smallest image file but might take a significant amount of time. Balanced is a 
compromise between compression time and image file size.) Path and image are the path and 
filename of the new image relative to the partition root. If you omit the partition number, the 
local Desktop Management imaging partition is used.

For details on other related img command parameters, see “Imaging Engine (Img: Command 
Line and Menu)” on page 707.

Creating an Image Using the ZENworks Imaging Engine Menu

1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.

3 Enter img to display the ZENworks Imaging Engine menu.

4 (Optional) Click System Information, then click Drive Information to display a list of the 
partition slots on the workstation.

For your information, note the number of the FAT partition where you’ll store the new image.

5 Click Imaging, then click Make Image.

6 In the Make Image Wizard window, click Local, then click Next.

7 Browse to and specify the path to the image archive.

8 Select the partitions that you want to include in the image.
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9 Select a compression option.

None: No compression is used.

Speed: Takes the least amount of time to compress but creates the largest compressed image 
file. This option is used by default when an image is created.

Balanced: Represents a compromise between compression time and image file size.

Size: Creates the smallest image file but takes longer to compress.

10 Click Next.

11 (Optional) Fill in the fields:

Author: The name of the person creating this image.

Computer: The name of the computer being imaged.

Image Description: A description of the image.

Comments: Any additional comments about the image.

12 Click Next.

Depending on the amount of data on the hard disk, the image might take several minutes to 
create. If the screen goes blank, just press any key. (Linux enters a screen-saving mode after 
a few minutes.)

13 After the image has been created, exit from the ZENworks Imaging Engine menu, remove any 
diskettes from the drive, then reboot the workstation.

14 (Optional) Verify that the image file was created. You might also want to check its size.

Putting Down an Image from a Hard Disk or Jaz Drive
You can put down an image from a hard disk or Jaz drive using either the bash prompt or using the 
ZENworks Imaging Engine menu.

The following sections contain additional information:

“Putting Down an Image Using the Bash Prompt” on page 659

“Putting Down an Image Using the ZENworks Imaging Engine Menu” on page 660

Putting Down an Image Using the Bash Prompt

1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.
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3 (Optional) At the Linux prompt, enter img dump to view the available partitions.

For your information, note the number of the FAT partition where the source image is stored.

4 Enter a command of the following format:

img restorel[pNumber] /path/image.zmg

where pNumber is the number of the partition where the source image is stored, and path and 
image are the image path and filename relative to the partition root. If you omit the partition 
number, the local Desktop Management imaging partition is used.

For details on other related img command parameters, see “Imaging Engine (Img: Command 
Line and Menu)” on page 707.

5 When the imaging is done, remove the imaging device (if applicable) and do the following to 
boot the workstation with the new image:

5a At the Linux prompt, type lilo.s, then press Enter.

5b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.

Putting Down an Image Using the ZENworks Imaging Engine Menu

1 Boot the workstation using one of the following methods:

If the workstation is PXE-enabled, boot it from the Imaging/Preboot Services server. For 
more information, see “Using Preboot Services (PXE)” on page 577.

Boot the workstation using an Imaging boot CD or DVD. For more information, see 
“Preparing Imaging Boot CDs or DVDs” on page 578.

(SP1 only) Boot the workstation using Imaging boot diskettes. For more information, see 
“Using the ZENworks Imaging Floppy Boot Disk Creator Utility” on page 580.

Boot the workstation from the Imaging hard-disk partition. For more information, see 
“Creating an Imaging Hard-Disk Partition” on page 587.

2 Enter manual from the boot prompt. (SP1 only:) Insert the second, third, fourth, and fifth 
diskettes if you are prompted for them.

3 Enter img to display the ZENworks Imaging Engine menu.

4 (Optional) Click System Information, then click Drive Information to display a list of the 
partition slots on the workstation.

For your reference, note the number of the FAT partition where the source image is stored.

5 Click Imaging, then click Restore Image.

6 Click Local, then click Next.

7 Browse to and specify the path to the image archive.

8 (Optional) Specify a file set.

9 (Optional) Specify any advanced options, such as sfileset or apartition:ppartition.

For details on this and other related img command parameters, see Chapter 61, “Imaging 
Engine (Img: Command Line and Menu),” on page 707.
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10 Click Next.

Depending on the size of the image, it might take several minutes to put the image down. 
Images actually take slightly longer to put down than they do to take. If the screen goes blank, 
just press any key. (Linux enters a screen-saving mode after a few minutes.)

11 When the imaging is done, remove the imaging device (if applicable) and do the following to 
boot the workstation with the new image:

11a At the Linux prompt, type lilo.s, then press Enter.

11b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.
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59 Multicasting Images

Novell® ZENworks® Desktop Management Imaging software includes an imaging multicast 
capability. The following sections explain what this is, why you might want to use it, and the 
overall procedures for using it.

“Understanding Multicasting” on page 663

“Performing a Multicast Session” on page 664

Understanding Multicasting
To multicast an image is to take an image of one workstation (the master), immediately send it over 
the network to multiple other workstations (the participants), and put it down simultaneously on 
those workstations. You can specify a workstation as the session master, or you can specify an 
image file that you have previously saved and customized.

If the session master is a workstation, a base image is taken of all the partitions on the hard disks 
and other storage devices (such as Jaz drives) of that workstation. 

Before the image is put down on the participating workstations, all existing partitions are removed 
from the hard disks and writable storage devices of those workstations.

For multicasting to work properly, the routers and switches on the network must have multicast 
features configured. Otherwise, multicast packets might not be routed properly.

In versions of ZENworks for Desktops prior to 3.2, the master had to be a Linux workstation, 
which formerly restricted multicasting to exact “cloning” of the workstation.

The following sections contain additional information:

“Benefits of Multicasting Images” on page 663

“Limitations of Multicasting Images” on page 664

Benefits of Multicasting Images
Multicasting is the way to use ZENworks Desktop Management Imaging services for mass re-
imaging with the least amount of overhead. It is useful if you have one workstation with a clean 
software configuration that you want to duplicate on several other machines, or if you have a single 
image that you want to set up on multiple machines.

With multicasting, all you need is a physical network with modern routers and switches.

If you will be setting up multicasting by visiting each workstation, you will also need imaging boot 
diskettes (SP1 only), an imaging boot CD or DVD, or the workstations must be PXE-enabled. For 
more information, see Chapter 52, “Preparing an Imaging Boot Method,” on page 577.
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The workstations to be imaged must be physically connected to the network. They can be 
workstations with existing operating systems of any kind, or they can be new workstations with 
no operating system installed.

Limitations of Multicasting Images
One significant limitation of using multicast without installing any ZENworks Desktop 
Management software is that it results in a set of workstations that have duplicate network 
identities. The IP addresses, Computer (NETBIOS) names, Workgroup memberships, and 
Security Identifiers (Windows 2000/XP only) are all the same and will cause conflicts if deployed 
on the network without change.

For a handful of workstations, this might not be a problem. But for a larger number, if the 
workstations have Windows, you should install the Desktop Management Imaging Agent on them 
before doing the multicast. (See Step 4 of “Enabling a Workstation for Auto-Imaging Operations” 
on page 630.) The Imaging Agent saves the workstation’s network identity settings before the 
multicast session and restores them afterwards.

Performing a Multicast Session
The following sections contain additional information:

“Initiating an Automatic Multicast Session in ConsoleOne” on page 664

“Performing a Manual Multicast Session” on page 667

Initiating an Automatic Multicast Session in ConsoleOne
When you initiate an automatic multicast session in ConsoleOne®, you do not need to start the 
session from the ZENworks Imaging server or physically visit each participating workstation. You 
name the session, define the master image source (an image file or workstation), and then add 
Workstation objects to include in the multicast session or define rules to include workstations that 
meet specific criteria you set.

To initiate an automatic multicast session in ConsoleOne:

1 (Optional) Install the Desktop Management Imaging Agent on each of the participating 
workstations.
IMPORTANT: If you do not install the Desktop Management Imaging Agent on each participating 
machine, those machines will have duplicate network identities. For more information, see “Limitations of 
Multicasting Images” on page 664.

2 In ConsoleOne, right-click the Server object, click Properties, then click the ZENworks 
Imaging tab.

If you do not see the ZENworks Imaging tab, click the right-arrow on the right side of the 
displayed tabs until it displays. 
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3 Click Add, type a name for the multicast session, then click OK.

4 Specify the Master Image Source. 

You can specify an image file or a master workstation. 

A workstation cannot be the master if it is being used as a master in another multicast session 
or if it explicitly participates in any other session.
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5 Decide how many participating workstations you want to have booted up before the multicast 
session begins. Specify this number in the Clients Have Joined text box. 

The default if you do not specify a number is 5 workstations.

6 If not enough workstations have booted up to fulfill the Clients Have Joined requirement, the 
multicast session will begin if a participating workstation boots up and a certain amount of 
time passes without another participating workstation booting up. Specify this amount of time 
in the Minutes Have Elapsed Since a New Client Has Joined text box. 

The default if you do not specify a time is 15 minutes.

7 (Optional) To delete the session after it has finished, select the last check box.

8 Click the down-arrow on Multicast Session tab, then click Participation.

9 Click Add Workstation under Include the Following Workstations to explicitly add the 
workstation objects that you want to include in this multicast session.

or

To create rules to select the workstations you want to participate in this multicast session, click 
Add Rule under Include Machines Which Meet Any of These Criteria. 
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Click Help on the Participation page for more information.

10 Click OK to return to the ZENworks Imaging Multicast Sessions page. 

11 The check box next to the multicast session name is automatically selected, showing that the 
session is enabled. If you want to disable a multicast session, deselect the check box next to 
the session name.

12 (Optional) If you want to change the position of a session in the list, select the multicast 
session name, then click Move Up or Move Down.

If multiple multicast sessions are defined that use rules to select participating workstations, it 
is possible that a workstation could qualify to participate in more than one session. If this 
occurs, the first enabled session in this list for which the workstation qualifies takes 
precedence over the other enabled sessions.

13 Click OK.

Performing a Manual Multicast Session
If you want to perform a manual multicast session, you need to start the multicast session from the 
ZENworks Imaging server (NetWare or Windows) and physically visit each participating 
workstation. Performing a manual multicast session is particularly useful in a lab environment in 
which a small number of workstations participate. 

The following sections contain step-by-step information about performing a manual multicast 
session:

“Initiating a Multicast Session from the ZENworks Imaging Server” on page 667

“Initiating a Multicast Session from Each Client” on page 669

To perform a manual multicast session, you must perform the steps in both sections; however, the 
order in which you perform the tasks does not matter.

Initiating a Multicast Session from the ZENworks Imaging Server

You can use either a NetWare® or Windows ZENworks Imaging server to initiate a multicast 
session. The following sections contain additional information:

“Initiating a Multicast Session from a NetWare ZENworks Imaging Server” on page 668
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“Initiating a Multicast Session from a Windows ZENworks Imaging Server” on page 668

Initiating a Multicast Session from a NetWare ZENworks Imaging Server

1 From the Netware server, load the ZENworks Imaging Server (imgserv.nlm).

2 From the Main Menu, select Manually Start Multicast.

3 Specify the path to the image archive.

You can either type the full path to the image file you want to use, or you can press Insert 
browse for the image file.

4 Specify the name for the multicast session.

5 Decide how many participating workstations you want to have booted up before the multicast 
session begins. Type this number in the Number of Clients field. 

The default if you do not specify a number is 1 workstation.

6 If not enough workstations have booted up to fulfill the Number of Clients requirement, the 
multicast session begins if a participating workstation boots up and a certain amount of time 
passes without another participating workstation booting up. Specify this amount of time in 
the Maximum Time to Wait field. 

The default if you do not specify a time is 5 minutes.

7 (Optional) Specify a file set.

8 Press Esc, then select Yes to start the multicast session.

9 (Conditional) If you have not done so, proceed with the steps under “Initiating a Multicast 
Session from Each Client” on page 669.

After you initiate the multicast session from each participating client, the image is sent to and 
put down on each participating workstation.

At the Main Menu, select Multicast Sessions to see how many clients have registered and how 
many the session is still waiting for. For example, 3/2 means 3 clients have registered and 2 more 
need to register before the session can begin. You can delete any session listed, even if it is in 
progress, by selecting the session name, then pressing Delete.

Initiating a Multicast Session from a Windows ZENworks Imaging Server

1 From the Windows taskbar, click the ZIS icon to start the ZENworks Imaging Server program.

2 Click the Start Multicast Session tab.
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3 Type the name for the multicast session.

4 Browse to and specify the image archive file.

5 Decide how many participating workstations you want to have booted up before the multicast 
session begins. Specify this in the Number of Clients text box. 

The default if you do not specify a number is 5 workstations.

6 If not enough workstations have booted up to fulfill the Number of Clients requirement, the 
multicast session begins if a participating workstation boots up and a certain amount of time 
passes without another participating workstation booting up. Specify this amount of time in 
the Maximum Time to Wait text box. 

The default if you do not specify a time is 15 minutes.

7 (Optional) Specify a file set.

8 Click Start.

9 (Conditional) If you have not done so, proceed with the steps under “Initiating a Multicast 
Session from Each Client” on page 669.

You can click the Status tab to see how many Update Requests have been received, how many 
images have been sent or received, and the number of client referrals. 

You can click the Multicast Sessions tab to view current multicast sessions. You can also delete 
any session listed, even if it is in progress, by selecting the session name, then clicking Delete. You 
can refresh a session by selecting the session name, then clicking Refresh.

Initiating a Multicast Session from Each Client

You can use the bash prompt or the ZENworks Imaging Engine menu to perform the multicast 
session as you physically visit each workstation. 

The following sections contain additional information:

“Using the Bash Prompt to Perform the Multicast Session” on page 670

“Using the ZENworks Imaging Engine Menu to Perform the Multicast Session” on page 671

Using the Bash Prompt to Perform the Multicast Session

1 (Optional) Install the Desktop Management Imaging Agent on each of the participating 
workstations.
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If you do not install the Desktop Management Imaging Agent on each participating machine, 
the machines will have duplicate network identities. For more information, see “Limitations 
of Multicasting Images” on page 664.

2 Create a set of imaging boot diskettes (SP1 only) or an imaging boot CD or DVD for each 
person who will assist with the multicast session, or enable PXE on the participating 
workstations.

If you don’t know how to do this, see “Preparing an Imaging Boot Method” on page 577. 

3 At each workstation, including the master workstation (unless you will be starting the 
multicast session from the imaging server), access a Linux prompt by using the imaging boot 
diskettes (SP1 only), imaging boot CD or DVD, or if it is PXE-enabled, boot it up.

4 Enter manual at the boot prompt. 

5 To identify each participating workstation in the multicast session, enter the following 
command at the bash prompt of every workstation:

img session name

where name is any string that uniquely identifies this multicast session from other multicast 
sessions that might be in progress on the network. Use the same session name on each of the 
participating workstations in this multicast session. You can specify any multicast session, 
including one that originates from the Imaging server (as long as you specify the session name 
used by the Imaging server).

Example: img session doug

The img session command can take other parameters that allow you to designate the 
master workstation and the imaging start time beforehand. See Chapter 61, “Imaging Engine 
(Img: Command Line and Menu),” on page 707 for details.

6 (Conditional) If you have not already done so, start the multicast session from the master 
workstation or from the Imaging server. 

Master Workstation: To start the multicast session from the master workstation, after all the 
other workstations have registered as participants, click Start Session.

If you start the session from the master workstation, the session master must be a workstation. 
If you start the session from the Imaging server, the session master must be a previously saved 
image file.

The Imaging engine begins creating the image of the master workstation and the image is sent 
to and put down on each participating workstation. Any problems are reported and displayed 
on the master workstation.

Imaging Server: To start the multicast session from the Imaging server, follow the steps 
under “Initiating a Multicast Session from the ZENworks Imaging Server” on page 667.

7 At each participating workstation, when the imaging is done, do the following to boot the 
workstation with the new operating system:

7a At the Linux prompt, type lilo.s, then press Enter.
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7b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.

Using the ZENworks Imaging Engine Menu to Perform the Multicast Session

1 (Optional) Install the Desktop Management Imaging Agent on each of the participating 
workstations.

If you do not install the Desktop Management Imaging Agent on each participating machine, 
the machines will have duplicate network identities. For more information, see “Limitations 
of Multicasting Images” on page 664.

2 Create a set of imaging boot diskettes (SP1 only) or an imaging boot CD or DVD for each 
person who will assist with the multicast session, or enable PXE on the participating 
workstations.

If you don’t know how to do this, see “Preparing an Imaging Boot Method” on page 577. 

3 At each workstation, including the master workstation (unless you will be starting the 
multicast session from the imaging server), access a Linux prompt by using the imaging boot 
diskettes (SP1 only), imaging boot CD or DVD, or if it is PXE-enabled, boot it up.

4 Enter manual at the boot prompt. 

or

Select Start ZENworks Imaging in Maintenance Mode from the PXE menu.

5 To identify each participating workstation in the multicast session, type img at the bash 
prompt to display the ZENworks Imaging Engine menu.

6 Click Imaging, then click Multicast Session.

7 Type a session name.

The session name is any string that uniquely identifies this multicast session from other 
multicast sessions that might be in progress on the network. Use the same session name on 
each of the participating workstations in this multicast session. You can specify any multicast 
session, including one that originates from the Imaging server (as long as you specify the 
session name used by the Imaging server).

8 Select a Session Role option:

Master: Select this option if this is the session master.

Client: Select this option if this is a participating workstation.

9 (Optional) If you chose Master in Step 8, specify any additional options:

Compression Level: Specify the compression level you want to use for this multicast 
session:

None: No data compression is used. Data is sent immediately across the network to 
participating workstations. You might use this option if the master workstation has a 
slow CPU; the amount of time to compress the data is eliminated and the data is 
immediately sent across the network. Using this option, however, the multicast 
session creates more network traffic than it would if you selected one of the other 
compression levels (Speed, Balanced, or Size).
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Speed: Takes the least amount of time to compress the data before the data is sent 
across the network to participating workstations. You might use this option if the 
master workstation has a slow CPU; the amount of time to compress the data is 
reduced before the data is sent across the network. With this option, however, the 
multicast session creates more network traffic than it would if you selected either the 
Balanced or Size compression level.

Balanced: Represents a compromise between data compression and the amount of 
network traffic that the multicast session creates.

Size: Takes the most amount of time to compress the data before sending it across 
the network to participating workstations. You might use this option if the master 
workstation has a fast CPU. Using this option requires the most CPU resources to 
compress the data but creates less network traffic to transfer the data to the 
participating workstations.

Automated Session: Click Enabled to specify the number of participating workstations 
(clients) that must register before starting the automated multicast session and to specify 
the amount of time, in minutes, that can expire without the number of participating 
workstations to register before starting the automated multicast session. If you do not 
click the Enabled check box, you must manually start the multicast session.

10 Click Next, then click Start Session.

11 At each participating workstation, when the imaging is done, do the following to boot the 
workstation with the new operating system:

11a At the Linux prompt, type lilo.s, then press Enter.

11b Press Ctrl+Alt+Delete.

If the workstation doesn’t boot to the new operating system (that is, if the Linux prompt 
reappears), enter the lilo.s command again and reboot the workstation a second time.
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60 Imaging Utilities and Components

The following sections provide reference information on Novell® ZENworks® Desktop 
Management imaging utilities, commands, configuration settings, and log formats.

“Image Explorer (imgexp.exe)” on page 673

“ZENworks Imaging Windows Agent (Ziswin.exe)” on page 678

“Image-Safe Data Viewer and Editor (Zisview and Zisedit)” on page 688

“Imaging Boot Disk Creator (Zimgboot.exe)” on page 692

“Imaging Configuration Parameters (Settings.txt)” on page 695

“Imaging Bootup Parameters” on page 701

“Imaging Bootup Languages (Zimglang.ini)” on page 701

“Imaging Server (Imgserv.nlm or .dll or .dlm)” on page 702

“Imaging Server Log (Zimglog.xml)” on page 703

Image Explorer (imgexp.exe)
Use the Image Explorer utility at a Windows workstation to view or modify workstation images, 
create add-on images, compress image files, and split images.

Imgexp.exe is located in the sys:\public\zenworks\imaging folder in your Desktop Management 
installation (on the Imaging server).

To start the Image Explorer as a standalone utility (from Windows), double-click the imgexp.exe 
file. There are no command line parameters. 

To start the utility from ConsoleOne® from the server, click Tools > ZENworks Utilities > Imaging 
> Image Explorer.
IMPORTANT: Do not exclude BPB files from a base image or the workstation won’t be able to boot the new 
operating system after receiving the image.

Non-Windows partitions, such as NetWare® partitions, are visible when you open an image, but 
their contents are not.

To use Image Explorer to open images larger than 4 GB that are stored on a NetWare server, the 
workstation must be running the Novell ClientTM 4.9 or newer and the NetWare server must be 
running NetWare 5 or newer with Novell Storage Services® (NSS) installed.

Although the ZENworks Imaging Explorer looks, and in most situations, functions like the 
Microsoft Windows Explorer, the two programs are different and some functionality differences 
exist. The following list describes key differences between how the ZENworks Image Explorer 
and Microsoft Windows Explorer function:
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Replacing Files in an Image: During the lifecycle of an image, files might be deleted or 
updated using Image Explorer. When you replace an existing file in an image using Image 
Explorer, the original file is not deleted from the image. Image Explorer purges only deleted 
files; it does not purge files that have been updated. When files are added to an image where 
the file already exists, Image Explorer appends the entry to the end of the image. When images 
are restored, all files that have been previously updated are sequentially restored. To avoid 
performance problems, you should manually delete and purge each instance of duplicate files 
in order to have them purged from the image.

Dragging Files from Image Explorer: You cannot drag files from Image Explorer in order 
to extract them.

The following sections describe the tasks that you can perform using the Image Explorer:

“Opening Image Explorer (Imgexp.exe)” on page 674

“Opening an Image” on page 674

“Adding a File or Folder to an Open Image” on page 675

“Creating a Folder in an Open Image” on page 675

“Adding Specific Windows Registry Settings That Are to Be Applied After the Open Image 
is Laid Down” on page 675

“Excluding a File or Folder from the Open Image” on page 675

“Marking a File or Folder for Deletion in the Open Image” on page 675

“Purging Files and Folders Marked for Deletion from the Open Image” on page 675

“Extracting a File or Directory from the Open Image to a Folder” on page 676

“Extracting a File or Directory from the Open Image as an Add-On Image” on page 676

“Viewing a File from the Open Image in its Associated Application” on page 676

“Saving Your Changes to the Open Image” on page 676

“Creating a Workstation Add-On Image” on page 676

“Compressing a Workstation Image” on page 676

“Splitting a Workstation Image” on page 677

“Resizing a Partition in an Image” on page 678

Opening Image Explorer (Imgexp.exe)
1 To start the Image Explorer as a Windows standalone utility, double-click the imgexp.exe file 

(located in the zenworks\imaging folder on the Imaging server).

or

To start the utility from ConsoleOne if you are running it from the server, click Tools > 
ZENworks Utilities > Imaging > Image Explorer.

Opening an Image
1 Open Image Explorer (imgexp.exe).

2 Click  on the toolbar, browse for the image (.zmg) file, then click Open. 

Large image files might take a few moments to open.
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Adding a File or Folder to an Open Image
1 Open Image Explorer (imgexp.exe).

2 In the left pane, browse to the partition or folder where you want to add the file or folder.

3 Click  or  on the toolbar, browse to the file or folder, then click Add or OK.

Creating a Folder in an Open Image
1 Open Image Explorer (imgexp.exe).

2 In the left pane, browse to the partition or folder where you want to create the folder, click , 
type the name of the folder, then click OK.

Adding Specific Windows Registry Settings That Are to Be Applied After the Open 
Image is Laid Down

1 Open Image Explorer (imgexp.exe).

2 Select a partition in the left pane, click Image, then click Add Registry File.

3 Select the registry (.reg) file that contains the settings, then click Add.

The registry file is added to a fixed, known area of the partition and is applied when the 
workstation reboots after receiving the image.

Excluding a File or Folder from the Open Image
1 Open Image Explorer (imgexp.exe).

2 Select the file or folder, click Edit, click File Sets, then select the filesets (variants of the 
image) that you want the file or folder to be excluded from.

This image has 10 possible variants, labeled Set 1, Set 2, and so on. The files and/or folders 
that you selected in the main window will be excluded only from the variants that you select 
in this dialog box.

Marking a File or Folder for Deletion in the Open Image
1 Open Image Explorer (imgexp.exe).

2 Select the file or folder, click Image, then click Delete.
NOTE: Deleting a file in the Image Explorer merely marks it for deletion, it can still be retrieved. A deleted file 
is not purged from the image, but it is not added to the restored image.

Purging Files and Folders Marked for Deletion from the Open Image
1 Open Image Explorer (imgexp.exe).

2 Ensure that the open image has been saved, click File, then click Purge Deleted Files.

3 Browse to the image filename or specify a new image filename, then click Save
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Extracting a File or Directory from the Open Image to a Folder
1 Open Image Explorer (imgexp.exe).

2 Click the file or directory, click the File menu, click Extract, click As Files, browse to and 
select a folder, then click OK.

Extracting a File or Directory from the Open Image as an Add-On Image
1 Open Image Explorer (imgexp.exe).

2 Click the file or directory, click Extract, click As Add-on Image, type the name of the new 
add-on image, then click OK.

Viewing a File from the Open Image in its Associated Application
1 Open Image Explorer (imgexp.exe).

2 Click the file, click the File menu, then click Extract and View.

Saving Your Changes to the Open Image
1 Open Image Explorer (imgexp.exe).

2 Click  on the toolbar.

Creating a Workstation Add-On Image
1 Open Image Explorer (imgexp.exe).

2 Click  on the toolbar, open Windows Explorer, browse to the files and folders you want the 
add-on image to contain, drag the files and folders into the right pane from Windows Explorer, 
then click Save.

Adding a Partition to a New Add-On Image
1 Open Image Explorer (imgexp.exe).

2 Click  on the toolbar, click the root of the image, click Image, then click Create Partition.

You cannot add a partition to an existing add-on image or to any base image.

Compressing a Workstation Image
You can set compression options so that it takes less time to restore the image file and less space 
to store the file on your Imaging server. You can compress an uncompressed image (including 
images created by previous versions of ZENworks Desktop Management) by 40 to 60 percent of 
the original file size. 

The ZENworks Desktop Management Image Explorer provides the following types of image 
compression:

“Compressing an Open Image” on page 677

“Compressing Any Image without Waiting for the File to Fully Load into Image Explorer” on 
page 677
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Compressing an Open Image

1 Open Image Explorer (imgexp.exe).

2 Click File > Compress Image.

3 Browse to a folder, specify a new image filename, then select a compression option:

Optimize for Speed: Takes the least amount of time to compress but creates the largest 
compressed image file.

Balanced (Recommended): Represents a compromise between compression time and 
image file size. This option is used by default when an image is created.

Optimize for Space: Creates the smallest image file but takes longer to compress.

4 Click Compress.

Files marked for deletion in the image will be removed during the compression operation. 

Compressing Any Image without Waiting for the File to Fully Load into Image Explorer

You can set compression options to quickly compress an image file without waiting for the file to 
fully load into Image Explorer.

To use QuickCompress:

1 Open Image Explorer (imgexp.exe).

2 Click Tools > click QuickCompress.

3 Browse to the image file, browse to a folder, specify a new image filename, select a 
compression option: 

Optimize for Speed: Takes the least amount of time to compress but creates the largest 
compressed image file.

Balanced (Recommended): Represents a compromise between compression time and 
image file size. This option is used by default when an image is created.

Optimize for Space: Creates the smallest image file but will take longer to compress.

4 Click Compress.

If you have used Delete to hide files in the image, they are removed from the image during 
compression.

Splitting a Workstation Image
You can split an image file into separate files so that you can span the entire image across several 
CDs or DVDs.

1 Open Image Explorer (imgexp.exe).

2 Click Tools > Image Split.

3 Specify an existing base image file to split, specify the directory in which to store the split 
images, specify the maximum file size of each split-image file.

Because images are split by placing individual files into different images, an image cannot be 
split if it contains any single file that is larger than the specified maximum file size.

4 Click Split.
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When you split a workstation image and span it across several CDs or DVDs, you are essentially 
creating a base image on the first CD or DVD. The remaining CDs or DVDs are add-on images.

To restore a workstation image that has been spanned across several CDs or DVDs you should 
restore the first CD or DVD before restoring the remaining CDs or DVDs containing the add-on 
images. For more information, see “Manually Putting an Image on a Workstation” on page 651.
NOTE: Restoring Split Images is a manual task and can only be automated by scripted imaging.

Resizing a Partition in an Image
For workstation (base) images, you can edit the value in the Original Size text box to allow you to 
change how big the imaging engine will make the partition when the image is restored.

For example, suppose you create a workstation (base) image of a workstation with a 20 GB hard 
drive and you want to then put that image on a new workstation with a 60 GB hard drive. If you 
do not increase the size of the partition, the partition will be 20 GB, thus making the remaining 40 
GB unusable. 

However, if you increase the number in the Original Size text box to match the size of the new hard 
drive, the imaging engine will expand the partition when the image is restored so that you will be 
able to use the entire drive. 

To resize a partition:

1 Open Image Explorer (imgexp.exe).

2 Right-click a partition in the left frame, then click Properties.

3 Increase or decrease the value in the Original Size text box.

You cannot decrease the number in the Original Size text box to a smaller value that what is 
in the Minimum Size text box. 

NOTE: The Original Size field is not applicable for add-on images and cannot be modified.

ZENworks Imaging Windows Agent (Ziswin.exe)
When you install the ZENworks Imaging Windows Agent (ziswin) on an existing Windows 
workstation, it saves certain workstation-unique data (IP address, computer name, etc.) to an area 
on the hard disk that is safe from reimaging. 

The following sections contain additional information:

“Understanding the ZENworks Imaging Windows Agent (Ziswin.exe)” on page 679

“Running the ZENworks Imaging Windows Agent in Interactive Mode” on page 680

“Running the ZENworks Imaging Windows Agent in Service Mode” on page 685

“Running the ZENworks Imaging Windows Agent in Installation Mode” on page 688

“Running the ZENworks Imaging Windows Agent in Uninstallation Mode” on page 688
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Understanding the ZENworks Imaging Windows Agent (Ziswin.exe)
The ZENworks Imaging Windows Agent is an extension to the Windows bootup procedure on a 
workstation. 

The ZENworks Imaging Windows Agent (ziswin.exe) is installed on each workstation when you 
install the Desktop Management Agent. On Windows 98 workstations, the default location is 
windows\system\ziswin.exe. On Windows 2000/XP workstations, the default location is 
windows\system32\ziswin.exe. During installation of the Desktop Management Agent, you must 
select the Workstation Imaging feature on the Select Features page. For more information, see 
“Installing and Configuring the Desktop Management Agent” in the Novell ZENworks 6.5 Desktop 
Management Installation Guide.

If you want to run the ZENworks Imaging Windows Agent on a workstation without the Desktop 
Management Agent installed, you can install it manually. For more information, see “Manually 
Installing the ZENworks Imaging Windows Agent (Ziswin.exe)” on page 680.

The ZENworks Imaging Windows Agent (ziswin.exe) is also installed on the Imaging server 
(sys:public\zenworks\imaging\ziswin.exe, by default).

The ZENworks Imaging Windows Agent runs before any network communications are 
established. It enables you to:

Make an existing Windows workstation safe for reimaging

When you install the ZENworks Imaging Windows Agent on an existing Windows 
workstation, it saves certain workstation-unique data (such as the IP address and Computer 
name) to an area on the hard disk that is safe from reimaging. After the workstation is 
reimaged and Windows reboots, the agent restores the data from the image-safe area so the 
workstation can communicate on the network using the same identity as before.

Automatically assign a network identity to a brand new workstation

A new workstation (with no Windows operating system) doesn’t have a network identity 
established yet. You can define network identity information for such a workstation in a 
Novell eDirectoryTM policy and apply it when the workstation receives its first Windows 
image. In this scenario, the Windows image is put down (including the ZENworks Imaging 
Windows Agent) on the workstation and the identity information from the eDirectory policy 
is written to the image-safe area on the hard disk. When the workstation reboots, the agent 
reads the data from the image-safe area and applies it to the Windows installation, thus 
establishing the workstation’s network identity automatically.

The data that the ZENworks Imaging Windows Agent saves to (or restores from) the image-safe 
area includes the following:

Whether a static IP address or DHCP is used

If a static IP address is used:

IP address

Subnet mask

Default gateway (router)

Computer (NETBIOS) name

Workgroup that the workstation belongs to, if any

Workstation Security ID (SID)

If the workstation has been registered in eDirectory: 
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Distinguished name of the Workstation object

Context of the Workstation object

eDirectory tree that the Workstation object belongs to

DNS settings

DNS suffix

DNS hostname

DNS servers

On a workstation that has just received a new Windows 2000/XP base image, in addition to 
restoring the above data, the agent also locates and modifies all instances of the Security Identifier 
(SID). This ensures that the workstation has a SID that is unique from other workstations that 
might receive the same image.
IMPORTANT: The ZENworks Imaging Windows Agent does not save or restore any Windows2000/XP 
Domain information. If you change a workstation’s domain and then restore an image, the workstation receives 
whatever domain is embedded in the new image.

Manually Installing the ZENworks Imaging Windows Agent (Ziswin.exe)

The ZENworks Imaging Windows Agent (ziswin.exe) is installed on each workstation when you 
install the Desktop Management Agent. You can also run the ZENworks Imaging Windows Agent 
on a workstation without the Desktop Management Agent installed. 

The following sections contain additional information:

“Manually Installing Ziswin.exe on a Windows 98 Workstation:” on page 680

“Manually Installing Ziswin.exe on a Windows 2000/XP Workstation:” on page 680

Manually Installing Ziswin.exe on a Windows 98 Workstation:

1 From the windows\system folder on the Imaging server, copy the following files to the 
windows\system folder on the workstation:

ziswin.exe

zislib16.dll

zislib32.dll

2 From the command prompt, run ziswin -install.

Manually Installing Ziswin.exe on a Windows 2000/XP Workstation:

1 From the windows\system folder on the Imaging server, copy the ziswin.exe file to the 
windows\system32 folder on the workstation.

2 From the command prompt, run ziswin -install.

Running the ZENworks Imaging Windows Agent in Interactive Mode
You can use the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode to view and 
edit a workstation’s image-safe data using a graphical user interface rather than from the command 
line or regedit. The ZENworks Imaging Windows Agent combines the capabilities of the Image-
Safe Data Viewer (zisview) to let you view a workstation's image-safe data and the Image-Safe 
Data Editor (zisedit) to let you edit this data.
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The following sections describe the tasks that you can perform using the ZENworks Imaging 
Windows Agent in interactive mode:

“Starting the ZENworks Imaging Windows Agent in Interactive Mode” on page 681

“Reloading a Workstation’s Image-Safe Data” on page 681

“Saving a Workstation’s Unique Data to the Image-Safe Data Store” on page 681

“Importing a Workstation’s Image-Safe Data from a File” on page 682

“Exporting a Workstation’s Image-Safe Data to a File” on page 681

“Modifying a Workstation’s Image-Safe Data” on page 682

“Clearing a Workstation’s Image-Safe Data” on page 683

“Viewing the Contents of a Workstation’s Image-Safe Data” on page 683

“Modifying a Workstation’s Image-Safe Options” on page 683

“Viewing a Workstation’s Image-Safe Data History” on page 685

Starting the ZENworks Imaging Windows Agent in Interactive Mode

1 To run the ZENworks Imaging Windows Agent in interactive mode, manually run ziswin.exe, 
for example from Explorer, the command line prompt, the Windows > Start > Run command, 
and so forth.

The ZENworks Imaging Windows Agent (ziswin.exe), is installed on each workstation during 
installation of the Desktop Management Agent (if you selected the Desktop Imaging feature). 
For Windows 98 workstations, the default location is windows\system\ziswin.exe. For 
Windows 2000\XP workstations, the default location is windows\system32\ziswin.exe. For 
more information, see “Installing and Configuring the Desktop Management Agent” in the 
Novell ZENworks 6.5 Desktop Management Installation Guide.

If the ZENworks Imaging Windows Agent is started as part of a boot sequence, it is 
automatically started in service mode. If the ZENworks Imaging Windows Agent is started 
manually, it is automatically started in interactive mode.

Reloading a Workstation’s Image-Safe Data

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click File > Reload Image-Safe Data.

Saving a Workstation’s Unique Data to the Image-Safe Data Store

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click File > Save Image-Safe Data > Save.

Exporting a Workstation’s Image-Safe Data to a File

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click File, then click Export to File.

3 Browse to the location in which you want to save the file, then type the filename.

4 Click Save.
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Importing a Workstation’s Image-Safe Data from a File

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click File, then click Import from File.

3 Browse to and select the .zis file you want to import data from, then click Open to apply the 
imported image-safe data to the workstation.

Modifying a Workstation’s Image-Safe Data

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click Edit, then click Modify Image-Safe Data.

3 In the Modify Image-Safe Data dialog box, modify the desired data on the Imaging tab:

Just Imaged Flag: If this option is selected, the ZENworks Imaging Windows Agent (ziswin) 
reads data from the image-safe data store and writes it to the Windows registry. If this option 
is not selected, the Imaging Agent reads data from the Windows registry and writes it to the 
image-safe data store. 

Last Base Image: Displays information about the last base image that was restored to this 
workstation. The imaging engine uses this information to prevent the same image from being 
restored to the workstation, unless you specify in Novell ConsoleOne® that the same image 
be restored.

Filename: The last base image that was restored to the workstation.

File Time: The time stamp of the last base image that was restored to the workstation.

File Size: The size of the last base image that was restored to the workstation.

Scripted Image: Indicates whether or not the last imaging operation was a scripted image.

Scripted Image Flag: If this option is checked, the last imaging operation was a scripted 
image. If this option is not checked, the last imaging operation was not a scripted image.

Script Checksum: Displays the checksum value representing the last script run. The 
imaging engine uses the checksum to prevent the same script from re-running on the 
workstation unless you specify in ConsoleOne that you want to rerun the same script.

4 Click the Identity tab in the Modify Image-Safe Data dialog box, then modify the desired data:

Object Name: The name of the Novell eDirectory Workstation object for this workstation.

Tree Name: The Novell eDirectory tree that contains the Workstation object for this 
workstation.

Object ID: The ZENworks Object ID for this workstation, which together with the 
workstation DN, uniquely identifies this workstation. 

5 Click the Windows tab in the Modify Image-Safe Data dialog box, then modify the desired 
data:

NETBIOS Name: Displays the Windows NETBIOS name for this workstation. For Windows 
2000/XP workstations, the computer name and the NETBIOS name are not necessarily the 
same. For these workstations, the ZENworks Imaging Windows Agent uses the DNS 
Hostname field in the image-safe data as the computer name, which takes precedence over the 
NETBIOS name entered here.

Workgroup: Displays the network workgroup that this workstation belongs to, if any. A 
workgroup is a group of users who work on a common project and share information on 
interconnected computers, often over a LAN.
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Workstation SID: Displays the workstation's Security ID (SID), a unique number that 
identifies this workstation in Windows.

Clear SID: Clears this workstation's SID. If you clear the workstation's SID, the ZENworks 
Imaging Windows Agent generates a new SID if the agent is run in Enabled mode. To specify 
that the agent run in Enabled mode, click Edit, click Options, then click Enabled on the Mode 
tab. You must also set the Just Imaged flag (click Edit, click Modify Image-Safe Data, then 
click Just Imaged Flag on the Imaging tab).

6 Click the IP Settings tab in the Modify Image-Safe Data dialog box, then modify the desired 
data to configure the IP settings stored in the image-safe data area of this workstation:

Uses DHCP to Get an IP Address: Indicates that this workstation uses DHCP to obtain its 
IP address.

Uses a Static IP Address: Indicates that this workstation uses a static IP address.

IP Address: Displays the static IP address that this workstation uses.

Subnet Mask: Displays the subnet mask that this workstation uses.

Gateway: Displays the gateway that this workstation uses.

7 Click the DNS tab in the Modify Image-Safe Data dialog box, then modify the desired data to 
configure the DNS settings stored in the image-safe data area of this workstation:

DNS Suffix: Displays the DNS context of the workstation.

DNS Hostname: Displays the DNS local hostname of the workstation. For Windows 2000/
XP, this is the Computer name plus the first 15 characters of the NETBIOS name.

DNS Servers: Displays the names of DNS servers used for DNS name resolution. You can 
use the drop-down list to select another DNS server or you can use the browse button to enter 
additional DNS servers for this workstation. 

8 Click OK.

Clearing a Workstation’s Image-Safe Data

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click Edit > Clear Image-Safe Data.

Viewing the Contents of a Workstation’s Image-Safe Data

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click Edit > Copy to Clipboard.

Modifying a Workstation’s Image-Safe Options

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click Edit > Options.

3 In the ZENworks Imaging Windows Agent Options dialog box, modify the desired data on 
the Mode tab to select the mode for the ZENworks Windows Imaging Agent (ziswin) to run 
during the boot process:

Enabled: If this option is checked and the Just Imaged Flag is set (File > Edit > Modify 
Image-safe Data > Imaging tab), the ZENworks Imaging Windows Agent will read data from 
the image-safe data store and write it to the Windows registry.
Imaging Utilities and Components 683



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
If this option is checked but the Just Imaged Flag is not set, the ZENworks Imaging Windows 
Agent will read data from the Windows registry and write it to the image-safe data store.

Disabled: If this option is checked, the ZENworks Imaging Windows Agent will run 
automatically during the boot process, but will exit without doing any work.

Re-enable After _ Boot: Enable this option and specify the number of boot cycles to take 
place before the imaging agent returns to an enabled state. 

Uninstalled: If this option is enabled, the ZENworks Imaging Windows Agent does not 
automatically run during the boot process.

4 Click the Logging tab in the ZENworks Imaging Windows Agent Options dialog box, then 
modify the desired data to specify history log and debug logging setting for the ZENworks 
Imaging Windows Agent (ziswin):

History Logging: Use the options in this group box to specify the location of the history log 
file and how many entries you want the log file to contain before discarding the oldest entries.

History Log File: Click the browse button to specify the location in which you want to 
store the history log file (ziswin.hst).

Maximum History Log Entries: Specify the maximum number of log entries that you 
want the history log file to contain. After the number of entries you enter in this field is 
reached, each new entry causes the oldest entry to be discarded.

Debug Logging: The debug log file, ziswin.log, is located in the system temp directory if the 
ZENworks Imaging Windows Agent is run in service mode. The ZENworks Imaging 
Windows Agent runs, by default, in service mode during each Windows boot process when 
the workstation is started. When you run the ziswin.exe executable file, by default, the agent 
is started in interactive mode and ziswin.log is located in the interactive user's user temp 
directory.

Disabled: Turns off debug logging.

Single Log File: Enables debug logging and specifies that the current debug log file be 
overwritten during each boot process.

Multiple Log Files: Enables debug logging and specifies that a new debug log file will 
be created during each boot process. Each new log file will be given a unique name 
(ziswinx.log, where x represents a number that identifies each log file). Although these 
log files are small, you may want to periodically delete older files that you no longer need.

5 Click the Restore Mask tab in the ZENworks Imaging Windows Agent Options dialog box, 
then use this tab to prevent restoration of certain image-safe data components to the 
workstation when the ZENworks Imaging Windows Agent (ziswin) restores image-safe data.

To prevent image-safe data from being restored to the workstation, check the box next to the 
desired component.

If the check box is enabled (a check mark displays next to an item), that information will not 
be restored to the workstation from the image-safe data.

If the check box is not enabled (a check mark does not display next to an item), that 
information will be restored to the workstation from the image-safe data.

6 Click the Collection Mask tab in the ZENworks Imaging Windows Agent Options dialog box, 
then use this tab to prevent certain items from being overwritten in the image-safe data store 
when the ZENworks Imaging Windows Agent (ziswin) collects data from Windows.

To prevent image-safe data from being overwritten, check the box next to the desired 
component.
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If the check box is enabled (a check mark displays next to an item), that information will not 
be written to the workstation's image-safe data. Any corresponding existing image-safe data 
will not be overwritten.

If the check box is not enabled (a check mark does not display next to an item), that 
information will be collected from the workstation and stored with the workstation's image-
safe data. Any corresponding existing image-safe data will be overwritten.

7 Click OK.

Viewing a Workstation’s Image-Safe Data History

1 Open the ZENworks Imaging Windows Agent (ziswin.exe) in interactive mode.

2 Click View > View History.

From the ZENworks Imaging Agent History dialog box, you can view the image-safe data's 
history, load a history file from another location, clear the workstation's image-safe data 
history, and view a specific history entry's details, including the image-safe data that was 
loaded during bootup and saved during shutdown. To view a specific history entry's data, 
select the entry in the ZENworks Imaging Agent History dialog box, then click Details.

Running the ZENworks Imaging Windows Agent in Service Mode
The ZENworks Imaging Windows Agent (ziswin) runs in service mode when no parameters are 
given on the command line. This will always be the mode when the ZENworks Imaging Windows 
Agent is run automatically by Windows during the boot process (because of the registry entries 
made during the installation mode install process.) When it is in service mode, the ZENworks 
Imaging Windows Agent reads the registry to determine if it should be disabled or inactive. If the 
ZENworks Imaging Windows Agent is not disabled and not inactive, it will read the image-safe 
data to determine whether to run in restoration or collection submode. If the Just-Imaged flag in 
the image-safe data is set, the ZENworks Imaging Windows Agent runs in the restoration 
submode. If the Just-Imaged flag in the image-safe data is not set, or if image-safe data does not 
exist on the machine, the ZENworks Imaging Windows Agent runs in collection submode.

The following sections contain more information:

“Disabled Submode” on page 685

“Inactive Submode” on page 686

“Collection Submode” on page 686

“Restoration Submode” on page 687

Disabled Submode

To run the ZENworks Imaging Windows Agent in the disabled submode of service mode, edit the 
workstation’s HKEY_LOCAL MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN 
Disabled registry setting.

When this string value is set to 1, the ZENworks Imaging Windows Agent exits without doing any 
work.
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Inactive Submode

You can set a registry value to cause the ZENworks Imaging Windows Agent to consider itself 
inactivated for a certain number of executions.

To run the ZENworks Imaging Windows Agent in the inactive submode of service mode, edit the 
workstation’s HKEY_LOCAL MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN 
Inactive setting. You can set this value at anything greater than zero.

When the ZENworks Imaging Windows Agent runs in service mode and determines that this 
registry value is set, the agent decrements the inactive count by one and then exits. When the 
inactive count reaches zero, the ZENworks Imaging Windows Agent reactivates itself and 
performs its normal collection or restoration work.

Collection Submode

The ZENworks Imaging Windows Agent gathers Windows registry information necessary to 
populate the image-safe data store and writes that information to an area on the workstation’s hard 
disk that is safe from reimaging. In so doing, the ZENworks Imaging Windows Agent will not 
collect information for any image-safe data components that are specified in the Do Not Collect 
entry in the registry. This functionality provides a means for administrators to prevent certain 
components in the image-safe data store from being overwritten with new data.

You can also edit the edit the workstation’s HKEY_LOCAL 
MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN Do Not Collect Mask to specify 
which components you do not want the ZENworks Imaging Windows Agent to collect inside of 
the image-safe data store. This value is interpreted as a mask (as seen in the table below), with each 
component receiving one bit in the mask. To stop the collection of one item, specify its 
corresponding mask as the value in the registry. To stop the collection of multiple items, add the 
masks together and the sum is the value defined in the registry.

You can use the following values for the ZISWIN Do Not Collect Mask:

Component Value

Workstation Distinguished Name 0x00000001

Workstation Tree                        0x00000002

NetBios Name                             0x00000004

Workgroup                               0x00000008

IP Address                                   0x00000010

SID                                              0x00000020

DNS                                             0x00000100

Workstation ID                              0x00000200
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Restoration Submode

The ZENworks Imaging Windows Agent reads the information stored in the image-safe data store 
and restores that information into the Windows registry.

You can also edit the workstation’s HKEY_LOCAL 
MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN Do Not Restore Mask to specify 
image-safe data components that you do not want the ZENworks Imaging Windows Agent to 
restore to the Windows registry upon successful completion of an image. This value is interpreted 
as a mask (as seen in the table below), with each component receiving one bit in the mask. To stop 
the restoration of one item, specify its corresponding mask as the value in the registry. To stop the 
restoration of multiple items, add the masks together and the sum is the value defined in the 
registry.

You can use the following values for the ZISWIN Do Not Restore Mask:

Following are common scenarios and example usages of the ZISWIN Do Not Restore Mask:

Windows Domain Environment: The ZENworks Imaging Windows Agent does not currently 
add workstations to the domain. However, you can use SYSPREP to add the workstation to the 
domain. In this scenario, you can specify that the ZENworks Imaging Windows Agent restore 
everything but the Workgroup. To do this, set the value of this registry key to 0x00000008. 

DHCP Environment: Administrators who push IP and DNS configuration through DHCP do not 
need the ZENworks Imaging Windows Agent to restore this information from image-safe data 
store. To not restore these two components, the value of this registry key is 0x00000110.

SYSPREP Naming Environment: Administrators can have a process (running during the mini-
setup that SYSPREP performs) that names the NetBios name of the computer. Because the 
ZENworks Imaging Windows Agent runs after SYSPREP, there could be a case where the 
ZENworks Imaging Windows Agent is renaming the workstation (to its original name) after the 
proper name was determined during the SYSPREP routine. To have the ZENworks Imaging 
Windows Agent not restore the NetBios name of a workstation, set the value of this registry key 
to 0x00000004.

If your environment has all three of the above mentioned configurations, add the four components’ 
mask values. The resulting registry value is 0x0000011C.

Component Value

Workstation Distinguished Name 0x00000001

Workstation Tree                        0x00000002

NetBios Name                             0x00000004

Workgroup                               0x00000008

IP Address                                   0x00000010

SID                                              0x00000020

DNS                                             0x00000100

Workstation ID                              0x00000200
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If your environment needs only the Workstation Object, Workstation ID, and Workstation Tree to 
be restored after imaging, you would add up all the other components’ mask values. The resulting 
registry value would be 0x0000013C.

If your environment does not need anything restored by the ZENworks Imaging Windows Agent, 
the registry value can be set to 0xFFFFFFFF.
NOTE: You can use the registry REG_SZ value in HKEY_LOCAL 
MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN Prevent Reboot=1 to prevent the ZENworks Imaging 
Windows Agent from causing the workstation to reboot after performing work in Restoration mode.

Running the ZENworks Imaging Windows Agent in Installation Mode
To install the ZENworks Imaging Windows Agent so that it runs automatically each time Windows 
starts, follow the instructions in Chapter 54, “Setting Up Workstations for Imaging,” on page 629.

To run the ZENworks Imaging Windows Agent in installation mode, entering the following on the 
workstation’s command line:

ziswin -install

The ziswin.exe file must be located in the workstation’s windows\system32 directory for Windows 
2000/XP workstations. For Windows 98 workstations, ziswin.exe must be located in the 
workstation’s windows\system directory.

When you run ziswin.exe with the -install switch, the ZENworks Imaging Windows Agent creates 
the registry entries necessary for it to run automatically during subsequent boot cycles of the 
workstation. This switch adds the String Value System with a Value Data of ZISWIN.EXE to the 
registry location so that ziswin.exe will execute during subsequent bootup sequences. On 
Windows 2000/XP workstations, this location is 
HKEY_LOCAL_MACHINE\SOFTWARE\MICROSOFT\WINDOWS 
NT\CURRENTVERSION\WINLOGON. On Windows 98 workstations, this location is 
HKEY_LOCAL_MACHINE\SOFTWARE\MICROSOFT\WINDOWS\CURRENT 
VERSION\RUN SERVICES. 

Running the ZENworks Imaging Windows Agent in Uninstallation Mode
The ZENworks Imaging Windows Agent (ziswin.exe) is uninstalled if you uninstall the 
ZENworks Desktop Management Imaging Agent from the workstation. 

If you want to uninstall only the ZENworks Imaging Windows Agent, you can run ziswin -remove 
from the workstation’s command line. Running ziswin -remove removes the registry entries that 
cause ziswin.exe to be executed during the boot cycle; however, the ziswin.exe file is not removed 
from the workstation.

Image-Safe Data Viewer and Editor (Zisview and Zisedit)
After booting a workstation from an imaging device, you can enter zisedit and zisview at 
the Linux bash prompt to edit and view the image-safe data for that workstation.

The following sections contain additional information:

“Image-Safe Data Viewer” on page 689

“Image-Safe Data Editor” on page 691
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NOTE: You can also use the ZENworks Imaging Windows Agent (ziswin.exe) to view and edit a workstation’s 
image-safe data. The ZENworks Imaging Windows Agent combines the capabilities of the Image-Safe Data 
Viewer (zisview) to let you view a workstation's image-safe data and the Image-Safe Data Editor (zisedit) to let 
you edit this data. For more information, see “ZENworks Imaging Windows Agent (Ziswin.exe)” on page 678.

Image-Safe Data Viewer
After booting a workstation from an imaging device, you can enter zisview at the Linux bash 
prompt to view the image-safe data for that workstation.

The image-safe data viewer (zisview) displays the following information about the workstation:

Category Information

Image-safe Data Version: The version number of the Imaging Agent (ziswin).

Just Imaged Flag: If this is set to False, the Imaging Agent 
(ziswin) reads data from the Windows registry and write it to the 
image-safe data store. If this is set to True, the Imaging Agent will 
read data from the image-safe data store and write it to the 
Windows registry.

Last Base Image: The last base image that was restored to the 
workstation.

Last Base Image Time: The time stamp of the last base image 
that was restored to the workstation.

Last Base Image Size: The size of the last base image that was 
restored to the workstation.

Scripted Image Flag: If this option is set to True, the last imaging 
operation was a scripted image. If this option is set to False, the 
last imaging operation was not a scripted image.

Script Checksum: Displays the checksum value representing 
the last script run. The imaging engine uses the checksum to 
prevent the same script from re-running on the workstation 
unless you specify in ConsoleOne that you want to rerun the 
same script.

Workstation Identity 
Information

Workstation Tree: The Novell eDirectory tree that contains the 
Workstation object for this workstation.

Workstation Object: The distinguished name of this computer’s 
workstation.

Workstation ID: The workstation identification number.

Computer Name: The computer name for the workstation.

Workgroup: The Microsoft network workgroup of the 
workstation.

Windows SID: The Windows Security ID of the workstation, a 
unique number that identifies this workstation in Windows.
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To use zisview, enter any of the following commands at the Linux bash prompt:

Network Information DHCP: Displays whether this workstation uses DHCP to obtain 
its IP address.

IP Address: Displays the static IP address that this workstation 
uses.

Subnet Mask: Displays the subnet mask that this workstation 
uses.

Gateway: Displays the gateway that this workstation uses.

DNS Servers: The number of DNS nameservers used for DNS 
name resolution.

DNS Suffix: The DNS context of the workstation.

DNS Hostname: The DNS local hostname of the workstation.

Command Explanation

zisview Displays all image-safe data.

zisview -z field Displays information about a specific field or fields. field is one or 
more field names separated by a space. field is not case-sensitive. 

All of the following are valid field names (the corresponding 
minimum names that can also be entered on the command line 
follow each field name in parenthesis):

JustImaged (J)
ScriptedImage (SC) 
LastBaseImage (L)
Tree (T)
ObjectDN (ObjectDN)
NetBIOSName (N)
WorkGroup (WorkG)
SID (SI)
WorkstationID (Works)
DHCP (DH)
IP (I)
Gateway (Gateway)
Mask (M)
DNSServerCount (DNSServerC)
DNSServer (DNSServer)
DNSSuffix (DNSSu)
DNSHostName (DNSH)

zisview -s Creates a script that can be used to generate environment variables 
that contain all the image-safe data fields.

zisview -h Displays help for zisview.

Category Information
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Image-Safe Data Editor
After booting a workstation from an imaging device, you can enter zisedit at the Linux bash 
prompt to change, clear, or remove information the image-safe data for that workstation.

To use zisedit, enter any of the following commands at the Linux bash prompt:

Command Explanation

zisedit This displays a screen showing all of the image-safe data fields. You 
can add or change any of the information in the fields.

zisedit field=new_information You can change the information for one field using this syntax, where 
field is any valid field name and new_information is the information 
you want this field to contain. field is not case sensitive.

For example, enter zisedit Mask=255.255.252.0 to enter this 
information in the subnet mask field.

All of the following are valid field names (the corresponding minimum 
names that can also be entered on the command line are shown in 
parenthesis after each field name):

JustImaged (J)
ScriptedImage (SC) 
LastBaseImage (L)
Tree (T)
ObjectDN (ObjectDN)
NetBIOSName (N)
WorkGroup (WorkG)
SID (SI)
WorkstationID (Works)
DHCP (DH)
IP (I)
Gateway (Gateway)
Mask (M)
DNSServerCount (DNSServerC)
DNSServer1 (DNSServer1)
DNSSuffix (DNSSu)
DNSHostName (DNSH)
PXEWorkRevision (PXEWorkR)
PXEWorkObject (PXEWorkO)
PXETaskID (PXETaskI)
PXETaskState (PXETaskS)
PXETaskRetCode (PXETaskR)

zisedit -c Clears all image-safe data fields.

zisedit -r Removes the image-safe data store.

zisedit -h Displays help for zisedit.
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Imaging Boot Disk Creator (Zimgboot.exe)
With the release of ZENworks 6.5 SP2, there are now two versions of zimgboot.exe:

“Zimgboot.exe for ZENworks 6.5 SP1 and Earlier” on page 692

“Zimgboot.exe for ZENworks 6.5 SP2 and Later” on page 695

Zimgboot.exe for ZENworks 6.5 SP1 and Earlier
Use the Imaging Boot Disk Creator at a Windows workstation to create or update imaging boot 
diskettes (SP1 only), so you can boot workstations to perform imaging tasks. Also use this utility 
to create a PXE boot disk to be used with a workstation that cannot be PXE enabled, and to create 
a diskette that contains Linux utilities.
IMPORTANT: You can update imaging boot diskettes only in the sense that the same physical diskettes can 
be reused. When updating the second, third, fourth, and fifth diskettes or the optional language diskette, you 
must reformat the diskette before updating it. The first diskette can be reused without reformatting.

Zimgboot.exe is located in the sys:public\zenworks\imaging folder in your ZENworks Desktop 
Management installation (on the Imaging server). It is also accessible from the Tools menu of 
ConsoleOne.

This section includes the following information:

“Starting the Imaging Boot Disk Creator” on page 692

“Using Zimgboot.exe to Add Linux Drivers” on page 693

“Using Zimgboot.exe to Create a Language Disk” on page 694

“Using Zimgboot.exe to Create a Utility Disk” on page 695

“Using Zimgboot.exe to Create a PXE Disk” on page 695

Starting the Imaging Boot Disk Creator

1 To start the boot disk creator as a standalone Windows utility, double-click the zimgboot.exe 
file (sys:public\zenworks\imaging\zimgboot.exe on the Imaging server). There are no 
command line parameters. 

or

To start the utility from ConsoleOne from the server, click Tools > ZENworks Utilities > 
Imaging > Create or Modify Boot Diskette.
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TIP: If the Imaging Boot Disk Creator fills up too much of your screen, change your screen resolution to a 
setting greater than 800 X 600.

For the process to create imaging boot diskettes, see “Using the ZENworks Imaging Floppy Boot 
Disk Creator Utility” on page 580. When creating the diskettes, you can configure various aspects 
of the imaging bootup process, including:

How to communicate on the IP network, if necessary

How automated the imaging bootup process should be

Which Imaging server to contact during automated operations

How large the imaging Desktop Management Workstation Imaging (Linux) partition on the 
hard disk should be, if one will be created

Which language support (English or otherwise) to load for the keyboard

For details on these and other configuration options, see the online help (click the Help menu or 
press F1) in the utility. The configuration settings you make in the utility are saved to the 
settings.txt file on the fifth imaging boot diskette. You can edit this file after creating the diskettes 
if needed. For details on the format of this file, see “Imaging Configuration Parameters 
(Settings.txt)” on page 695.

If you need to create imaging boot diskettes to boot with a non-English keyboard but the language 
you need isn’t listed in the utility, see “Imaging Bootup Languages (Zimglang.ini)” on page 701.

Using Zimgboot.exe to Add Linux Drivers
IMPORTANT: For information on adding Linux drivers in ZENworks 6.5 SP2, see Chapter 62, “Adding Linux 
Drivers in ZENworks 6.5 SP2,” on page 723.

Use the Add Linux Drivers function to specify the Linux drivers you want to place on the fourth 
boot diskette (if space allows) or on an additional Linux drivers diskette.

Using this function, you can search for and add the network path to Linux driver files that you have 
created or downloaded. The dialog box helps you to build a drivers list and categorize it by driver 
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type (SCSI, Block, Network, PCMCIA, and Miscellaneous). You can also remove unwanted 
drivers from the list. This master list of driver files can be added to a diskette that you can specify 
later.

The Add Linux Drivers function also lets you specify the drivers you want to load by default. You 
do this by selecting the name of a driver on the master list and then clicking the Load button. This 
moves the driver name to the default load list, where you can change the load order of the default 
drivers and further specify their individual loading parameters.

When your load list is ready, you can use a function in zimgboot.exe to copy the additional Linux 
drivers to a diskette. All of the driver files are stored in different subdirectories of the \drivers 
directory on the diskette:

Network drivers are stored in \drivers\net

PCMCIA drivers are stored in \drivers\pcmcia

Block drivers are stored in \drivers\block

SCSI drivers are stored in \drivers\scsi

Miscellaneous drivers are stored in \drivers\misc

These drivers can also be added to an imaging boot CD or DVD, hard-disk partition, or for use 
with Preboot Services. For more information, see “Preparing an Imaging Boot Method” on 
page 577 and “Adding Linux Drivers to Your Boot Method” on page 588.

Obtaining Linux Drivers

To obtain a Linux driver for your particular hardware, visit the Web site of the hardware vendor 
and check for a download location.

There are also some other Web sites where you can obtain drivers:

Network drivers can be downloaded from the Scyld Computing Corporation (http://
www.scyld.com/network.html).

PCMCIA drivers can be downloaded from the Linux PCMCIA Information Page (http://
pcmcia-cs.sourceforge.net).

You can also get additional Linux drivers at the Novell ZENworks Cool Solutions Web 
Community (http://www.novell.com/coolsolutions/zenworks/features/a_linux_drivers_zw.html).

To learn more about drivers, including the loading parameters you need to specify, see the Linux 
Documentation Project (http://en.tldp.org) and visit the following HOWTO (http://en.tldp.org/
HOWTO/HOWTO-INDEX/howtos.html) sites: 

Hardware

PCMCIA

SCSI

Ethernet

Using Zimgboot.exe to Create a Language Disk

If you use the Boot Disk Creator to create boot diskettes, and if you choose a non-English keyboard 
in the Language/Country field of the Boot Disk Creator dialog box, you can click Create Language 
Disk to create a language diskette that will be used to boot the workstation with the imaging 
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diskettes in the non-English language you chose. The diskette you use must be an empty, 
formatted, high-density diskette. Do not reuse an old imaging diskette unless you reformat it first.

Using Zimgboot.exe to Create a Utility Disk

You can use the Boot Disk Creator to create a diskette that contains Linux utilities such as df 
(shows disk usage), fdisk, less, more, host (performs DNS lookups in order to convert DNS names 
to IP addresses), ldd (shows shared library dependencies), pico (text editor), sed (stream file 
editor), and touch (changes file time stamps). These utilities are not needed to perform imaging, 
but they might be useful to you for debugging purposes when imaging is booted to manual or 
maintenance mode.

For more information, see “Create A Utility Disk” on page 584.

Using Zimgboot.exe to Create a PXE Disk

You can use the Boot Disk Creator to create a PXE boot diskette that allows you to use PXE on a 
workstation that is not PXE-enabled. Click Create PXE Disk to launch PXE-on-Disk. You need 
one empty, formatted, high-density diskette.

For more information, see “Using the Desktop Management Preboot Services PXE-on-Disk 
Utility” on page 617.

Zimgboot.exe for ZENworks 6.5 SP2 and Later
For information, see “Using zimgboot.exe in ZENworks 6.5 SP2 and Later” on page 584.

Imaging Configuration Parameters (Settings.txt)
With the release of ZENworks 6.5 SP2, there are now two versions of the settings.txt file for the 
different zimgboot.exe utilities:

“Settings.txt for ZENworks 6.5 SP1 and Earlier” on page 695

“Settings.txt for ZENworks 6.5 SP2 and Later” on page 698

Settings.txt for ZENworks 6.5 SP1 and Earlier
The settings.txt file contains parameters that control how the imaging boot-up process occurs.

Settings.txt is installed to the root of the imaging boot device (CD or DVD, hard-disk partition, the 
fifth diskette, or on the Imaging/Preboot Services server).

Settings.txt is a plain text file that contains various parameters, each on a separate line. Each 
parameter has the general format of PARAMETER=value. Lines that begin with a pound sign (#) 
are comments and are ignored during the imaging bootup process.

The format and function of each parameter in the settings.txt file are described in the following 
table:
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Parameter Specifies

PROMPT Specifies whether to prompt for each configuration setting when you 
boot a workstation from the imaging device. If you leave this 
parameter commented out or set it to No, the workstation boots using 
the configuration settings specified in settings.txt and you can’t 
override the settings during bootup unless you type config at the 
boot prompt before the Linux operating system begins to load. If you 
set this parameter to Yes, you are automatically prompted for each 
configuration setting during bootup.

PARTITIONSIZE The number of megabytes to allocate to the ZENworks Desktop 
Management Workstation Imaging (Linux) partition if you choose to 
create one locally on a workstation when you boot the workstation 
from the imaging device. The default size is 150 MB. The minimum 
partition size is 50 MB. The maximum size allowed is 2048 MB (2 
GB). If you plan to store an image in the ZENworks Desktop 
Management imaging partition, such as to enable the workstation to 
be restored to a certain state without connecting to the network, you 
might want to specify a larger size on this parameter.

Example: PARTITIONSIZE=500 

IPADDR The IP address used by a workstation to communicate on the 
network when you boot the workstation from the imaging device, if a 
static IP address is needed.

Example: IPADDR=137.65.95.126

If you want DHCP to be used, leave this and the next two parameters 
commented.

GATEWAY The IP address of the gateway (router) to be used by the workstation, 
if the workstation is using a static IP address.

Example: GATEWAY=137.65.95.254

If DHCP is being used, leave this parameter commented.

NETMASK The subnet mask to be used by the workstation, if the workstation is 
using a static IP address.

Example: NETMASK=255.255.252.0

If DHCP is being used, leave this parameter commented.

DNSDOMAINSUFFIX The list of DNS domain suffixes to be used to identify connections 
used by this workstation. Use a space to separate entries.

Example: DNSDOMAINSUFFIX=example.novell.com 
example.xyz.org

If DHCP is being used, leave this parameter commented.

DNSNAMESERVER The list of DNS name servers, by IP address, to use for resolving 
DNS domain names used on this workstation. Use a space to 
separate entries.

Example: DNSNAMESERVER=123.45.6.7 123.45.6.9

If DHCP is being used, leave this parameter commented out.
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PROXYADDR The IP address or full DNS name of the imaging (proxy) server to 
connect to when you boot a workstation from the imaging device in 
auto-imaging mode.

Examples:
PROXYADDR=137.65.95.127

PROXYADDR=imaging.xyz.com

This parameter is used to set the PROXYADDR environment 
variable in Linux when the workstation is booted from the imaging 
device. The imaging engine then reads this variable to determine 
which server to contact if it’s running in automatic mode. Whether it’s 
running in automatic or manual mode, the imaging engine attempts 
to log the imaging results to the server specified in this variable.

MANUALREBOOT Specifies whether to access the bash prompt to reboot a workstation 
manually after it was booted from the imaging device in automatic 
mode. (If the workstation was booted from the imaging device in 
manual mode, you must always reboot the workstation manually.)

If you boot a workstation from the imaging device and you let the 
bootup process proceed in automatic mode, the imaging engine 
starts and checks the imaging server to see if an imaging operation 
should be performed on the workstation. If so, it performs the 
imaging operation and then quits. If not, it quits without doing 
anything. 

What happens next depends on how you set this parameter. If you 
leave it commented out or set it to No, you are prompted to remove 
the imaging device (such as the CD or diskette, if necessary) and 
press any key to reboot the workstation to the native operating 
system. If you set this parameter to Yes, the workstation doesn't 
reboot automatically but instead displays the Linux prompt, allowing 
you to perform additional imaging-related tasks using the Linux 
menu or at the command line. This is helpful if you want to do things 
like check the current partition information or the image-safe data 
before booting to the native operating system.

Example: MANUALREBOOT=YES

LANGDISK Specifies whether to prompt for a language diskette when you boot 
a workstation from the imaging device. Set this parameter to Yes 
only if the workstation has a non-English keyboard and you have 
created a language diskette to support that keyboard as explained in 
the F1 help for the Imaging Boot Disk Creator (Zimgboot.exe) utility. 
If you need to support a language that’s not listed in the Imaging Boot 
Disk Creator utility, see “Imaging Bootup Languages (Zimglang.ini)” 
on page 701.

Example: LANGDISK=YES

Parameter Specifies
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If you have problems obtaining an IP address for a workstation running dual NICs, put the 
following line in the settings.txt file:

export VALIDATE_NIC=$PROXYADDR

This line in the settings.txt file validates the NICs; you might notice a small performance decrease 
in the time it takes to obtain an IP address for the workstation.

Settings.txt for ZENworks 6.5 SP2 and Later
The settings.txt file contains parameters that control how the imaging boot-up process occurs.

Settings.txt is installed to the root of the imaging boot device (CD or DVD, hard-disk partition, a 
blank diskette, or on the Imaging/Preboot Services server).

Settings.txt is a plain text file that contains various parameters, each on a separate line. Each 
parameter has the general format of PARAMETER=value. Lines that begin with a pound sign (#) 
are comments and are ignored during the imaging boot process.

You can edit this file manually in a text editor, manually using the Load Settings from Disk option 
in the zimgboot.exe utility, or by making configuration changes in the zimgboot.exe utility.

The format and function of each parameter in the settings.txt file are described in the following 
table:

LOADADDITIONALDRIVERS Specifies whether to prompt for a diskette with a /drivers directory 
containing additional Linux device drivers. This is a way to add 
drivers that might not be included, or to update existing drivers. 

Example: LOADADDITIONALDRIVERS=YES

The location of the driver on the diskette depends on the type of 
driver. For example, a network driver would be in /drivers/kernel/
drivers/net.

There might also be a drivers.conf in the /drivers directory on the 
diskette that is used to configure the drivers in a specific way. For 
more information about adding or updating drivers, see “Adding 
Linux Device Drivers” on page 587.

Parameter Specifies
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Parameter Specifies

MANUALREBOOT Whether you must reboot a workstation manually after it was booted 
from the imaging device in automatic mode. (If the workstation was 
booted from the imaging device in manual mode, you must always 
reboot the workstation manually.)

If you boot a workstation from the imaging device and you let the 
boot process proceed in automatic mode, the imaging engine starts 
and checks the imaging server to see if an imaging operation should 
be performed on the workstation. If so, it performs the imaging 
operation and then quits. If not, it quits without doing anything. 

What happens next depends on how you set this parameter. If you 
leave it commented out or set it to No, you are prompted to remove 
the imaging device (if necessary) and press any key to reboot the 
workstation to the native operating system. If you set this parameter 
to Yes, the workstation doesn't reboot automatically but instead 
displays the Linux prompt, allowing you to perform additional 
imaging-related tasks using the Linux menu or at the command line. 
This is helpful if you want to do things like check the current partition 
information or the image-safe data before booting to the native 
operating system.

Example: MANUALREBOOT=YES

PARTITIONSIZE The number of megabytes to allocate to the ZENworks Desktop 
Management Workstation Imaging (Linux) partition if you choose to 
create one locally on a workstation when you boot the workstation 
from the imaging device. The default size is 150 MB. The minimum 
partition size is 50 MB. The maximum size allowed is 2048 MB (2 
GB). If you plan to store an image in the ZENworks Desktop 
Management imaging partition, for example to enable the 
workstation to be restored to a certain state without connecting to the 
network, you might want to specify a larger size for this parameter.

Example: PARTITIONSIZE=500 

netsetup If you are using DHCP, keep this option enabled. If you are using a 
specific IP address, replace “dhcp” with “1” and uncomment and 
configure the other three IP address lines (HostIP, NETMASK, and 
GATEWAY).

Example: netsetup=dhcp

HostIP The IP address used by a device to communicate on the network 
when you boot the device from the imaging device, if a static IP 
address is needed.

Example: HostIP=137.65.95.126

If you want DHCP to be used, leave this and the next two parameters 
commented.

NETMASK The subnet mask to be used by the workstation, if the workstation is 
using a static IP address.

Example: NETMASK=255.255.252.0

If DHCP is being used, leave this parameter commented.
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If you have problems obtaining an IP address for a workstation running dual NICs, put the 
following line in the settings.txt file:

export VALIDATE_NIC=$PROXYADDR

This line in the settings.txt file validates the NICs; you might notice a small performance decrease 
in the time it takes to obtain an IP address for the workstation.

GATEWAY The IP address of the gateway (router) to be used by the workstation, 
if the workstation is using a static IP address.

Example: GATEWAY=137.65.95.254

If DHCP is being used, leave this parameter commented.

NAMESERVER The list of DNS name servers, by IP address, to use for resolving 
DNS domain names used on this workstation. Use a space to 
separate entries.

Example: NAMESERVER=123.45.6.7 123.45.6.9

If DHCP is being used, leave this parameter commented.

DOMAIN The list of DNS domain suffixes to be used to identify connections 
used by this workstation. Use a space to separate entries.

Example: DOMAIN=example.novell.com example.xyz.org

If DHCP is being used, leave this parameter commented.

PROXYADDR The IP address or full DNS name of the imaging (proxy) server to 
connect to when you boot a workstation from the imaging device in 
auto-imaging mode.

Examples:

PROXYADDR=137.65.95.127
PROXYADDR=imaging.xyz.com

This parameter is used to set the PROXYADDR environment 
variable in Linux when the workstation is booted from the imaging 
device. The imaging engine then reads this variable to determine 
which server to contact if it’s running in automatic mode. Whether it’s 
running in automatic or manual mode, the imaging engine attempts 
to log the imaging results to the server specified in this variable.

export PS1="\`pwd \`#" Configures the string used by the bash shell. You can change the 
string by editing the text after the = symbol. The ‘ character is not a 
single quote mark, but is from the ~ key.

export IMGCMD Use IMGCMD to alter the behavior of automated imaging. If this 
variable is defined as a script (or a series of commands), then that 
script (or those commands) are executed instead of the usual img 
auto command (see /bin/imaging.s).

netdevice=eth0 Selects a specific network adapter. If necessary, replace eth0 with 
the correct interface.

Parameter Specifies
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Imaging Bootup Parameters
This section only applies to ZENworks 6.5 Desktop Management SP1 and earlier. Boot parameters 
are not used in ZENworks 6.5 Desktop Management SP2 and later.

ZENworks Imaging, by default, loads PCMCIA, SCSI, and USB drivers. When performing 
imaging work using diskettes, CDs, or DVDs, some computers, particularly laptops, with 
PCMCIA, SCSI, or USB cards can hang during the boot process. While loading these drivers does 
not normally cause problems, you can use command line parameters to prevent these drivers from 
loading. Also, if you have computers that use PCMCIA cards, you can choose to have the 
PCMCIA driver load earlier in the boot process if these computers experience problems loading 
the driver during a normal boot process.

You can use the following parameters at the command prompt:

Imaging Bootup Languages (Zimglang.ini)
IMPORTANT: This section applies only to ZENworks 6.5 SP1 and earlier.

The zimglang.ini file defines the non-English keyboards that are supported for the imaging bootup 
process. You can create language diskettes for each of these languages using the Imaging Boot 
Disk Creator (Zimgboot.exe) utility. You can add support for additional languages to this file as 
explained in Chapter 54, “Setting Up Workstations for Imaging,” on page 629.

Zimglang.ini is located in the zenworks\imaging folder in your ZENworks Desktop Management 
installation (on the Imaging server).

This is a standard Windows .ini format file. Each section of the file defines the keyboard support 
for a single language, including the keyboard mappings, fonts, and Unicode mappings to use. For 
example, the German keyboard is defined like this:

[German]
keymap=keymaps/de.kmap.gz 
Font=consolefonts/iso01.f16.psf.gz
ACM=consoletrans/iso01.acm.gz

You can add support for additional languages to this file as explained in Chapter 54, “Setting Up 
Workstations for Imaging,” on page 629.

Parameter Specifics

PCMCIA Whether to load a PCMCIA device during the boot process.

Example: manual PCMCIA=NO

PCMCIABOOT Whether to load a PCMCIA device earlier during the boot process 
(for example, a PCMCIA CDROM device).

Example: manual PCMCIABOOT=YES

SCSI Whether to load a SCSI device during the boot process.

Example: manual SCSI=NO

USB Whether to load a USB device during the boot process.

Example: manual USB=NO
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Imaging Server (Imgserv.nlm or .dll or .dlm)
The Imaging server is a software component of the Desktop Management server. It enables 
imaging clients (workstations that are booted from an imaging device) to connect with the network 
to receive imaging services, including:

Storage or retrieval of an image on a server

Automatic imaging based on an eDirectory policy or setting

Logging of the results of an imaging operation

A multicast imaging session

The imaging server modules are located on a NetWare server in sys:\system or on a Windows 
server in the folder where eDirectory is installed (such as c:\novell\nds).

In most environments, the Imaging server starts automatically when you reboot the server after 
installing Desktop Management. With eDirectory 8.5 on Windows, you must start the Imaging 
server manually as follows: from the folder where eDirectory is installed, double-click 
ndscons.exe, select the imgsrv.dlm service, then click Start. You might also want to click Startup 
to configure the service to start automatically each time the server reboots.

You can use the following parameters with the Imaging Server:

Use the imaging server for the following:

“Viewing Information About Imaging Requests” on page 703

“Starting a Manual Multicast Session” on page 703

Parameter Description

-i:ip_address Used in a clustering environment to specify the IP address of the virtual server. 
This parameter is automatically set during installation in a clustering 
environment.

You can also use this parameter in a multiple-NIC environment to bind the 
Imaging Server to a specific IP address. 

-s:DN Used in a clustering environment to specify the DN of the virtual server. If the 
DN contains spaces, enclose the DN in quotation marks. This parameter is 
automatically set during installation in a clustering environment.
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Viewing Information About Imaging Requests
After the imaging server has started, you can view information about the status and results of the 
imaging requests that it has received from imaging clients. A statistical summary of these requests 
is shown on the server console (NetWare) or in a window accessible from the taskbar (Windows). 
The statistics shown on this screen are explained below. All statistics are reset to zero if you restart 
the imaging server.

Starting a Manual Multicast Session
On the server console (NetWare) or in a window accessible from the system tray (Windows), you 
can start a manual multicast session, see any sessions in progress, and delete sessions. For more 
information, see “Initiating a Multicast Session from Each Client” on page 669 in Chapter 59, 
“Multicasting Images,” on page 663.

Imaging Server Log (Zimglog.xml)
Zimglog.xml is a chronological record of all the imaging requests that have been received by the 
Imaging server since it was installed and first started, including requests merely to log information 
about imaging operations serviced elsewhere. For each imaging request, the Imaging server logs 
information such as the source, type, date/time, and results of the request.

Zimglog.xml is created on a NetWare server in sys:\system or on a Windows server at the root of 
the drive where eDirectory is installed (such as c:\).

Zimglog.xml is an XML file. The oldest imaging request is logged at the top of the file and the 
most recent at the bottom. The file continues to grow unless you trim it manually (using a text 
editor) or delete it. It isn’t cleared if you restart the imaging server.

Statistic Specifies

Update 
Requests

The number of imaging requests of any kind that have been received by the Imaging 
server since it was started. This includes requests that failed, were denied, or were 
referred to other Imaging servers (see Client Referrals below). Information about 
each of these requests, such as the source, type, date/time, and results, is logged 
on the Imaging server as explained in “Imaging Server Log (Zimglog.xml)” on 
page 703.

Images Sent The number of images that the Imaging server has sent to imaging clients since the 
Imaging server was started. This includes only images that were retrieved from this 
Imaging server. See Client Referrals below for more information.

Images 
Received

The number of new images that have been received and stored on the Imaging 
server since it was started. This includes images that were received through client 
referrals as explained below.

Client Referrals The number of client requests that have been referred (redirected) by the Imaging 
server to other imaging servers since this Imaging server was started. Such referrals 
are made only when the client is running in auto-imaging mode and the Imaging 
server determines from eDirectory that the image to be created or retrieved is on a 
different Imaging server.

IMPORTANT: If a client is running in manual imaging mode and it requests to store 
or retrieve an image on a different Imaging server, the request is denied and an error 
is returned to the client. Referrals are currently supported only when the client is 
running in auto-imaging mode.
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Each imaging operation is entered in the log as a group of lines. For example, the log file shown 
below has two entries: one describing a successful upload operation and another describing a 
failed download operation. (An upload is the taking of a client image and storing it on the Imaging 
server or other available (local) medium. A download is the retrieval of a client image from the 
Imaging server or local medium and putting it down on the client.)

<ZENImageLog>

<CN=CV7PB00:C0:4F:DC:2A:B5.O=sales>
<Tree>XYZ</Tree>
<Status>Success</Status>
<Operation>Upload</Operation>
<ImageType>Base Image</ImageType>
<ImagePath>\\XYZ_SERVER\sys\imgs\dell_nt.zmg</ImagePath>
<Timestamp>Thur Nov 22 13:10:05 2001
</Timestamp>
</CN=CV7PB00:C0:4F:DC:2A:B5.O=sales>

<CN=CV7PB00:C0:4F:DC:2A:B5.O=sales>
<Tree>XYZ</Tree>
<Status>Failure</Status>
<ErrorMessage>Unable to find an image to download</ErrorMessage>
<Operation>Download</Operation>
<Timestamp>Thur Nov 22 13:13:17 2001
</Timestamp>
</CN=CV7PB00:C0:4F:DC:2A:B5.O=sales>

</ZENImageLog>

The table below describes the various XML elements that comprise the log entries shown above. 
Each element has an opening and closing tag, such as <tree> and </tree>. The outermost element 
contains all the other elements in the entry.

XML Element Specifies

Outermost_Container The distinguished eDirectory name of the workstation that requested the 
imaging operation. This name is read by the imaging engine from the 
workstation’s image-safe data. If the workstation name isn’t found (for 
example, if the workstation hasn’t been registered as an object in eDirectory), 
the name of the Imaging server that serviced the request is given instead (for 
example, XYZ_SERVER).

Tree The eDirectory tree containing the workstation or server specified in the 
Outermost_Container element.

Status Whether the requested imaging operation succeeded or failed.

ErrorMessage The reason why the requested imaging operation failed, if applicable.
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Operation Whether the requested imaging operation was an upload or download 
attempt. An upload is the taking of a client image and storing it on the Imaging 
server or other available (local) medium. A download is the retrieval of a 
client image from the Imaging server or local medium and putting it down on 
the client.

NOTE: Occasionally, you might see an entry in the log that omits the 
Operation element. Such an entry is typically a follow-up to the previous 
operation. For example, you might see an entry indicating that a download 
operation was successful, but the next entry (time-stamped a few seconds 
later and specifying no operation) might indicate that the Imaging server 
failed to get image-safe data from eDirectory. In this case you could assume 
that the client that just received the download didn’t have its own image-safe 
data, and so the Imaging server was trying to get that data from eDirectory 
to apply it to the client.

ImageType Whether the image that was created or retrieved is a base image or an add-
on image. With a base image, all existing partitions and data are removed 
before the image is put down. With an add-on image, the existing partitions 
are left intact and are merely augmented with additional data.

ImagePath The full path and filename of the image that was created, retrieved, or 
requested.

Timestamp The time when the results of the requested imaging operation were logged 
by the Imaging server, including the week day, month, date, 24-hour time 
(including seconds), and year.

XML Element Specifies
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61 Imaging Engine (Img: Command Line and Menu)

After booting a workstation from an imaging device, you can use the img command at the Linux 
bash prompt or the ZENworks Imaging Engine menu to do any of the following:

Take an image of the workstation’s hard disks

Put down an image on the workstation’s hard disks

View or manipulate the workstation’s hard-disk partitions

View the workstation’s hardware configuration or image-safe data

Display a menu from which you can also perform all of these tasks

The imaging engine is installed to the \bin folder on the imaging boot device. If the imaging boot 
device is diskettes (SP1 only), a CD, or DVD, the \bin folder is actually archived in the root.tgz 
file, which is expanded during the imaging bootup process. If the imaging boot method is Preboot 
Services, the imaging engine is downloaded to the workstation during bootup.

Because the imaging engine is a Linux application, the command syntax is case-sensitive. The 
overall syntax is:

img [mode]

where mode is any of the modes described in the sections below.
NOTE: Each mode can be abbreviated to the first letter of its name. For example, img dump can be 
abbreviated img d.

“Help Mode (img help)” on page 708

“Auto Mode (img auto)” on page 708

“Make Mode (img make)” on page 709

“Restore Mode (img restore)” on page 711

“Dump Mode (img dump)” on page 716

“Partition Mode (img p)” on page 716

“ZENPartition Mode (img zenPartition)” on page 718

“Information Mode (img info)” on page 718

“Session (Multicast) Mode (img session)” on page 720

To access the ZENworks Imaging Engine menu from which to perform all of these tasks, enter 
img with no parameters. 
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Help Mode (img help)
Use Help mode to get information about the img command if you don’t have this documentation 
available.

To use the Help mode:

1 Enter the following:

img [help [mode]]

where mode is the mode whose command syntax you want help with.

or

Enter img to display the ZENworks Imaging Engine menu, select Help, then select a mode 
name.

Auto Mode (img auto)
Use Auto mode to image the workstation automatically, based on any applicable eDirectoryTM 
policies and settings. The imaging engine runs in this mode if you let the imaging bootup process 
proceed without interruption, or if you type the command below at the Linux prompt.

To use the Auto mode:

1 Enter the following:

img auto

or

Enter img to display the ZENworks Imaging Engine menu, click Imaging, then click Query 
For Work.

In this mode, the imaging engine queries the Imaging server specified in the PROXYADDR 
environment variable for any work to do. The imaging server checks the relevant eDirectory 
policies and settings to determine what imaging tasks should be performed (if any), such as taking 
or putting down an image. It then instructs the imaging engine to perform those tasks. If any tasks 
involve storing or retrieving images on other Imaging servers, the Imaging server refers the 
imaging engine to those servers to complete those tasks. After the imaging engine has completed 
its work, it communicates the results to the original imaging server, and the results are logged on 
that server.

For information on configuring the eDirectory policies and settings that control what happens in 
this mode, see Chapter 55, “Setting Up Imaging Policies,” on page 633.

Example Explanation

img help Displays a short description of each mode.

img help m Displays information on how to use the Make mode.

img help p Displays information on how to use the Partition mode.
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Make Mode (img make)
Use the Make mode to take an image of the workstation and store it in a specified location. 
Normally, all partitions on hard disks and other storage devices (such as Jaz drives) are included 
in the image, but there are some exceptions noted below.

You can take an image of a workstation using either the bash prompt or using the ZENworks 
Imaging Engine menu. For step-by-step instructions, see “Manually Taking an Image of a 
Workstation” on page 647. You can also use the Make Locally mode to take an image of the 
workstation and store it in a partition on a local (writable) device, such as a hard disk or Jaz drive. 
For step-by-step instructions, see Chapter 58, “Setting Up Disconnected Imaging Operations,” on 
page 655.

The image size corresponds roughly to the size of the data in the Windows partitions plus the entire 
size of any non-Windows partitions (such as NetWare® partitions). ZENworks® Linux partitions 
and Compaq configuration partitions are always excluded. The data from Windows partitions is 
stored in an intelligent, file-by-file format so you can customize it later using the Image Explorer 
(imgexp.exe) utility. Non-Windows partitions are stored in a raw, bit-by-bit format that cannot be 
customized. 

The syntax of this mode depends on whether you will store the image locally or on an Imaging 
(proxy) server.

The following sections contain additional information:

“Make Locally (img makel)” on page 709

“Make on Proxy (img makep)” on page 710

Make Locally (img makel)
Using the bash prompt, the following example explains the syntax and available parameters that 
you can use with the makel “make locally” parameter:

img makel[pNumber] filepath [comp=comp level] [xpartition]

Parameter Specifies

makel[pNumber] The partition number (as displayed by img dump) of the local partition to store 
the image in. It must be a primary FAT16 or FAT32 partition. This partition is 
excluded from the image that’s created.

If you omit the partition number from this parameter, the image is stored in the 
local Desktop Management imaging partition.

filepath The image filename, including a .zmg extension (case-sensitive) and the 
complete path from the root of the partition. The directories in the path must 
exist. If the file already exists, it will be overwritten.

[comp=comp level] comp level is the amount of compression used when creating the image. 
Specify any number from 0-9. 0 means no compression. 1 is the same as 
Optimize for Speed. 6 is the same as Balanced and is used by default if you do 
not specify this parameter. 9 is the same as Optimize for Space.
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Make on Proxy (img makep)
Using the bash prompt, the following example explains the syntax and available parameters that 
you can use with the makep “make on proxy” parameter:

img makep address filepath [comp=comp level] [xpartition]

xpartition The partition number (as displayed by img dump) of a local partition to exclude 
from the image. You can repeat this parameter as needed to exclude multiple 
partitions.

If you omit this parameter, all partitions are included in the image except the 
one where the image will be stored.

Example Explanation

img makel8 /imgs/
dellnt.zmg

Takes an image of all partitions except the one in slot 8 and saves the 
image to imgs/dellnt.zmg in the partition in slot 8. (Assumes slot 8 
contains a primary FAT16 or FAT32 partition.)

img makel /imgs/dellnt.zmg Takes an image of all partitions and saves it to imgs/dellnt.zmg in the 
ZENworks Desktop Management imaging partition. (Assumes the 
Desktop Management imaging partition has been installed.)

img makel /imgs/dellnt.zmg 
x2 x3

Takes an image of all partitions except those in slots 2 and 3 and saves 
the image to imgs/dellnt.zmg in the Desktop Management imaging 
partition. (Assumes the Desktop Management imaging partition has 
been installed.)

Parameter Specifies

address The IP address or DNS name of an imaging server where the image will be 
stored. This can be any server running the Imaging Proxy service.

filepath The UNC path to the new image file being created, including the image 
filename and the .zmg extension (case-sensitive). The format of the UNC path 
is as follows:

//servername/volume_or_share/path_to_store_images/imagename.zmg

Upon execution of img makep at the cmd line, the servername portion of this 
path is replaced with the value in the address portion of this syntax.

The directories in the path must exist. If the file already exists; the imaging 
server won’t overwrite it unless you enable this behavior in the imaging server’s 
policy in eDirectory. (See “Allowing Overwriting Filenames and Restricting 
Save Location of Image Files (Imaging Server Settings)” on page 637.) If no 
folders are specified in the path, the image is created at the root of the volume 
or drive where the ZENworks Desktop Management Workstation Imaging 
server software is installed.

IMPORTANT: Because Linux does not recognize backslashes, you must use 
forward slashes in the UNC path or enclose the entire path in quotes.

Parameter Specifies
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Restore Mode (img restore)
Use the Restore mode to retrieve an image from a specified location and put it down on a 
workstation.

You can restore an image of a workstation using either the bash prompt or using the ZENworks 
Imaging Engine menu. For step-by-step instructions, see “Manually Putting an Image on a 
Workstation” on page 651. You can also use the Restore mode to restore an image from a partition 
on a local (writable) device, such as a hard disk or Jaz drive. For step-by-step instructions, see 
Chapter 58, “Setting Up Disconnected Imaging Operations,” on page 655.

Normally, if the image to be put down is a base image (one created previously by the imaging 
engine), all existing partitions except ZENworks Linux and Compaq configuration partitions are 
removed from all local writable devices (such as hard disks and Jaz drives) before the new image 
is put down. When the image is put down, the sizes of the original partitions from which the image 
was taken are preserved if possible. If there’s insufficient space, the last partition is shrunk to fit 
unless this would result in data loss, in which case the imaging engine denies the requested 
operation. If there’s extra space left after all partitions in the image have been restored to their 
original sizes, that space is left unpartitioned.

If the image to be put down is an add-on image (one produced from an Application object or 
created by the Image Explorer (imgexp.exe) utility), or if it’s a base image and you specify the 

[comp=comp level] comp level is the amount of compression used when creating the image. 
Specify any number from 0-9. 0 means no compression. 1 is the same as 
Optimize for Speed. 6 is the same as Balanced and is used by default if you do 
not specify this parameter. 9 is the same as Optimize for Space.

xpartition The partition number (as displayed by img dump) of a local partition to exclude 
from the image. You can repeat this parameter as needed to exclude multiple 
partitions.

If you omit this parameter, all partitions are included in the image.

Example Explanation

img makep 137.65.95.127 //
xyz_server/sys/imgs/dellnt.zmg

Takes an image of all partitions and saves it to sys/
imgs/dellnt.zmg on xyz_server. (Assumes 
137.65.95.127 is the IP address of xyz_server.)

img makep img.xyz.com //xyz_server/
sys/imgs/dellnt.zmg x2 x3

Takes an image of all partitions except those in slots 2 
and 3 and saves the image to sys/imgs/dellnt.zmg on 
xyz_server. (Assumes img.xyz.com is the DNS name 
of xyz_server.)

img makep img.xyz.com //bogus/sys/
imgs/dellnt.zmg

Takes an image of all partitions and saves the image 
to sys/imgs/dellnt.zmg on img.xyz.com. (Assumes 
img.xyz.com is the DNS name of a server running the 
Imaging Proxy service).

Because the servername inside the UNC path is 
replaced by the address value defined earlier in the 
cmd line, //bogus would become //img.xyz.com

Parameter Specifies
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apartition:ppartition parameter, none of the existing physical partitions are removed. Instead, the 
appropriate partitions are merely updated with the files from the image. The update process does 
not remove any existing files or overwrite any existing files of the same names if they are newer.

Restoring add-on images over 4 GB in size is not supported by Desktop Management Workstation 
Imaging.

The syntax of this mode depends on whether you will retrieve the image from a local device or 
from an Imaging (proxy) server, as explained in the subsections below:

“Restore from Local (img restorel)” on page 712

“Restore from Proxy (img restorep)” on page 714

Restore from Local (img restorel)
Use the Restore from Local mode to retrieve an image from a local device and put it down on the 
workstation. For more information, see Chapter 58, “Setting Up Disconnected Imaging 
Operations,” on page 655.

Using the bash prompt, the following example explains the syntax and available parameters that 
you can use with the restorel “restore from local” parameter:

img restorel[pNumber] filepath [sfileset] [apartition:ppartition]

Parameter Specifies

restorel[pNumber] The partition number (as displayed by img dump) of the local partition to 
retrieve the image from. It must be a primary FAT16 or FAT32 partition. This 
partition will not be changed by the imaging operation.

If you omit the partition number from this parameter, the image is retrieved from 
the local Desktop Management imaging partition.

filepath The filename of the image to retrieve, including the .zmg extension (case-
sensitive) and the complete path from the root of the partition.

sfileset The number of the image fileset (variant) to put down. Valid values are 1 
through 10. For information on creating variants of an image, see Chapter 56, 
“Creating and Restoring Images,” on page 639.

If you omit this parameter, fileset 1 is used.
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apartition:ppartition A mapping between a partition in the image archive (apartition) and a target 
physical partition on the local machine (ppartition). Use this parameter to 
selectively restore a specific part of the image to a specific local partition. 

IMPORTANT: If you use this parameter, none of the existing local partitions 
are removed, and only the target local partition is updated. The update process 
does not remove any existing files; however, any existing files of the same 
names are overwritten. If you want to remove all existing files from the target 
partition before updating it, first use img pd and img pc to delete and recreate 
the partition.

For apartition, use the partition number displayed for the source partition in the 
Image Explorer (imgexp.exe) utility. For ppartition, use the partition number 
displayed by img dump for the target partition. The target partition must be a 
Windows partition. You can repeat this parameter as needed to request multiple 
selective restorations in a single operation. In doing so, you can apply multiple 
parts of the image to a single local partition, but you can’t apply the same part 
of an image to multiple local partitions in a single operation.

Example Explanation

img restorel8 /imgs/dellnt.zmg Removes all existing local partitions except the one in 
slot 8, retrieves the image from imgs/dellnt.zmg in slot 8, 
and puts down the partitions and contents of that image 
on the available local writable devices. (Assumes there’s 
sufficient local space and that slot 8 contains a primary 
FAT16 or FAT32 partition.)

img restorel /imgs/dellnt.zmg Removes all existing local partitions, retrieves the image 
from imgs/dellnt.zmg in the Desktop Management 
imaging partition, and puts down the partitions and 
contents of that image on the available local writable 
devices (assuming there’s sufficient space).

img restorel /imgs/dellnt.zmg s2 Removes all existing local partitions, retrieves the image 
from imgs/dellnt.zmg in the Desktop Management 
imaging partition, and puts down the partitions and 
contents of variant 2 of that image on the available local 
writable devices (assuming there’s sufficient space).

img restorel /imgs/dellnt.zmg 
a2:p1 a3:p1

Retrieves the image from imgs/dellnt.zmg in the Desktop 
Management imaging partition, updates local partition 1 
with the data from partitions 2 and 3 of that image, and 
leaves the other local partitions unchanged. (Assumes 
there’s sufficient space in local partition 1.)

Parameter Specifies
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Restore from Proxy (img restorep)
Use the Restore from Proxy mode to retrieve an image from an Imaging (proxy) server and put it 
down on the workstation. For more information, see “Manually Putting an Image on a 
Workstation” on page 651.

Using the bash prompt, the following example explains the syntax and available parameters that 
you can use with the restorep “restore from proxy” parameter:

img restorep address filepath [sfileset] [apartition:ppartition]

Parameter Specifies

address The IP address or DNS name of the Imaging server to retrieve the image from. 
This can be any server running the Imaging Proxy service.

filepath The UNC path to the image file to retrieve, including the image filename and 
the .zmg extension (case-sensitive). The format of the UNC path is as follows:

//servername/volume_or_share/path_to_stored_images/imagename.zmg

Upon execution of img restorep at the cmd line, the servername portion of 
this path is replaced with the value in the address portion of this syntax.

IMPORTANT: Because Linux doesn’t recognize backslashes, you must use 
forward slashes in the UNC path or enclose the entire path in quotes.

sfileset The number of the image fileset (variant) to put down. Valid values are 1 
through 10. For information on creating variants of an image, see Chapter 56, 
“Creating and Restoring Images,” on page 639.

If you omit this parameter, fileset 1 is used.

apartition:ppartition A mapping between a partition in the image archive (apartition) and a target 
physical partition on the local machine (ppartition). Use this parameter to 
selectively restore a specific part of the image to a specific local partition. 

IMPORTANT: If you use this parameter, none of the existing local partitions 
are removed, and only the target local partition is updated. The update process 
does not remove any existing files or overwrite any existing files of the same 
names if they are newer. If you want to remove all existing files from the target 
partition before updating it, first use the Partition Mode (img p) to delete and 
recreate the partition.

For apartition, use the partition number displayed for the source partition in the 
Image Explorer (imgexp.exe) utility. For ppartition, use the partition number 
displayed by img dump for the target partition. The target partition must be a 
Windows partition. You can repeat this parameter as needed to request multiple 
selective restorations in a single operation. In doing so, you can apply multiple 
parts of the image to a single local partition, but you can’t apply the same part 
of an image to multiple local partitions in a single operation.
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Example Explanation

img restorep 137.65.95.127 //xyz_server/
sys/imgs/dellnt.zmg

Removes all existing local partitions, retrieves 
the image from sys/imgs/dellnt.zmg on 
xyz_server, and puts down the partitions and 
contents of that image on the available local 
writable devices. (Assumes there’s sufficient 
local space and that 137.65.95.127 is the IP 
address of xyz_server.)

img restorep img.xyz.com //xyz_server/
sys/imgs/dellnt.zmg s2

Removes all existing local partitions, retrieves 
the image from sys/imgs/dellnt.zmg on 
xyz_server, and puts down the partitions and 
contents of variant 2 of that image on the 
available local writable devices. (Assumes 
there’s sufficient local space and that 
img.xyz.com is the DNS name of xyz_server.)

img restorep img.xyz.com //xyz_server/
sys/imgs/dellnt.zmg a2:p1

Retrieves the image from sys/imgs/dellnt.zmg 
on xyz_server, updates local partition 1 with the 
data from partition 2 of that image, and leaves 
the other local partitions unchanged. (Assumes 
there’s sufficient space in local partition 1 and 
that img.xyz.com is the DNS name of 
xyz_server.)

img restorep img.xyz.com //bogus/sys/
imgs/dellnt.zmg

Removes all existing local partitions, retrieves 
the image from sys/imgs/dellnt.zmg on 
img.xyz.com, and puts down the partitions and 
contents of that image on the available local 
writable devices. (Assumes there is sufficient 
local space, and that img.xyz.com is the DNS 
name of a server running the Imaging Proxy).

Because the servername inside the UNC path 
is replaced by the address value defined earlier 
in the cmd line, //bogus becomes 
//img.xyz.com
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Dump Mode (img dump)
Use the Dump mode to view information about the storage devices and partitions on the 
workstation.

To use the Dump mode:

1 Enter the following:

img dump [geo]

or

Enter img to display the ZENworks Imaging Engine menu, click System Information, then 
click Drive Information.

Partition Mode (img p)
Use the Partition mode to activate (make bootable), add, or delete a partition on the workstation.

You can activate, add, or delete a partition using either ZENworks Imaging Engine menu or the 
bash prompt. 

To use the Partition mode using the ZENworks Imaging Engine menu:

1 Enter img to display the ZENworks Imaging Engine menu, then click Partitioning.

2  Click Modify Partitions, then click an option.

Active: Select a partition that you want to activate (make bootable), then click Active.

Add: Opens the Create New Partition window. Click a partition type, partition size, and 
cluster size, then click OK.

Delete: Select a partition, then click Delete.

See the table below for more information.

Parameter Specifies to

dump List the existing partitions on all local writable devices, such as hard disks and Jaz 
drives. For each partition, the type, size, and slot number of the partition are given.

NOTE: ZENworks Linux and Compaq configuration partitions are not listed.

geo Display additional information about the geometry (cylinders, heads, and sectors) 
and capacity of each storage device, including read-only devices such as CD drives.

Example Explanation

img dump Lists the current partitions on all local writable devices.

img dump geo Lists all storage devices, their geometry and capacity, and the current partitions 
on the writable devices.
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To use the Partition mode using the bash prompt:

1 From the bash prompt, enter:

img poperation

where operation is one of the following:

Operation Specifies to

pcpNumber type 
[size] 
[cluster=clusterSiz
e]

Create a new partition, where:

pNumber is the number of the partition slot (as displayed by img dump) 
in which to create the partition

type is a keyword, FAT12, FAT16, FAT32, NTFS, or Extended, or a 
numerical value for the partition type, for example 0x0C (hexadecimal) 
or 11 (decimal)

If you are creating an extended partition, you can create a logical drive 
inside of the extended partition. See the next table for an example.

size is a valid size for the partition type in MB

If you omit this parameter, the largest valid size for the partition type is 
used, given the available unpartitioned space on the drive.

clusterSize is the cluster size for an NTFS partition. This parameter is 
not valid for any other partition type.

Don’t use this parameter unless you have a specific reason to do so. It 
must be a power of 2 (2, 4, 8, 16, ...128). If you omit this parameter, the 
imaging engine uses a reasonable cluster size for the NTFS partition 
size.

The new partition is recognizable by other operating systems, but must be 
formatted or have a base image restored to it before you can store files in 
it.

pdpNumber Delete the partition from slot number pNumber. Use img dump to get the 
slot number.

papNumber Activate (make bootable) the partition in slot number pNumber. Use img 
dump to get the slot number.

Example Explanation

img pc1 fat16 Creates a FAT16 partition in slot 1 using all the available unpartitioned 
space on the drive.

img pc5 fat32 
5671

Creates a FAT32 partition in slot 5 using 5,671 MB on the drive.

img pd3 Deletes the partition from slot 3.

img pa5 Activates (makes bootable) the partition in slot 5. (Assumes a partition 
exists in that slot.)
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ZENPartition Mode (img zenPartition)
Use the ZENPartition mode to enable, disable, or remove the installed ZENworks Workstation 
Imaging (Linux) partition. 

To use the ZENPartition mode:

1 Enter img to display the ZENworks Imaging Engine menu, click Partitioning, then click 
Disable ZEN Partition, Enable ZEN Partition, or Remove ZEN Partition.

or

From the bash prompt, enter the following:

img zenPartition operation

where operation is enable, disable, or remove.

2 Enter lilo.s to make this change effective.
IMPORTANT: If you remove an installed Desktop Management imaging partition, you must immediately 
restore a base image with a valid non-LILO MBR (Master Boot Record). If you do not, the workstation will not 
be able to boot properly.

Information Mode (img info)
Use the Information mode to view the following:

The data currently stored in the image-safe area on the workstation

This data is saved by the Imaging Agent during each Windows session to ensure that it can be 
restored after the workstation is reimaged. If the workstation is new and doesn’t have 
Windows yet, an initial set of data is supplied from an eDirectory policy via the Imaging 
server to the imaging engine when the first base Windows image is put down. (For more 
information, see “Defining an Imaging Policy for Unregistered Workstations (Server Policy)” 
on page 633.)

Information about the hardware devices on the workstation

This information is detected during the imaging bootup process. If the imaging engine runs in 
auto-imaging mode, this information is sent to the imaging server to help determine which 
image to put on the workstation, if necessary.

Name of the base image that was last put down on the workstation

img pc2 
extended 2500

img pc2 NTFS 
2000 cluster=1

img pc2 fat16 
500

Creates an extended partition with a 2000 NTFS logical drive and a 500 
MB FAT16 logical drive.

Example Explanation
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To use the Information mode:

1 Enter img to display the ZENworks Imaging Engine menu, click System Information, then 
click Image-Safe Data or Detected Hardware. See the table below for details.

or

Enter the following from the bash prompt:

img info [zisd]

Menu item or 
parameter

Specifies to

System Information 
> Detected 
Hardware

or

info from the bash 
prompt

List the detected hardware devices on the workstation, including:

CPU chipset

BIOS asset tag

BIOS serial number

Video adapter

Network adapter

MAC address

Sound card

Hard drive controller

Hard disk capacity

Detected RAM

Boot media

System Information 
> Image Safe Data

or

zisd from the bash 
prompt

List the data currently stored in the image-safe area on the workstation. The 
items that comprise this data are listed in “ZENworks Imaging Windows Agent 
(Ziswin.exe)” on page 678.

In addition to the image-safe data, the last base image that was put down on the 
workstation is also listed.

Example Explanation

img info Lists the detected hardware devices on the workstation.

img info 
zisd

Lists the Desktop Management image-safe data currently stored on the workstation 
and the last base image that was put down.
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Session (Multicast) Mode (img session)
Use the Session (Multicast) mode to take an image of one workstation and put it down on multiple 
other workstations simultaneously over the network in a single operation.

For step-by-step instructions of the different ways you can perform multicast sessions, see the 
following sections:

“Initiating an Automatic Multicast Session in ConsoleOne” on page 664

“Using the Bash Prompt to Perform the Multicast Session” on page 670

“Using the ZENworks Imaging Engine Menu to Perform the Multicast Session” on page 671

For multicasting to work, each participating workstation must boot from an imaging device and 
run the imaging engine in this mode, as explained below. The workstation from which the image 
is taken is called the master, and the workstations that receive the image are called participants. 
Starting in ZENworks for Desktops 4, you can start the multicast session from the Imaging server. 
If you start the session this way, you specify an image file for multicasting rather than a 
workstation as the session master.
NOTE: For multicasting to work properly, the routers and switches on the network must have multicast 
features configured. Otherwise, multicast packets might not be routed properly.

Using the bash prompt, the following example explains the syntax and available parameters that 
you can use with the session parameter:

img session name [master|client] [clients=count [t=minutes]]

Parameter Specifies

name The name of the multicast session. Each workstation joining the session uses the 
same value for this parameter.

NOTE: The name must be unique among concurrent multicast sessions. It is 
hashed by the imaging engine to produce a Class D IP address for the multicast 
session. To facilitate troubleshooting (wire sniffing), all Desktop Management 
Workstation Imaging multicast addresses start with 231. For example, the session 
name doug produces the multicast address 231.139.79.72.

master|client That this workstation is the session master or a session client.

If you omit this parameter, the imaging engine waits for a user on one of the 
workstations to press m to designate that workstation as the master, or for the 
imaging session to be started from the imaging server by selecting Manually Start 
Multicast, providing the required information, then selecting Yes.

clients=count The number of participating workstations that must register with the master before 
imaging will begin. The option only applies for session masters.

If you omit this parameter, the imaging engine waits for the master user to press g. 
After imaging has begun, any participating workstations attempting to register are 
denied.

time=minutes The number of minutes the master workstation waits for the next participant to 
register before starting the imaging process without reaching count registered 
participants. The option only applies for session masters.

If you omit this parameter, the imaging process won’t start until count is reached or 
the master user presses g. After that, any participants attempting to register are 
denied.
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Example Explanation

img session doug Starts a multicast session named doug. Each successive workstation that 
issues this same command before the imaging begins joins the session. 
Imaging doesn’t start until one of the users presses m to designate himself as 
master and presses g to start the imaging, or the imaging session is started 
from the Imaging server by selecting Manually Start Multicast, providing the 
required information, then selecting Yes.

img session doug 
m

Starts a multicast session named doug and designates this workstation as the 
master. Each successive workstation that issues img session doug before 
the imaging begins joins the session as a participant. Imaging doesn’t start until 
the master user presses g.

img session doug 
master clients=5

Starts a multicast session named doug. Each successive workstation that 
issues img session doug before the imaging begins joins the session. Imaging 
doesn’t start until one of the users presses m to designate himself as master, 
or until the imaging session is started from the Imaging server by selecting 
Manually Start Multicast, providing the required information, then selecting Yes. 
Five other workstations must also register as participants before the session 
begins.

img session doug 
master clients=5 
time=20

Starts a multicast session named doug. Each successive workstation that 
issues img session doug before the imaging begins joins the session. Imaging 
doesn’t start until one of the users presses m to designate himself as master, 
or until the imaging session is started from the Imaging server by selecting 
Manually Start Multicast, providing the required information, then selecting Yes. 
Either five other workstations must register as participants or more than 20 
minutes must elapse between any consecutive participant registrations, 
whichever occurs first, and then the session will begin.
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62 Adding Linux Drivers in ZENworks 6.5 SP2

Beginning with Novell® ZENworks® 6.5 Support Pack 2 (SP2), a new method for adding Linux 
drivers into ZENworks image resource files is introduced.

The following sections provide concepts and instructions for adding Linux drivers into an image 
resource file:

“The New Linux Distribution for Imaging” on page 723

“Understanding Device Boot Processes in a ZENworks Imaging Environment” on page 724

“Understanding ZENworks Partitions and Command Line Parameters” on page 725

“Modifying ZENworks Imaging Resource Files” on page 727

“Adding or Updating LAN Drivers” on page 729

“Using Uname” on page 731

“Variables and Parameters” on page 732

“Troubleshooting Linux Driver Problems” on page 733

The New Linux Distribution for Imaging
ZENworks Imaging uses a small Linux distribution on the client device to perform imaging 
operations. The distribution shipping with ZENworks 6.5 SP2 is based on the SUSE® installation 
system, where SUSE Linux or SUSE Linux Enterprise Server (SLES) boot to a small distribution 
to perform a YaST installation. ZENworks Imaging uses the same installation system found in 
SLES, but instead of starting a YaST installation, it starts a ZENworks Imaging session.

In ZENworks 6.5 SP1 and earlier, Linux kernel 2.4.x is used in the customized distribution; in 
ZENworks 6.5 SP2 the kernel is updated to 2.6 and is a SLES-based distribution.

Using a stable Linux distribution based on SLES gives customers a distribution with the broadest 
range of stable drivers available. The hardware industry is continually introducing new and 
updated network and disk drivers, so it’s not always possible to provide the latest drivers in its 
software releases.

This section covers how to update Linux drivers using the new distribution. It deals with the 
Imaging resource files that are based on the SLES distribution and ZENworks Preboot Services 
processing.
Adding Linux Drivers in ZENworks 6.5 SP2 723



    Novell Confidential                                                                                            Manual (99a)  21 December 2004
Understanding Device Boot Processes in a ZENworks Imaging 
Environment

The following provides a high-level overview of a Linux boot process and how ZENworks 6.5 SP2 
imaging affects it:

1. A boot loader program loads the Linux kernel and initrd (initial RAM drive) into memory.

The SLES-based imaging distribution uses isolinux as the boot loader for imaging CDs, or 
linld.com when using PXE or a single diskette with the CD. If you have a ZENworks partition 
installed, it uses the lilo program to boot alternately between the ZENworks partition and the 
installed operating system.

The following provides the current paths and filenames and a historical comparison:

2. The Linux kernel starts running, does some device driver setup, then mounts the initrd file 
system.

Regardless of which boot loader method is used, the main purpose is to set up the initrd file 
as a RAM drive, load the Linux kernel into memory, then turn control over to it with an 
indication to the Linux kernel of where to find initrd.

3. The Linux kernel turns control over to linuxrc for performing initial hardware detection. 
When finished, control is returned to the Linux kernel.

Historical Note: ZENworks 6.5 SP1 and earlier imaging contains a linuxrc script file that 
performs some initial setup, but not the hardware detection.

4. The Linux kernel starts a background process (/sbin/init).

After control is passed to the /linuxrc program, control is never returned to the Linux kernel 
or passed on to the init process.

Historical Note: ZENworks 6.5 SP1 and earlier use the init process to perform the imaging. 
All ZENworks imaging processing is performed within the linuxrc process. For this reason, 
some of the standard processes you are familiar with do not work or exist in ZENworks 
imaging beginning with SP2.

Files ZENworks 6.5 SP1 and Earlier ZENworks 6.5 SP2

Preboot loader Does the following for all methods:

Loads DOS

Uses loadlin

Uses isolinux when booting from a 
CD; otherwise, uses linld.com.

Linux kernel name Uses kernel when booting from a CD.

Uses linux.1 when booting from PXE.

Uses kernel.zen when booting from a 
diskette.

For CD, uses \boot\loader\linux.

For PXE, uses \tftp\boot\linux.

initrd filename For CD, uses initrd.gz.

For PXE, uses linux.2.

For diskettes, uses initrd on the 
second boot diskette.

For CD, uses \boot\loader\initrd.

For PXE, uses \tftp\boot\initrd.
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For example, the halt and reboot commands are different. In a fully-installed Linux system, 
reboot actually performs an init 6 call. Because init is not running during the SP2 imaging 
process, an init 6 call cannot be made. Therfore, reboot has been aliased to reboot -r, which 
forces a reboot without trying to call init.

Most other commands do run from the bash prompt, because bash is running.

For more information on linuxrc and zenworks.s, review the following sections:

“linuxrc” on page 725

“zenworks.s” on page 725

linuxrc
When control is turned over to linuxrc, there are several processes it performs to get the system 
ready for the imaging process. Linuxrc is initially configured from the /linuxrc.config file, which 
is located in the initrd file system. Additional configuration information for linuxrc can be placed 
in the /info file (located in the initrd file system), but ZENworks does not normally use this 
information.

Linuxrc also loads a root file system, which is combined with the initrd file system that is set up 
by the boot loader. The root file system is located on an imaging CD as the file \boot\root. For PXE 
booting, the root file system is stored on the ZENworks imaging server as \tftp\boot\root.

Linuxrc attempts to locate and load the settings.txt file, either on the root of the imaging CD, or on 
the ZENworks imaging server in the \tftp directory. From settings.txt, linuxrc reads and processes 
any parameters that pertain to itself, then copies settings.txt to the root (/) of the file system.

zenworks.s
A normal SUSE installation for SUSE Linux or SLES boots to a small distribution to perform a 
YaST installation. ZENworks Imaging boots with the same installation system, but instead of 
starting a YaST installation, it starts the ZENworks Imaging process. Control is turned over to the 
ZENworks script /bin/zenworks.s, which is the main script file for ZENworks imaging processing. 
The script performs a certain number of setup tasks, then gives control to the appropriate script for 
the selected imaging process. For more information on the imaging process, see “Understanding 
Desktop Management Preboot Services” on page 591.

One of the setup tasks is to apply any update files. When booting from a CD, zenworks.s copies 
the /addfiles directory structure to the Linux file system. For more information, see “Adding Files 
to an Imaging Boot CD” on page 727.

Understanding ZENworks Partitions and Command Line 
Parameters

The following sections provide an understanding of the ZENworks partition and imaging 
commands that are used when updating Linux drivers:

“The ZENworks Partition” on page 726

“Command Line Parameters and Variables” on page 726
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The ZENworks Partition
To provide additional imaging functionality, ZENworks has changed the way it uses the 
ZENworks partition. Beginning with ZENworks 6.5 SP2, the partition is no longer mounted as the 
root file system and has a minimum size of 150 MB. In ZENworks 6.5 SP1 and earlier, the partition 
is mounted and used as the Linux root file system with a minimum size of 100 MB.

In ZENworks 6.5 SP2 and later, the ZENworks partition is used to store the files required to load 
Linux into RAM, making the result similar to using a CD or PXE boot method. The ZENworks 
partition has a similar boot media layout as an imaging CD.

The files stored on the ZENworks partition are /boot/loader/linux, /boot/loader/initrd, and /boot/
root, which are the same directories as on the imaging CD. In ZENworks 6.5 SP2 and later, the 
boot loader continues to be lilo, which loads Linux as described under “Understanding Device 
Boot Processes in a ZENworks Imaging Environment” on page 724. The settings.txt file is 
searched for and loaded from the ZENworks partition.

If you need to modify the Linux files, you must modify the initrd or root file sets the same way as 
you would for other boot methods. For information, see “Adding Files to the Initrd or Root File 
Systems” on page 728.

Command Line Parameters and Variables
There are four types of command line parameters that can be used with the ZENworks imaging 
process. They are entered manually on the command line when booting from a CD.

Kernel parameters: The valid parameters for the Linux kernel are found in the /
Documentation/kernel-parameters.txt file that is installed with the kernel source.

Some devices have a faulty BIOS, where you must turn off ACPI processing for the kernel to 
load properly. To do this, use the kernel parameter acpi=off. For more information, see Novell 
Support (http://support.novell.com/techcenter/search/Docs/SuSE/SuSE_SDB/en/2002/10/
81_acpi.html).

Linuxrc parameters: These parameters affect the way linuxrc detects hardware or sets 
hardware settings. They are described briefly in the /usr/share/doc/packages/linuxrc/
linuxrc.html file in a Linux system.

Linuxrc parameters can be found in the /info file that resides in the initrd file system. Some 
parameters can be placed in the settings.txt file that is located on the root of the imaging CD 
or ZENworks partition, or in the \tftp\boot file for PXE booting.

Parameters that can be placed in the settings.txt file (the easiest file to edit) are limited. During 
PXE booting, parameters that affect the network are not processed from settings.txt, because 
by the time linuxrc loads the settings.txt file, the network is already set up. Network settings 
can be placed in the settings.txt file when booting from an imaging CD, because it is loaded 
early enough in the process to take effect.

ZENworks variables: Some environment variables affect the way imaging performs. They 
can be configured in any file, but should normally be configured in the settings.txt file.

If you add variables to the settings.txt file that were not originally defined there, you must 
export the variable. For example, in the settings.txt file, enter:

export IMGCMD=”myscript”

A list of all image engine or script variables is listed under “Variables and Parameters” on 
page 732.
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Other variables: Environment variables that you might want in your script can be added in 
the same manner as described for the ZENworks variables.

Modifying ZENworks Imaging Resource Files
From time to time you might want to modify an imaging distribution by adding your own files. 
These can be additional programs, scripts, data files, or updated Linux drivers.

You can use the following methods to update imaging resource files:

The easiest method is to edit the settings.txt file, which is located on the root of the imaging 
CD or in \tftp\boot on the ZENworks imaging server for PXE booting.

Where you are using a ZENworks partition, you can boot to the manual or maintenance mode, 
mount the ZENworks partition, then copy the modified settings.txt and the initrd or root files 
to the mounted ZENworks partition.

You can modify files in the initrd or root file systems, but you need a Linux environment for 
performing the modification process. Files required during the initial setup (during linuxrc 
processing time), such as LAN drivers, must be placed in the initrd file system. Other files that 
are not needed until the zenworks.s script file takes control can be placed in the root file 
system (for example, an imaging script).

This method is discussed in this section.

The following sections provide various methods for modifying imaging resource files in the initrd 
or root file systems:

“Adding Files to an Imaging Boot CD” on page 727

“Adding Files to the Initrd or Root File Systems” on page 728

Adding Files to an Imaging Boot CD
If you have files to add to an imaging boot CD so they can be available for use when you get to 
the actual imaging process (such as scripts, but normally not driver modules), you can copy the 
files to the /addfiles directory on the imaging CD. This is an easy way to insert your script or other 
files into the distribution without modifying the initrd or root file systems. However, these files are 
not available during the boot and module loading phases.

The imaging boot CD has a directory named /addfiles where you can add files. They should be 
placed below this directory in their proper directory names. They are then available in this 
directory structure during the imaging process.

An example of how you can add files:

1 If you want to execute your own script instead of the normal imaging process, create a script 
file named myscript.s and place it on the boot CD. For example, /addfiles/bin/myscript.s.
IMPORTANT: The script file must have proper LF line terminators that Linux requires, not the DOS CR 
and LF end-of-line characters. In other words, you cannot use Notepad.exe to create the script; you must 
use a text editor compatible with Linux or UNIX, such as TextPad.

2 To place the following line in the settings.txt file, enter:

export IMGCMD=/bin/myscript.s

When imaging is run, it runs /bin/myscript.s instead of using the normal img auto command.
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Adding Files to the Initrd or Root File Systems
This is the preferred method for updating imaging resource files, and must be performed in a Linux 
environment.

Before performing the procedure given below, make sure you have created backup copies of any 
files you plan to change. If you want to change the files on an imaging CD, you need an ISO editor 
or some other process for extracting and replacing the file in the bootcd.iso image file.
IMPORTANT: When updating or adding files and Linux drivers in the initrd or root file systems, document the 
changes you make. When you receive updated resource files from Novell, they do not contain your customized 
changes. If the kernel version has changed with the newer resource files from Novell, previously added drivers 
must be updated either by obtaining a new version from the manufacturer or recompiling the driver using the 
correct Linux kernel version source.

You can use the following procedure for the root file system by simply replacing “initrd” with 
“root” in the steps. However, Linux drivers should always be placed in the initrd file system, not 
the root file system.

To modify the initrd or root file system:

1 Using a Linux machine, create a working directory and change to that directory.

2 To copy initrd from the PXE server or the boot CD to the new working directory:

For PXE, copy \tftp\boot\initrd to the Linux workstation’s working directory.

For the CD, extract initrd from the \boot\loader directory on the boot CD, then copy the 
extracted initrd to the Linux workstation’s working directory.

3 To rename initrd to initrd.gz, enter:

mv initrd initrd.gz

4 To unzip the initrd.gz file, enter:

gunzip initrd.gz

5 To create another working directory for use as a mount point in the subsequent steps, enter:

mkdir work

6 To mount the initrd file system to the /work directory, enter:

mount -o loop initrd work

7 To copy your files or updated driver to the mounted initrd file system, enter:

cp /your_path/module.ko work/lib/modules/2.6.5-override-default/
initrd

where your_path is the path to the module.ko file and module is the name of the module.

Other files to be included in the initrd file system should be copied to the appropriate 
directory.

8 To unmount the initrd file system, enter:

umount work

9 To zip the new initrd file, enter:

gzip -v9c initrd > initrd.gz

10 To rename initrd.gz back to initrd, enter:

mv initrd.gz initrd
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11 To copy the file back:

For PXE, copy the updated initrd to the \tftp\boot directory on the PXE server.

For the CD, copy the updated initrd to the \boot\loader directory on the boot CD.

Adding or Updating LAN Drivers
As LAN card manufacturers develop and release new LAN adapters, they usually release new or 
updated drivers as well. Sometimes the new LAN card functions properly with an earlier driver, 
and sometimes the earlier driver does not recognize the new LAN card and refuses to load. 
Occasionally, the older driver does load, but the LAN card exhibits serious performance problems. 
To obtain the full performance capabilities of a new LAN card, you should use the new driver.

The following sections explain how to obtain or compile drivers:

“Obtaining Drivers” on page 729

“Building Drivers” on page 729

If you need to load your drivers with specific parameters, see “Loading Drivers with Parameters” 
on page 731.

Obtaining Drivers
New LAN drivers should be obtained from the manufacturer. Most LAN card manufacturers have 
drivers available for free downloading from their Web site.  Some drivers are available from 
www.scyld.com/network, and the source to the Broadcom BCM5700 driver can be downloaded 
from http://www.broadcom.com/drivers/downloaddrivers.php.

If a manufacturer has a binary driver compiled specifically for the kernel version used by 
ZENworks, you can obtain the driver and use one of the update methods to add the driver. 
ZENworks 6.5 SP2 is based on SLES 9 SP2, kernel version 2.6.5-7.191. If the driver is not for this 
specific version, you must obtain the source and compile it for this version. For more information, 
see “Building Drivers” on page 729.

Building Drivers
Nearly all Linux drivers are distributed in source code form and need to be compiled before they 
can be used. Follow the manufacturer’s instructions included with the new driver to build the 
driver module. Many drivers can be built in such a way that they are built into the kernel itself; 
however, we recommend that LAN drivers be built as external kernel modules.

When building your LAN drivers, make sure that your build machine uses the same kernel as the 
imaging environment. If you have a LAN driver that doesn’t load in your imaging environment, it 
usually means that you have a mismatch between your build environment and the imaging 
environment.

You can find the current kernel version of your Linux environment using the following command:

uname -r

However, you might need to modify the results from the uname command to get your kernel 
versions to match. For more information, see “Using Uname” on page 731.
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To build your drivers:

“Obtaining the Linux Source Code Tree” on page 730

“Compiling the Module” on page 730

Obtaining the Linux Source Code Tree

To compile a module, you need the Linux source code tree that contains the configuration 
matching the ZENworks kernel. To obtain the necessary source code:

If you have ZENworks 6.5 Desktop Management Support Pack 2 installed, download the 
zenimgk2657191.tgz Linux source code tree file (http://support.novell.com/servlet/
filedownload/pub/zenimgk2657191.tgz).

If you have ZENworks 6.5 Desktop Management Support Pack 2 HP3 (or later) installed, 
download the zenimgk2657244.tgz Linux source code tree file (http://support.novell.com/
servlet/filedownload/pub/zenimgk2657244.tgz).

To use the Linux source code tree:

1 Unzip the file and install the source code tree in the /usr/src directory.

For example, the tar file creates the following directories:

/usr/src/linux-2.6.5-7.191
/usr/src/linux-2.6.5-7.191-obj

2 Obtain the proper configuration file from one of the following locations:

A running ZENworks imaging distribution file (/proc/config.gz).

The applicable version: zenimgk2657191.tgz (http://support.novell.com/servlet/
filedownload/pub/zenimgk2657191.tgz) or zenimgk2657244.tgz (http://
support.novell.com/servlet/filedownload/pub/zenimgk2657244.tgz).

3 Copy this configuration file to the directory created in Step 1.

For example, /usr/src/linux-2.6.5-7.191.

4 To create a link to the source tree:

4a Change to the /usr/src directory:

cd /usr/src

4b If there is a Linux soft link in the directory, delete it.

4c Create the Linux soft link, such as:

ln -s linux-2.6.5-7.191 linux

You now have the Linux kernel source tree and soft link ready for compiling the module. Continue 
with “Compiling the Module” on page 730.

Compiling the Module

To manually compile the module:

1 Install the source.

Follow the supplied instructions from the manufacturer to install the source.

Normally, the module source is in a directory under /usr/src. Module source files usually come 
in the form of a gzipped tar file (.tar.gz or .tgz). The file might also be a bzipped file (.bz2).
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2 To compile the source:

2a Change directories to the source.

2b If you modified uname to change to the proper kernel version, issue a make command.

3 When you have your module compiled for ZENworks, take the generated .ko module file 
(make sure you select the proper module name and not a work .ko file) and install it by placing 
it in the initrd file system.

Loading Drivers with Parameters
If there is a module you want to load during the linuxrc processing time, and if linuxrc does not 
recognize that it needs to be loaded or you want to specify the load parameters, you can enter a line 
in the linuxrc.config file. This file then needs to be updated in the initrd file system.

You might need to load a LAN driver module with specific parameters. You can do this with a line 
like:

insmod="moduleName parm=xxx"

This type of line is most commonly used to load a LAN driver with specific parameters, such as 
full duplex or specific speed.

Using Uname
The uname command enables you to find the current kernel version of your Linux environment. 
However, you might need to modify the results from the uname command to get your kernel 
versions to match.

The following steps modify the uname command to provide the value you need:

1 To obtain your current kernel version, enter:

uname -r

Write down the version number so you an use it in Step 4. This example uses version 
2.6.13-15-smp from a SLES 9 SP2 installation.

2 Create a new directory, enter:

mkdir /bin/orig

3 To move the uname binary to the /bin/orig directory that you just created, enter:

mv /bin/uname /bin/orig/uname

4 Use a Linux editor (such as vi) to create the /bin/uname file that contains the following lines:

#!/bin/sh
#uname
if [ $KRNLVERSION"a" = "a" ] ; then
if [ $(/bin/orig/uname -r) = "2.6.13-15-smp" ] ; then
          export KRNLVERSION=2.6.13-15-smp
     else
          export KRNLVERSION=2.4.31
     fi
fi
if [ $1"a" = "-ra" ] ; then
     echo $KRNLVERSION
else
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     /bin/orig/uname $*
fi

IMPORTANT: Replace the strings “2.6.13-15-smp” with the version you found in Step 1.

5 To make the new uname command script executable, enter:

chmod +x /bin/uname

6 Enter the following to cause the uname -r command to return a specific version, such as when 
compiling a module:

export KRNLVERSION="2.6.5-7.191"

7 Following the manufacturer’s directions, compile the module using the appropriate make 
command.

8 To reset uname so that it returns actual values, enter:

unset KRNLVERSION

Variables and Parameters
The following sections describe the variables and parameters used in updating resource files:

“Imaging Script Variables” on page 732

“Linuxrc Parameters Specified in Settings.txt” on page 733

“Image Engine Variables” on page 733

Imaging Script Variables
The following environment variables are used in imaging scripts and must not be modified:

The following environment variables can be modified or set in the settings.txt file:

Variable Definition

ACTIVEPARTITION Device of the active OS partition.

CDBOOT YES = Booted from a CD.

DISABLEZEN 1 = Disable the ZENworks partition.

ENABLEZEN 1 = Re-enable the ZENworks partition.

ZENDEVICE Device name of the ZENworks partition.

ZENPARTBOOT YES = Booted from ZENworks partition.

Variable Definition

HDPARM NO = Do not set hdparm parameters.

IMGCMD Imaging command to run instead of the img a command.

MANUALREBOOT YES = Do not automatically reboot.

PARTITIONSIZE Size in MB to create the ZENworks partition.
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Linuxrc Parameters Specified in Settings.txt

Image Engine Variables

Troubleshooting Linux Driver Problems
“Troubleshooting During the Boot Process” on page 733

“Troubleshooting at the Bash Prompt” on page 734

Troubleshooting During the Boot Process
While booting ZENworks imaging, there are several things that you can do to help troubleshoot if 
there is a problem:

Press Esc to see the kernel messages. Usually, messages are shown for failures.

Screen 3 (press Alt+F3) is used to show the progress of the linuxrc process. It lists progress 
results, what linuxrc is doing, which modules are loaded, and so on.

PROXYADDR IP/DNS address of the Imaging server.

PROMPT Go to the bash prompt after imaging is complete.

Variable Definition

netsetup dhcp = Use DHCP.

1 = Static IP.

HostIP Static IP address to use.

NetMask Network mask.

Gateway Network gateway.

HostName Host name to assign.

Nameserver DNS name server.

Domain Domain suffix.

NetDevice ethx = Define which network device to configure.

Variable Definition

DEVELOPER_LOG “A” creates a verbose imglog debug file.

ZENIMGLOG “A” creates a less verbose imglog debug file.

ZEN_IGNORE_GEO_MISMATCH Ignore geometry device mismatches when restoring raw 
image formats.

Variable Definition
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Screen 4 (press Alt+F4) is used to show output from the modules during linuxrc.

Screens 1 (press Alt+F1), 3, and 4 can be used to help determine which part of the process is 
failing or causing a problem.

Screens 3 and 4 indicate which drivers are loaded.

If a drive is loaded properly but fails in some way, view screen 4 to see if there is an outdated 
driver.

If the boot process fails, the first command line parameter to use is acpi=off.

Troubleshooting at the Bash Prompt
When the bash prompt is displayed, there are a few tools that you can use to gather information 
about the hardware:

hwinfo: This utility is used by linuxrc to load hardware. You can use hwinfo -pci to determine 
exactly what hardware was recognized.

Pipe to “less,” because hwinfo can create a lot of output. For example, hwinfo -pci | less.

If you need to contact Novell Support for help, you should capture the output from hwinfo 
-pci to a file for their use. You can gather the most information with this command:

hwinfo –pci –log /logfilename

where logfilename is the name of the file you will send.

You can then mount a device, such as a Thumb drive or other USB device, and save the output 
file for later use. You might also be able to use FTP to save the file where it can be available.

ethtool: This is a valuable tool (contained in a ZENworks distribution) that can be used to 
change the configuration on most Ethernet network devices.
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63 Supported Ethernet Cards

Novell® ZENworks® Desktop Management provides the Ethernet card drivers contained in the 
Linux kernel that ships with ZENworks 6.5.

ZENworks 6.5 ships with the 2.4.22 SUSE® LINUX kernel, ZENworks 6.5 SP1 ships with the 
2.4.28 kernel, and ZENworks 6.5 SP2 ships with the 2.6.5 kernel.

To determine which Linux kernel you are using, enter uname -r at the bash prompt.

If your workstation or laptop computer uses a different card that is not supported, you must supply 
your own Ethernet driver as explained in “Using Zimgboot.exe to Add Linux Drivers” on 
page 693.
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64 Server Imaging

Novell® ZENworks® Desktop Management support for managing server images has not been 
fully tested. Although you can make and deploy server images using Desktop Management in 
certain simple server configurations, Novell does not support these practices.

For more information, see TID 10092081 (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/10092081.htm) in the Novell Knowledgebase.
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H Documentation Updates

This section contains information on documentation content changes that have been made in the 
Administration Guide for Imaging since the initial release of ZENworks 6.5 Desktop Management. 
This information will help you to keep current on updates to the documentation.

All changes that are noted in this section were also made in the documentation. The documentation 
is provided on the Web in two formats: HTML and PDF. The HTML and PDF documentation are 
both kept up-to-date with the documentation changes listed in this section.

The documentation update information is grouped according to the date the changes were 
published. Within a dated section, the changes are alphabetically listed by the names of the main 
table of contents sections for Workstation Management.

If you need to know whether a copy of the PDF documentation you are using is the most recent, 
the PDF document contains the date it was published on the front title page or in the Legal Notices 
section immediately following the title page.

The documentation was updated on the following dates:

“August 16, 2006” on page 739

“November 22, 2005” on page 740

“September 23, 2005 (Support Pack 2)” on page 740

“June 17, 2005” on page 742

“February 11, 2005 (Support Pack 1)” on page 744

“October 25, 2004” on page 745

August 16, 2006
Updates were made to the following sections:

Adding Linux Drivers in ZENworks 6.5 SP2

Preparing an Imaging Boot Method

Adding Linux Drivers in ZENworks 6.5 SP2
The following updates were made in this section:

Location Change

“Adding Files to the 
Initrd or Root File 
Systems” on page 728

Replaced the cp command with mv in Step 3 and Step 10 because the files 
should be renamed, not copied.
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Imaging Utilities and Components
The following updates were made in this section:

Preparing an Imaging Boot Method
The following updates were made in this section:

November 22, 2005
Updates were made to the following sections:

Adding Linux Drivers in ZENworks 6.5 SP2

Adding Linux Drivers in ZENworks 6.5 SP2
The following updates were made in this section:

September 23, 2005 (Support Pack 2)
Updates were made to the following sections:

Imaging Utilities and Components

Preparing an Imaging Boot Method

Supported Ethernet Cards

“Obtaining the Linux 
Source Code Tree” on 
page 730

Updated this section with a change in where to obtain the downloads. Also 
removed references to TID 10091818, as it no longer applies.

Location Change

“Imaging Bootup 
Parameters” on 
page 701

Added the following paragraph in this section:

This section only applies to ZENworks 6.5 Desktop Management SP1 and 
earlier. Boot parameters are not used in ZENworks 6.5 Desktop 
Management SP2 and later.

Location Change

“Preparing Imaging 
Boot CDs or DVDs” on 
page 578

Updated this section by splitting it into two subsections to cover the issues 
for creating boot CDs/DVDs with or without other files than the imaging boot 
ISO provided with ZENworks.

Location Change

“Adding Linux Drivers 
in ZENworks 6.5 SP2” 
on page 723

This is a new section.

Location Change
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IMPORTANT: Throughout this Workstation Imaging section, where information is applicable to only 
ZENworks 6.5 SP1 and earlier, the parenthetical (SP1 only) is used. Such instances include references to 
imaging diskettes, language diskettes, and Linux device drivers. For ZENworks 6.5 SP2 and later, the newer 
zimgboot.exe utility does not support these features.

Imaging Utilities and Components
The following updates were made in this section:

Preparing an Imaging Boot Method
The following updates were made in this section:

Location Change

“Restoration 
Submode” on 
page 687

In an IMPORTANT note, changed the DWORD value to REG_SZ value to 
correctly configure the  HKEY_LOCAL 
MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN registry key to 
prevent the ZENworks Imaging Windows Agent from causing the 
workstation to reboot after performing work in Restoration mode.

“Imaging Boot Disk 
Creator 
(Zimgboot.exe)” on 
page 692

Reorganized this section to include information for the newer zimgboot.exe 
utility that shipped with ZENworks 6.5 SP2.

“Imaging Configuration 
Parameters 
(Settings.txt)” on 
page 695

Reorganized this section to include information for the newer zimgboot.exe 
utility that shipped with ZENworks 6.5 SP2.

Location Change

“Using the ZENworks 
Imaging Floppy Boot 
Disk Creator Utility” on 
page 580

This section has been renamed from “Preparing Image Boot Diskettes” and 
has been reorganized and updated.

“Using zimgboot.exe in 
ZENworks 6.5 SP1 and 
Earlier” on page 580

This section has been created to include subsections for each task available 
on the older version of the zimgboot.exe utility.

“Using zimgboot.exe in 
ZENworks 6.5 SP2 and 
Later” on page 584

Because Support Pack 2 provides a newer version of the zimgboot.exe 
utility, this section has been added.

“Additional Information 
About Booting to Linux” 
on page 587

This section has been noted to only apply to ZENworks 6.5 SP1 and earlier. 
These features are not supported in the newer zimgboot.exe utility.
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Supported Ethernet Cards
The following updates were made in this section:

June 17, 2005
Updates were made to the following sections. The changes are explained below.

“Imaging Engine (Img: Command Line and Menu)” on page 742

“Performing Manual Imaging Operations” on page 743

“Using ZENworks Desktop Management Preboot Services” on page 743

Imaging Engine (Img: Command Line and Menu)
The following updates were made in this section:

Location Change

Chapter 63, “Supported 
Ethernet Cards,” on 
page 735

Modified the content of the chapter to correctly identify the SUSE® LINUX 
kernel shipping versions for SP1 and SP2.

Location Change

“Make on Proxy (img 
makep)” on page 710

Added the following sentence to the “Address” row:

“This can be any server running the Imaging Proxy service.”

“Make on Proxy (img 
makep)” on page 710

Added the following text to the “Filepath” row:

The UNC path to the new image file being created, including the image 
filename and the .zmg extension (case-sensitive). The format of the UNC 
path is as follows:

//servername/volume_or_share/path_to_store_images/
imagename.zmg

Upon execution of img makep at the cmd line, the servername portion of 
this path is replaced with the value in the address portion of this syntax.

“Make on Proxy (img 
makep)” on page 710

Added a new example:

img makep img.xyz.com //bogus/sys/imgs/dellnt.zmg

Takes an image of all partitions and saves the image to sys/imgs/dellnt.zmg 
on img.xyz.com. (Assumes img.xyz.com is the DNS name of a server 
running the Imaging Proxy service).

Because the servername inside the UNC path is replaced by the address 
value defined earlier in the cmd line, //bogus would become
//img.xyz.com

“Restore from Proxy 
(img restorep)” on 
page 714

Added the following sentence to the “Address” row:

This can be any server running the Imaging Proxy service.
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Performing Manual Imaging Operations
The following updates were made in this section:

Using ZENworks Desktop Management Preboot Services
The following updates were made in this section:

“Restore from Proxy 
(img restorep)” on 
page 714

Added the following text to the “Filepath” row:

The UNC path to the image file to retrieve, including the image filename and 
the .zmg extension. The format of the UNC path is as follows:

//servername/volume_or_share/path_to_stored_images/
imagename.zmg

Upon execution of img restorep at the cmd line, the servername portion 
of this path is replaced with the value in the address portion of this syntax.

“Restore from Proxy 
(img restorep)” on 
page 714

Added a new example:

img restorep img.xyz.com //bogus/sys/imgs/dellnt.zmg

Removes all existing local partitions, retrieves the image from sys/imgs/
dellnt.zmg on img.xyz.com, and puts down the partitions and contents of that 
image on the available local writable devices. (Assumes there is sufficient 
local space, and that img.xyz.com is the DNS name of a server running the 
Imaging Proxy).

Because the servername inside the UNC path is replaced by the address 
value defined earlier in the cmd line, //bogus becomes 
//img.xyz.com

Location Change

“Manually Taking an 
Image of a Workstation 
Using the Bash 
Prompt” on page 647

Added the following text to Step 4 on page 648:

The IP address or DNS name should be that of your Imaging server. This can 
be any server running the Imaging Proxy service.

The UNC path to the image file to retrieve, including image filename and 
.zmg extension (case-sensitive). The format of this UNC path is as follows:

//servername/volume_or_share/path_to_stored_images/
imagename.zmg

When img makep is executed at the cmd line, the servername portion of this 
path is replaced with the value in the address portion of the path. 

Location Change

“Configuring the Proxy 
DHCP Module” on 
page 615

Added information for the USE_DHCP_PORT option.

Location Change
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February 11, 2005 (Support Pack 1)
Updates were made to the following sections. The changes are explained below.

Imaging Utilities and Components

Performing Manual Imaging Operations

Supported Ethernet Cards

Imaging Utilities and Components
The following updates were made in this section:

Location Change

“Image Explorer 
(imgexp.exe)” on 
page 673

Added the following information:

Although the ZENworks Imaging Explorer looks, and in most situations, 
functions like the Microsoft Windows Explorer, the two programs are different 
and some functionality differences exist. The following list describes key 
differences between how the ZENworks Image Explorer and Microsoft 
Windows Explorer function:

Replacing Files in an Image: During the lifecycle of an image, files might 
be deleted or updated using Image Explorer. When you replace an 
existing file in an image using Image Explorer, the original file is not 
deleted from the image. Image Explorer purges only deleted files; it does 
not purge files that have been updated. When files are added to an image 
where the file already exists, Image Explorer appends the entry to the end 
of the image. When images are restored, all files that have been 
previously updated are sequentially restored. To avoid performance 
problems, you should manually delete and purge each instance of 
duplicate files in order to have them purged from the image.

Dragging Files from Image Explorer: You cannot drag files from Image 
Explorer in order to extract them.

“Image-Safe Data 
Editor” on page 691

Added a number 1 to the DNSServer field name. The field name now reads 
as follows:

DNSServer1 (DNSServer1)

“Imaging Configuration 
Parameters 
(Settings.txt)” on 
page 695

In previous versions of ZENworks documentation, this section was entitled 
Imaging Bootup Parameters (Settings.txt). This section is now entitled 
Imaging Configuration Parameters (Settings.txt).

Also removed information about the PCMCIABOOT and SCSI parameters 
and moved this information to a new section entitled Imaging Bootup 
Parameters.

“Imaging Bootup 
Parameters” on 
page 701

Added new section to describe command line options to prevent PCMCIA, 
SCSI, and USB drivers from loading during the boot process. 

Also added information to describe how to load PCMCIA drivers earlier in the 
boot process.
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Performing Manual Imaging Operations
The following updates were made in this section:

Supported Ethernet Cards
The following updates were made in this section:

October 25, 2004
Updates were made to the following sections. The changes are explained below.

Imaging Utilities and Components

Preparing an Imaging Boot Method

Using ZENworks Desktop Management Preboot Services

Location Change

“Manually Taking an 
Image of a Workstation 
Using the Bash 
Prompt” on page 647

Added the following note under Step 4 on page 648:

NOTE: Unless you mount a drive before using the makel command, the 
image is created in RAM and is lost during a reboot of the workstation.

Added the following information under Step 4 on page 648 for the makep and 
makel commands:

The directories in the path must exist. You can use the following characters 
in the path and filename:

Letters: a through z (uppercase and lowercase)

Numbers

Special Characters: $ % ' - _ @ { } ~ ` ! # ( )

“Manually Taking an 
Image of a Workstation 
Using the ZENworks 
Imaging Engine Menu” 
on page 649

Added the following note under Step 6 on page 650:

The directories in the path must exist. You can use the following characters 
in the path and filename:

Letters: a through z (uppercase and lowercase)

Numbers

Special Characters: $ % ' - _ @ { } ~ ` ! # ( )

Location Change

“Supported Ethernet 
Cards” on page 735

Added information explaining which Linux kernel ships with ZENworks 6.5 
(initial release) and with ZENworks 6.5 Support Pack 1 (SP1). Also provided 
information about determining which Linux kernel you are using.
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Imaging Utilities and Components
The following updates were made in this section:

Preparing an Imaging Boot Method
The following updates were made in this section:

Using ZENworks Desktop Management Preboot Services
The following updates were made in this section:

Location Change

“Restoration 
Submode” on 
page 687

Added the following note:

NOTE: You can use the registry DWORD value in HKEY_LOCAL 
MACHINE\SOFTWARE\NOVELL\ZENWORKS\ZISWIN Prevent Reboot=1 
to prevent the ZENworks Imaging Windows Agent from causing the 
workstation to reboot after performing work in Restoration mode.

Location Change

“Adding Linux Drivers 
for Use with Preboot 
Services (PXE)” on 
page 588

Changed the command to zip a file in Step 10 on page 588 from

gzip --v9c linux

to

gzip -9c linux > linux.gz

Location Change

“Creating the Diskette 
in a NetWare Server 
Environment” on 
page 619

Removed information about manually copying the PXE-on-Disk files to a 
NetWare server; the installation program copies these files on the server 
automatically.
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